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Welcome to AirMail!
AirMail is "email for the airwaves", a radio messaging program for ham, Sailmail and other licensed radio
systems. AirMail offers an easy email-style user interface, and was especially designed for the SCS PTCII DSP multimode Pactor-2 controller. Airmail also supports most other Pactor modems. (see System
Requirements »Page 5 for more information). Airmail also includes some features for retreivng messages
when an internet connection is available, for example Winlinks "telnet" connection and Sailmail's POP
server.
If all you need is some quick information then try the Quick Start »Page 103 index.
For more detailed information refer to the following topics:
Getting Started - a step-by-step guide for new users »Page 5,
Overview of AirMail Windows and Features - a quick guided tour of what's available »Page 9
Sending and Receiving Messages - how to compose, send and receive messages »Page 14
Setting Options - how to use Airmail's various options windows »Page 21
Using Winlink-2000, information for ham users of the Winlink-2000 system »Page 82
Using Sailmail - information for Sailmail members »Page 8,
History of Ham radio email in a nutshell »Page 6
License and Copyright Information »Page 4
Airmail updates and additional
http://www.airmail2000.com

information

are

available

from

the

Airmail

web

site,

For more information, suggestions, report a problem, or just say "Hi", please send email to
airmail@siriuscyber.net .
© 1997-2004 Jim Corenman
License Information
Airmail is not "freeware" and is not "public domain".software. License to use is granted only under the
terms outlined here, and other use is specifically prohibited.
Use: Airmail may be freely used without charge on amateur radio bands by licensed hams. Airmail can
also be used by members of the U.S. Military Afiliate Radio System (MARS), and by members of the
Canadian CAFRS system, when operating on authorized MARS/CAFRS frequencies. Airmail can also be
used to communicate with other stations or systems which have licensed the use of Airmail, including
Sailmail (www.sailmail.com ) and Bushmail (www.bushmail.co.za ). Other use is prohibited without prior
permission. Information on other use is available from the Airmail web site or by sending a query by email
(see the Introduction »Page 4 page for web and email addresses).
Unlicensed commercial use of any sort without prior permission is specifically prohibited.
Distribution: AirMail is distributed without charge from the Airmail web site (see the Introduction »Page 4
page for web address). The web-site files may also be copied onto floppy discs for distribution, and a
nominal charge can be made to cover the cost of distribution (not to exceed US$10 per floppy).
Distribution of individual files is not permitted.
Copyrights:
AirMail is Copyright ©1997-2004 by Jim Corenman, KE6RK, and Sirius Cybernetics LLC, P.O. Box 2143,
Friday Harbor, WA USA
Pactor is a registered trademark of SCS GmbH, Hanau, Germany.
Windows is a registered trademark of Microsoft, Inc., Redmond, WA USA
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Airmail requires a PC-compatible computer running Windows-95 or later. The computer must be equipped
with adequate memory (see Windows Performace issues »Page 75).
A compatible Pactor modem must be connected to a serial port accessible to Windows and also to a
digital-capable SSB transceiver. Many older SSB transceivers (ham or marine) are not capable of
continuous full-power transmission and must be operated at reduced power (see Audio levels »Page 67).
In case of doubt check the radio manual or seek assistance from the manufacturer or dealer.
Compatible modems:
SCS PTC-II, IIe, or IIpro
Kantronics KAM+, KAM with "enhancement board, or KAM-98
AEA PK-232mbx, PK-900, DSP1232/2232 (firmware must include Pactor mode, and ver 7.1 or later
firmware is needed to use binary mode)
MFJ 1276 or 1278B (ASCII modes only)
HAL DXP-38
SCS PTC-plus (Pactor-1), ASCII modes only
Current firmware is generally required.
Airmail is also capable of automatically setting the dial frequency of compatible transceivers when
stations and frequencies are selected. This is strictly optional and requires a compatible transceiver and
suitable interface. (see Remote Frequency Setting »Page 56).
Program Installation
If you have not yet installed Airmail, that is the next step. AirMail is installed from two install files. The first
installs required system files and need only be installed once, the first time Airmail Version 3 is installed.
(If the previous installation was Version 2, then the system files must be installed). The second is the
Airmailprogram and settings files. Simply double-click each install file and follow the prompts. The Airmail
install program will check for previous installations and offer a choice of installation directories. It is
recommended that you stick with the default installation folder of C:\Program Files\Airmail to avoid future
confusion.
AirMail uses a conventional ".ini" file for settings rather than the stylish-but-aggravating practice of burying
settings in the system registry. The initial settings are contained in an initial Airmail.ini file which is
installed only if there is no previous file. Settings will not be changed if Airmail is re-installed or updated.
(If you wish to reset the settings file to the original defaults, delete the Airmail.ini file and resinstall
Airmail). The address book is contained in the file addrbook.txt, which can be copied or saved. (Airmail
can also import or export addresses in a format compatible with many email programs).
To un-install, see Uninstalling Airmail »Page 5.
Un-installation:
To uninstall AirMail, simply delete the files and folders under the C:\Program Files\AirMail folder. There
are two entries which are left in the system registry to aid re-installation: the most-recent install folder and
the last message number. One file is left in the Windows System folder, "vcl50.bbl", which may be used
by other programs.
Getting Started
If you need some quick info, try the Quick Start »Page 103 pages.
If you are new to computers or to Windows, first spend some time learning the basics. Get a copy of
"Windows for Dummies" (seriously, it is a good book) and learn how to use the keyboard and mouse to
make Windows do what you want it to. We are not kidding, you will find Airmail a lot easier to use if you
understand the Windows basics first.
A note on the layout of this help page: There are a number of underlined links such as this one »Page 92
which will take you to another page (or "pop up »Page 92" a small window on top) with more detail. At the
top of this window is a "Back" button, use that to return. Also, use the">" and "<" buttons to move one
page forward or back, through related topics.
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The first step is to install Airmail »Page 5, the next step is to start it up. There will be a desktop icon, and
also a Start-menu item under "Radio" (which you can move »Page 91 or delete as you wish). AirMail will
first show a "splash screen" with the program version (also available via the Help/About menu). When
started for the first time, Airmail will first show the Setup Wizard »Page 117, otherwise it will go directly to
the Message Index »Page 12 which is a listing of all Incoming and outgoing messages. (You can click
these links now to read more, or better yet come back later after you've had a tour).
If you need to change any options then you can select Tools/Options from the menu to open the Options
»Page 21 Window, and then click here »Page 89 if you need help with what options settings to use.
For hams, click here »Page 91 to select the appropriate stations to use.
Now compose a message to a friend. Click the New Message button (third from the left) or select
File/New from the menu. The Address Book »Page 16 will open, click "New" and enter the name and
email address of a friend, or click "KE6RK" to select our email address, and click "OK" (or hit the "Enter"
key). The address book will disappear, and the selected email address will be in the "To:" box. Enter
"Howdy" in the Subject box, hit "Enter", and then type a short message in the message box below. Click
on the "mailbox" button to Post the message »Page 17 for sending (or select Message/Post from the
menu). A "Post-to" window may pop up, wanting to know which station you want to send this to, enter
"WL2K to send it to any Winlink-2000 station (Sailmail users should enter "Sailmail"). Check the box
marked "Always use this" and then click "OK". Your message is now waiting to be sent and should have a
"mailbox" icon in the index.
Next, power on the transceiver and modem, and click the right-most "AirMail" icon to open the Terminal
Window »Page 19 (or select Window/Terminal from menu). The first thing that will happen is that the
controller will be initialized - this will take a few seconds, and the left two buttons will turn green and red.
If that doesn't work then you will have to troubleshoot the controller connection, click here »Page 39.
Once the controller is initialized you are ready to try Connecting »Page 19 to a station. Click on the
Station Box on the toolbar (watch the hints) and select an appropriate station. The Propagation Window
»Page 94 can be a great help with deciding which stations have the best connections. Then click on the
Frequency Box and choose an appropriate frequency. If you have remote control connected then the
radio should set the correct frequency, otherwise check the lower-right status bar for the calculated dial
frequency (based on your options settings) and set the dial accordingly.
Then listen carefully to be sure the frequency is quiet.
Pactor signals interfere with each other and nobody gets through. If you hear chirping or beeping, wait for
the channel to become quiet or try another frequency. When the frequency is clear, click the green
"Connect" button. AirMail will initiate a call to the selected station. If it connects, then your message will
be sent off automatically. If the station does not answer then Airmail quits automatically after a minute or
so. Most stations scan multiple frequencies at a rate of 2-3 seconds per frequency, so typically you will be
calling for 10-20 seconds before connecting.
If you don't connect, wait a while or try another frequency or another station. The station might be busy on
another frequency, the radio propogation might be no good, or maybe something is not working. You
should be able to connect after a few tries, but don't keep hammering the same nail if the station isn't
answering.
For sending and receiving messages, that's it! Have fun staying in touch. There are a lot of other
capabilities for those interested, so browse through the help file at your leisure but don't feel that you have
to make use of every bell and whistle.

Overview of the Ham Radio Digital Network
The ham radio digital network is a bit like the internet- amorphous and hard to describe. It is a mix of VHF,
HF and VHF/UHF satellite stations interconnected to allow messages (traffic) to be passed anywhere in
the network. The VHF bulletin board (BBS) stations operate packet radio (AX.25) at high data rates over
relatively short hops, with multiple stations sharing a common frequency. The HF digital mailbox (MBO)
stations are the ones of primary interest to mobile hams, because they can be easily accessed with
modest equipment over long distances. Most HF MBO stations operate WinLink software and connect to
local VHF packet networks as well as other HF MBO's. The most popular mode of operation is Pactor or
Pactor-2, so these stations are often referred to as Pactor Mailboxes.
Radio propagation over line-of-sight VHF paths is pretty clean, phase-shift wise, and a simple two-tone

Airmail.RTF
AirMail Help
Page 7 of 135
simple FSK (Frequency Shift Keyed) modulation at relatively high baud rates works well, limited only by
the signal bandwidth. But the ionospheric propagation that allows long-haul communications on the HF
frequencies to work at all also introduces large amounts of phase distortion. This makes FSK modulation
at high baud rates impractical, bandwidth issues aside. Digital communications via HF radio has been a
series of developments, starting with RTTY and progressing to Amtor with rudimentary error-checking,
and then to Pactor with sophisticated error checking and higher baud rates. Amtor is still used by a few
amateur stations (and by large numbers of commercial stations in its commercial form of Sitor).
Characters are sent in 3-character blocks with a pause for an acknowledgment signal by the receiving
station, resulting in the characteristic "chirp-chirp" of Amtor and Sitor signals. Maximum throughput is 6
characters per second with a perfect signal, less in real life.
Pactor was developed around 1990 by a small group of German hams who went on to form the company
SCS. Pactor is an FSK-based system that incorporates longer blocks than Amtor, robust error checking
and automatic switching from 100 baud to 200 baud when conditions permit. The first Pactor controller
was developed by SCS and the protocol was adopted by most other manufacturers of TNC's (Terminal
Node Controllers or simply controllers or radio modems), but often without the analog memory error
correction scheme developed by SCS. All Pactor controllers request a repeat of a bad block, and if
multiple failures occur then try to reconstruct one good block out of the failed blocks. With analog memory
ARQ, the analog value of each bit is stored, not just the digitized binary value, providing "shades of gray"
for the controller to use in the reconstruction process.
The Pactor team at SCS went on to develop Pactor-2, a two-tone phase-shift encoding (PSK) scheme.
Their Pactor-2 controller is the PTC-II, with the modem implemented by a powerful DSP chip and
incorporating a fast 32-bit microprocessor to move the bits. The original Pactor mode is also included
(and in fact Pactor-2 operates as a "turbo" mode once contact is established via Pactor). Amtor, RTTY,
Morse and weather fax modes are also provided, plus plug-in options for 300-9600 baud VHF/UFH
packet.
Pactor-3 mode was developed in 2002 as an option for the PTC-II-family modems. It is not a new modem,
virtually any PTC-II-family modem can be upgraded for a modest cost. See Pactor-3 introduction »Page
121 for more information.
Enough on modems. A message on the digital ham network looks a lot like an email message, with
"From" and "To" addresses, a subject line and a message body. Mail was originally sent only between
radio users, but can now be easily sent to/from internet addresses also. Radio addresses are hierarchical
and geographic. For example KE6RK@OE4XBU.AUT.EU indicates station KE6RK who can be reached
at mailbox station OE4XBU in Austria in Europe. In Theory, a message can be entered into any BBS or
MBO station, addressed to any other, and will get there by whatever route the MBO stations decide.
Similar to email, the message is not generally delivered to the recipient automatically, they must connect
to the BBS or MBO station and collect it.
Interconnection with the Internet is straightforward only in Theory, but the WinLink-2000 system is now in
operation at many HF MBO's around the world and makes internet communication simple. The limitations
are the relatively low bandwidth of the ham radio network compared to the Internet, and the regulatory
restrictions associated with ham radio communications. For ordinary email messages the bandwidth is not
a problem and messages up to 5-10K or larger are commonly forwarded with no problem.
The regulatory issues result from the international agreements that grant amateur radio some prime HF
real estate, on a non-compete basis with commercial carriers. All of the various national regulatory bodies
have implemented prohibitions on commercial messages, which in the U.S. prohibits any communication
in which either party has a "pecuniary interest" (Part 97.113 of the FCC regulations, revised in 1993). So
you can order a pizza via ham radio as long as neither party works for the pizza parlor. This interpretation
applies to U.S. hams operating /mm from international waters also, but different rules may apply in other
countries. A second prohibition is on third-party traffic, i.e. messages which are address to or from a nonham. International third-party traffic is only permitted between countries who have an agreement in place.
In the U.S. there is no prohibition on domestic third-party traffic, which also extends to US-licensed
stations operating /mm in international waters. Only the radio link matters, not the country of origination of
the message. So a US-licensed ham operating from a country without a third-party agreement with the
US, and connecting to a station in the US, would not be permitted to send/receive internet traffic which
originated from a non-ham. Most MBO operators leave the responsibility for these issues to the message
originator, a trust that must be treated with respect.
In addition to the ham systems, private and public stations are being set up to handle Internet email
communications for remote users. Some, like Globe Wireless, are using proprietary hardware and
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software and are fairly expensive. Sailmail (www.sailmail.com) is a non-profit private coast station for
recreational vessels which has been operational since 1998 and has licensed Airmail, and can be used
interchangeably with Winlink by boaters who have some traffic which is not permitted on the ham bands.

Overview of Sailmail
The SailMail Association is a non-profit association of yacht owners that operates and maintains a
network of private coast stations in the Maritime Mobile Radio Service. The Association provides
radioprinter (e.g. Internet email) communications for its members on a cooperative basis, in order to meet
the private business and operational needs of the members' yachts. The SailMail Association provides
worldwide coverage through the operation of 15 stations in North America, Hawaii, Australia, Southeast
Asia, South Africa and Europe.
Sailmail uses the same Pactor technology as the ham radio system, and supports Pactor-1, Pactor-2 and
Pactor-3 on all frequencies at all stations. Airmail can be configured for either ham or Sailmail operation,
or both. With the addition of a Sailmail configuration file, the same copy of Airmail can provide service for
both the ham radio and Sailmail systems. This allows Sailmail to be used for business-related messages
which are not permitted on the ham bands, as well in countries where ham radio third-party traffic is not
permitted.
For more information on joining the SailMail Association, see the SailMail website at www.sailmail.com .
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Overview of AirMail Windows and Features
The AirMail program has two principal windows, a "Main Window" for viewing and editing messages, and
a "Terminal Window" for communicating via radio with mailbox stations and other Pactor stations.
Principle features include:
A Setup Wizard »Page 117 to help get set up and on the air quickly.
A Message Index »Page 12 window for easy access to incoming and outgoing messages, with
Message Icons »Page 13 to provide feedback on message type and status.
An Explorer-style Folder Tree »Page 14 facilitates storing and retrieving messages, including
separate folders (directories) for saved messages and trash you never wanted to see again. Either a
single folder or a mix of folders can be open, the initial setting is for the Inbox, Outbox and Bulletin
folders to all be open together.
Message Windows »Page 17 to provide easy display and editing of messages and bulletins. The
Windows MDI (Multiple-Document Interface) is used to allow multiple Message Windows and the
Message Index to be viewed simultaneously and arranged as desired. An email-style fill-in-the-box
message header makes creating a message straightforward.
A spell checker is provided for checking outgoing messages, if you know how to spell then you can
turn it off but it is great for the rest of us. Spell dictionaries are available for a variety of languages,
see the Airmail web site.
A Toolbar »Page 10 provides convenient access to the most common functions.
An Address Book »Page 16 stores Internet and radio addresses and formats messages
automatically. A tool to import addresses from Outlook, Netscape and Juno email programs is
provided.
A special Frequency List »Page 81 window is provided for ham stations to parse MBO frequency lists
and designate which stations will be visible for selection from the Terminal Window.
A special "Mail Server »Page 88" provides support for Outlook, Netscape or any other standard email
program. If you have a favorite email program you can continue to use it and Airmail will take care of
sending and receiving the messages via the radio instead of directly via the Internet.
A Log File »Page 35 is automatically maintained indicating stations connected to and messages
transferred.
The Terminal Window »Page 19 controls communications with the remote station and automates
message transfer using an automatic protocol to forward messages to the MBO station. A keyboard
mode is also provided. Features include color-coded split windows to provide viewing of received and
echo data separately from entered keyboard data. Controller link messages can also be displayed if
desired.
Station and frequency selection can be done directly from the Terminal Window for compatible radios
equipped with a suitable interface (direct serial connection or via a PTC-II controller).
Both the Main Window and the Terminal Window have a toolbar across the top and status boxes
along the bottom, which can be turned on or off.
A Local Mail Server »Page 88 allows a standard email program such as Outlook to be used for
sending/receiving radio email.
A Propagation Window »Page 94 provides assistance with selection of appropriate times and
frequencies for connection.
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Main Window Toolbar
Show/Hide Folder Tree: Opens or closes the split window showing the message folder
(directory) tree. When the folder tree is visible, messages can be dragged from the index
and dropped into "Saved" folders for archiving.
Address Book: Opens the Address Book window for review and changes.
New Message: Opens a new blank Message Window, and opens the Address Book to
allow selection of a recipient.
Open Message: If selected from the Message Index window, opens a new Message
Window for the currently selected message(s). If selected from the Message Window,
displays the Windows Open-file dialog window.
Reply: If the "from" address in the selected message is recognized from the address
book, then a new message is formatted as a reply.
Save Message: Works for an outgoing Message from a Message Window, and saves
any changes. A sequential filename is generated automatically. If a message has already
been sent and then is subsequently changed, it will be saved as a new file.
Post Message: Works for the selected messages in the Message Index, or the current
message in a Message Window. Posted messages are marked with the Posted icon in
the Message Index, and sent to the specified MBO when next connected.
File Message: Works for the selected message(s) in the Message Index, or the current
message in a Message Window, and transfers messages to a "Saved" folder.
Print Message: Works for the selected message(s) in the Message Index, or the current
message in a Message Window. Prints the message(s) on the default Windows printer.
Delete Message: Works for the selected message(s) in the Message Index, or the
current message in a Message Window, and moves message to a "Trash" folder.
Undo: Reverses the most recent edit change.
Cut: Moves selected text to the clipboard, deleting it from the message.
Copy: Copies selected text to the clipboard without deleting it from the message.
Paste: Inserts text from the clipboard into the message at the Insertion Point.
Spell Check (if installed): Performs a spell check, marking miss-spelled words with bold
red text. Right-click for suggestions or to add to a personal dictionary.
Message Index: Closes the current message and switches to the Message Index.
Terminal Window: Opens the Terminal window, or switches to it if already open. The
Terminal Window controls communications via the controller and radio.

Airmail.RTF
Keyboard Shortcuts:
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From any window:
Esc closes any window, except for the Message Index where it restores the normal Sort-by-Date.
Alt by itself accesses the menu bar, starting with the control menu under the logo icon at the left side.
Use the arrow keys to move around the menu choices; use Esc to cancel the menuaccess mode.
Alt+ letter key opens the corresponding menu selection.
F6 switches between the Main Program Window and the Terminal Window (if open).
From the Message Index:
Up arrow and Down arrow select the next or previous message.
Shift+up-arrow and Shift+down-arrow extend a selection up or down.
Ctrl+Home and Ctrl+End move the message selection to the top and bottom of the index.
Any letter key selects the next message with a To or From address beginning with that letter.
F3 finds and selects the next message with the same To or From address.
Enter opens the selected message(s).
From a Message Window:
Press Alt+PgDn or Alt+down-arrow to view the next message (i.e. the message referenced by the
previous line in the Message Index).
Press Alt+PgUp or Alt+up-arrow to view the previous message (i.e. the message referenced by the
previous line in the Message Index).
Alt+Tab cycles through all of the open message and index windows.
Alt+Home returns to the Message Index
The usual windows editing keys are active, the most common being: Home and End position the
Insertion Point (IP) at the beginning and end of the line; Ctrl+Home and Ctrl+End
position the IP at the beginning and end of the message; Ctrl with any arrow key
moves the cursor by one word horizontally or one paragraph vertically; Shift+ any of
the insertion-point-moving keys extends a selection from the insertion point; Ctrl+C
copies text to the clipboard; Ctrl+X cuts it, and Ctrl+V pastes text from the clipboard;
Ins toggles the insert/overwrite mode. Crtl+Z "undoes" the last edit operation.
F3 repeats the "Find" operation from the insertion point, and F7 starts the spell check operation.
From the Terminal Window:
F6 returns to the Main Window
F5 initiates a connection (same as green "Connect" button)
Esc cancels a connection request if contact is not yet made
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Overview of the Message Index
The Message Index is a separate window within AirMail that is used to view the status of messages that
have been sent or received, and to provide an easy means of accessing the messages themselves.
The index is divided into rows and columns, with each row representing one message. The format is
similar to that used by Windows Explorer, and keyboard and mouse operations are similar. Messages can
be sorted by any column by clicking the column header, and clicking the same column header again
reverses the sort order. Column widths can be changed by "dragging" the divider between the column
headings.
The fastest way to find a message to or from a particular address is to type a few letters, and Airmail will
try to match the "From" or "To" address. Use the F3 key to find the next matching entry. Alternately, click
the appropriate column heading to sort by that column (twice reverses the order), and then scan the list
for the desired entry. Pressing the Esc key when the index has the focus restores the sort order to the
default descending date order (new messages on top).
Messages can be selected by either using the keyboard arrow keys or with the mouse by clicking on an
entry. Multiple messages can be selected by use of the shift or control keys in the usual Windows fashion.
See Message Index Layout »Page 12 and Using the Message Index »Page 13 for more information.
The Index Window can be split into two panels to show a Folder Tree »Page 14 on the left side and the
Message Index on the right. This operates similarly to the split window in Microsoft's Exchange program.
Individual folders can be clicked to show their contents in the Index, or (something which even Explorer
can't do) multiple folders can be opened at the same time with a Shift-click. Additionally, messages can
be dragged into other folders, for example into a "saved" folder. Messages can also be dragged from the
Index into other applications such as Notepad or an open folder in Explorer for archiving, or in some
cases onto a program icon. See Folder Tree »Page 14 for details.
Message Index Layout
The layout of the Message Index columns, from left to right, is as follows:
Message ID:

Message ID Number and Icons »Page 13 for Message Type and Status.

Status:

Message Status (normally a hidden column)

To:

Destination for outgoing messages.

From:

Originator for incoming mail messages.

Via:

The MBO that the message was/will be sent to, or was received from.

Size:

Message Size

Date:

Message Date and Time.

File:

File Name

Note that the last column or two of the message Index may not be fully visible, depending on the column
widths and the size of the window. Use the "scroll bar" at the bottom to move the index horizontally. The
width of individual columns can be changed by positioning the cursor between the column headings (so
that it becomes a "split" icon) and dragging the column divider left or right. The columns width settings are
saved.
The index is normally sorted by descending date, with most recent message first. Clicking on any of the
column headers changes the sort key to that column, and clicking the same column again reverses the
sort order. To revert back to a sort-by-date, click the date column header or simply hit Esc on the
keyboard.
Sorting by the "To" or "From" columns provides an easy way to find sequential messages to or from the
same person. If you select a representative message first, then click the "From" column header (for
example), the selected message will remain visible and the other messages from the same address will
by displayed above and below (in chronological order if that was the previous sort). Once a message is
opened and you are viewing the Message Window, the Alt+down-arrow or Alt+up-arrow keys can be
used to rapidly open the next or previous message in the index, as currently sorted.
See Using the Message Index »Page 13 for more information.
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Message Icons:
Two icons indicate message type and status. The first indicates Message Status, and the second,
Message Type.
Message Status for incoming messages:
Indicates a new (unread) message or bulletin
Indicates a filed (archived) message
Message Status for outgoing messages:
Indicates that the message has been posted and is pending
Indicates message was successfully sent to the selected
MBO
Indicates a message that was rejected by the MBO station
Indicates an ambiguous auto-post (Auto-Answer mode only)
Message Types:
Indicates an Incoming Mail Message
Indicates a Outgoing Mail Message
Indicates a Thru-Message, received for another recipient.
Indicates a bulletin (i.e. an "SB" message or one not
addressed to a ham callsign).
Using the Message Index
Once one or more messages are selected (using any of the usual Windows selection methods), a number
of operations can be performed either by menu selection, using a button on the Toolbar »Page 10, or in
some cases via a keyboard key.
Open: A Message Window can be opened to view or edit the selected message(s) by pressing the Enter
key, double-clicking the Reference number, clicking the Open button on the toolbar, or selecting Open
from the File menu. Incoming Mail and Bulletin Messages will be opened read-only and cannot be edited,
but all or part of the text can be selected and transferred to a new outgoing message by selecting Copy
and Paste from the Edit menu or using the right mouse button to access a pop-up menu.
Archive: The selected message(s) can be Archived (stored in the Inbox/Saved folder) by clicking the
Archive ("File Cabinet") button on the toolbar or selecting "Archive" on the File menu. Filing older
messages cleans up the displayed Message Index and reduces the time required to update the index.
Print: The selected messages(s) can be printed on the default Windows printer by clicking the Print
button on the toolbar, or selecting Print on the File menu.
Post: The selected outgoing messages(s) can be posted for sending by clicking the Post button on the
toolbar or selecting Post from the File menu.
Delete: The selected messages(s) can be deleted (or moved to the "Trash" folder) by clicking the
Trashcan button on the toolbar, selecting Delete from the File menu, or typing the Del key on the
keyboard.
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Using the Folder Tree
The Message Index window can be split into two panes to show a Folder Tree on the left side and the
Message Index on the right. The Folder Tree indicates which folders are shown in the index (indicated by
an "open folder" icon), making it possible to reduce the size of the index yet still have messages readily
accessible.
Note that when messages appear to have "disappeared", it is most likely a case of their folder being
closed.
To view the Folder Tree, click the Show/Hide Folder Tree button on the left side of the toolbar, or select
View/Folder Tree from the Main Menu. The current folder (directory) structure will be shown, minus any
folders that have been designated as "hidden". (The hidden status can be changed in the Folders page of
the Tools/Options window, or by right-clicking on the Folder Tree pane).
The primary purpose of the Folder tree is to designate which folders are shown in the Message Index.
Normally these are the "Inbox", "Outbox" and "Bulletin" folders, with the corresponding "Saved" folders
being closed to reduce the clutter in the Message Index. Moving messages into the "Saved" folders
provides an easy way to keep the size of the index under control. Additional folders can easily be created.
To access a "Saved" message simply click on it in the Folder Tree. By default, a simple click will open
one folder, closing the others, while a Shift-Click will open or close that folder alone without closing other
open folders. This behavior can be changed by selecting the "toggles" option in the Tools/Options menu,
Folder tab.
Messages can be moved to another folder by selecting them in the Message Index, then dragging them
(with the left mouse button held down) to the desired folder, and then dropping them by releasing the
mouse button. Alternately, select the files and then choose Move from the File menu.
The Folder Tree pane can be closed by clicking the View/Hide button again, selecting View/Folder Tree
from the main menu, or Pressing the Esc key when the Folder Tree pane has the focus.
Introduction to Sending and Receiving Messages
Mail Messages are uploaded and downloaded automatically whenever a MBO is contacted using the
Terminal Window (and if the Terminal Window is in the "BBS mode, with the "handshake" button
depressed).
An Outgoing Message is created by opening a new message window, choosing an address from the
Address Book »Page 16 (or hitting Esc and entering the To-address by hand), entering a subject and
then composing the message. The message can be saved whenever desired, and it will be added to the
Message Index »Page 12 the first time it is saved. When the message is ready to be sent, the Post button
»Page 17 is used to mark the message as being ready for sending to the selected MBO. The Message
Index shows the status of outgoing messages, indicating whether they have been posted or sent and to
which MBO.
Incoming messages are downloaded automatically (in BBS mode), stored automatically and added to the
Message Index »Page 12 with a "New" icon.
For more information see the following topics:
Introduction to the Message Index »Page 12
Sending Mail Messages »Page 15
Receiving Mail Messages »Page 18
Terminal Window »Page 19

Airmail.RTF
Overview of the Message Window

AirMail Help

Page 15 of 135

A Message Header is provided as an easy way to address email or radio messages. (The header can be
turned off with the View/Message header menu selection).
The header boxes are used as follows:
To:

This is the destination address, either an email address ("Email" checked) or a radio
address for a ham radio message ("Radio" checked). For a Bulletin, this will be "Bulletin"
followed by the bulletin category (e.g. "Bulletin: MM" for a message to cruising sailors).
For outgoing messages, this is a button that will open the address book. Winlink-2000 will
accept multiple "To" addresses, for other systems include one only one "To:" address
and add any additional addresses to the "Cc" box.

Cc:

For email or Winlink-2000 messages only, the "Cc" allows entry of additional addresses
for copies of the message. Multiple addresses can be entered separated by commas,
and for outgoing messages this is a button that will open the address book. Winlink-2000
allows mixed radio and email addresses, for other systems only email addresses can be
entered.

Subject:

Allows entry of the message subject. (If left blank then "(no subject)" will appear in the
message subject header).

Post Via:

Allows entry of the mailbox station that the message will be sent to. This can be left blank
and the default station(s) will be used. For outgoing messages this is a button which will
open the Post-Via window for selecting a station.

Email Gate:

For email messages only, this is allows entry of the gateway name used for internet
email. For ham messages this can be left blank for the default "Nexus". To specify a
gateway at a particular station (e.g. different than the station connect to), enter (for
example) "Nexus@N0ZO". For Sailmail this should be "Email" or left blank.

Email/Radio/Auto: These buttons allow manual selection of the message type. Normally they are
selected automatically by the type of "To:" address entered.
Sending a Mail Message
There are three steps to create an outgoing message: Compose the message in a Message Window
»Page 17, Post it »Page 17 for sending, and then Connect to a station »Page 19 and send all of the
posted messages.
To compose a new message, select File/New from the main menu, or press the "New Message" toolbar
button. This will create a new, blank message and open the Address Book »Page 16.
You can select a recipient name from the Address Book (double-click or click "OK"), or you can create a
new entry by clicking the New button (click Details first if it is not showing). If you would rather just type in
the address, then press the Esc key to close the address book and type the address into the Message
Header »Page 15.
Alternately, to reply to an incoming message, select File/Reply or click the Reply toolbar button. (If the
"Reply" button is disabled, that means that no "from" address is recognized).
Now compose the new message in the Message Window. The "To" address will be filled in from the
address book (or click on it and type in an email or radio address), enter the subject, hit the Enter key and
begin typing the message. No other special formatting is required.
The message can be Saved at any time by selecting File/Save from the main menu, or clicking the Save
toolbar button. When saved for the first time, a sequential file name is created (which will become the
Message ID when the message is sent), and the message is added to the Message Index.
When the message is finished, Post it for sending. Select Message/Post from the main menu or click the
Post button. Depending on the destination the routing may be recognized, otherwise a dialog window
appears to allow selection of a destination station. "Posting" a message means that the message is ready
to send, but it not actially sent until the station is connected to.
To close the Message Window without yet posting the message, save it as above and then select
File/Close on the main menu or press the Esc key on the keyboard.
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The posted status of the message will be shown by the icons on the Message Index, and the "Via"
column will indicate the MBO station(s) that the message will be sent to.
The next step is to send the message to the selected MBO, see Terminal Window »Page 19
Address Book
The Address Book window is automatically opened when a new outgoing message is created, or can be
opened clicking the "Address Book" toolbar button or by selecting Address Book from the Window
menu. A list of familiar names or "nicknames" and their corresponding "To" addresses is shown in the
name/address box. The presence of one or more "Cc" addresses is shown by an ellipsis (...). Additional
information is shown in the panel below the address list.
To address a new message, either select a name and click "OK" or hit the Enter key, or double-click the
desired name. If the Address Book was opened as a result of opening a new message, or by clicking the
"To" or "Cc" button on the message header, then the address information will be copied from the selected
entry to the Message Window.
The Address Book has the following buttons:
OK:

Save any changes and close the address book. The selected address is copied into a
new message, or if the "To" or "Cc" header button was clicked.

Cancel:

Close the address book without saving changes, and without copying addresses into a
message.

New:

Create a new address entry. The name and address will be taken from an open message
if available.

Properties: Opens a "Properties" window to show all details and allow changes.
Delete:

Deletes the selected address book entry.

The Address Properties window shows the following text boxes. Only the first two are commonly used, to
enter (or change) the Name and To-address:
Name:

This is the familiar name or "Nickname" for the entry. This is a single text field, and
first/last names are not stored separately.

To:

This is the email (or radio) address for the selected name. It must be a valid email
address, or (for ham radio systems only) can be a ham callsign or properly-formatted
packet-style radio address.

Cc:

A list of email address for copies of any message to the selected name (available for
email addresses only, and for radio addresses using the Winlink-2000 ham system only).
Not normally used.

Post Via:

This defines the default routing for this particular addressee, and is either a callsign of a
mailbox station (e.g. "KN6KB") or the name of a radio system (e.g. "WL2K" or "Sailmail").
This is not generally required as the routing defaults will define the "Post-Via" station.
Users of both the ham system and Sailmail can use this box to always route certain
messages via Sailmail, for example messages to their accountant which cannot be sent
via the ham system.

Email Gate: Allows entry of the name of an email gateway, with a designated mbo if appropriate.
ONLY used for forwarding email via non-WL2K ham stations, do not use otherwise.
Subject:

Allows entry of a subject line to be used as a default for this particular address. Not
normally used.

Message text: Allows entry of "boilerplate" text, such as a salutation or signature for this particular
address. Not normally used.
Email Gateways
Most systems (Winlink-2000, Sailmail, Airmail) include an email gateway which routes email messages to
the internet automatically. Simply enter email addresses into the message header and Airmail will format
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There is one case where specail routing information must be entered: Ham users will sometimes need to
route messages over the Packet network or via an older Winlink station, in this case an additional piece of
routing information is needed because these systems do not understand email formats. The psuedocallsign "Nexus" is used to address a message to the internet gateway, with an optional @bbs.h-route
suffix. This is the purpose of Airmail's Email gate box, normally hidden. Make an entry in the Email gate
box only when a BBS.H-Route must be specified, as the "Nexus" pseudo-call is assumed. (If this doesn't
make sense, then do not make any entries in the Email Gate box, it will just cause troubles).
Posting a Message for Sending
Before a message will be sent, it must be Posted, which is how you tell AirMail that the message is
ready, and which station to send it to. If you only ever connect to a single station then the choice is pretty
obvious and AirMail will quickly catch on. If you connect to more than one mailbox station, however, then
you need to pay attention to which messages are sent off to which station in order for things to make
sense. This can be handled automatically once a little setup is done.
When the message has been composed, click the Post button (the "mailbox" icon) or select
Message/Post from the menu. This will save the message and check the address against AirMail's
Routing list. If the destination is not known (i.e. the destination is not in the Routing list or the specified
station has not connected recently), then the Post Message box will appear. Type in the callsign for the
mailbox station that you want to send the message to, or click on the callsign if it appears in the list.
Multiple MBO's can be selected by entering multiple callsigns separated by commas, or by clicking more
than one callsign from the list. Clicking again de-selects the station.
If this is a routing that you want to use again, be sure the checkmark at the bottom is checked, to "Always
use this path". That will add the destination address to the routing list, and the next time you post to that
station you will not be asked for the routing (provided the MBO has connected recently, i.e. within two
weeks).
You can always review the Routing List, and make new entries, by selecting Tools/Options from the menu
and clicking on the Posting/Routing »Page 24 Options tab.
Composing a Message in the Message Window
A Message Window is opened whenever a new outgoing message is created, or an incoming mail
message or bulletin, the Event Message list, or the log is opened. For outgoing messages, the word wrap
is set by default to 72 characters (which can be changed with entry to the .INI file, see Options).
When a Message Window is active, the edit buttons on the toolbar are enabled, i.e. Undo, Cut, Copy,
Paste, and Spell Check.
The Undo function is only one level deep, and reverses the most recent edit change. If selected again, it
re-does what was just undone.
Cut, Copy and Paste operate in the usual Windows fashion, and are enabled only if there is text selected
to Cut or Copy, or text in the clipboard to paste.
Spell Checking is done continuously, with mis-spelled words underlined. Right-clicking on a misspelled
word brings shows a "pop-up" meu with suggested choices. A full spell-check can be initiated either by
pressing the F7 key, selecting Edit/Spell Check on the menu, or clicking the Spell Check button on the
Toolbar. See Spell Checking »Page 17 for more information. With a full spell-check, the text is scanned
for spelling errors and the usual dialog box appears.
For all incoming messages, the Message Window is read-only and changes cannot be made. Text can be
selected and copied into another window, however, for example an outgoing message or the Windows
Notepad.
Spell Checking
Airmail uses a spell-check engine from Addictive Software in Australia. Spell checking uses two
dictionaries, a "Main dictionary" available in a vareity of languages, and a "Personal" or Custom dictionary
containing the words which you have selected with the "Add" button or pop-up menu. Dictionaries are
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available in a variety of languages, follow the link from the Airmail web site.
Airmail normally checks spelling in the background as you type, underlining misspelled words. An
underlined word can be right-clicked at any time, which will "pop up" a list of suggested corrections, or
"Add" to mark the word as correct and add it word to your personal dictionary.
Dictionaries are accessible via Airmail's Tools/Options window, Spelling tab. The "Dictionary" box shows
available dictionaries (stored in Airmail's "Dictionaries" folder). To add dictionaries to the list, click on
"Locate Dictionaries" and point to the folder containing the dictionary files. Personal or Custom
dictionaries are selected with the box at the bottom. The selected dictionary is where the new "Add"
selections are stored, and the "Dictionary" button allows any of the custom dictionaries to be included in
the spell checking.
A Word-format personal dictionary can also be included, use the "Locate Dictionaries" function to select it.
(The Word-format Main dictionary is not supported).
One thing to remember: A larger spell-check dictionary is not usually better. A dictionary (main or
personal) with more words means a greater likelihood that a misspelled word will be found in the
dictionary by happenstance. So use modereation when adding words to your personal dictionary.
Receiving a Mail Message
New incoming mail messages are downloaded automatically when a connection is made in BBS mode to
a mailbox station. Once download is complete, the message index is update and the message can be
opened.
To view new messages, find the new message on the Message Index. Normally the newest messages
will be at the top of the index if it is sorted by date, which is the default. If the index has been sorted by
some other column, press ESC to return to the sort-by-date format and Home to return to the top of the
index. New, unread messages are marked with a "NEW" icon.
Select the message to be read, and press the Enter key or click the Open button to display the message
in a new Message Window.
As an option, after the message has been selected and the Message Widow opened, you can view the
next message in the index (however it is sorted at the time) by pressing the Alt+PgDn keys together (or
Alt+down-arrow key). Similarly, the Alt+PgUp keys (or Alt+up-arrow) view the previous message in the
index.
Press the Esc key, click the "X" (window-close icon), or select File/Close from the menu to close the
Message Window when you are finished reviewing your messages.
Multiple messages can be opened at the same time. Use Ctrl+Tab to cycle through them, or the Window
menu to choose.
For information on connecting to a mailbox station to download messages, see Terminal Window »Page
19
Winlink Bulletins
Most traditional Winlink MBO stations maintain a collection of bulletins of common interest. The most
common way to access these bulletins is to connect with a Winlink station in Keyboard mode and use the
LB command to list new available bulletins since the last time the LB command was issued. AirMail now
captures these lists in the Message Index, allowing easy referral. Any desired bulletins can be read by
entering the "R nnnn" command, where "nnnn" is the bulletin number. Alternately the RMMC (Read
Multiple Message Continuous) command can be used to read multiple messages at a time. (Since AirMail
captures incoming bulletins there is no reason to use the RMM command which requires confirmation
after each bulletin). For example, enter the command "RMMC 11011 11012 11013" to download the three
specified bulletins.
AirMail now includes the ability to automatically download bulletins using Winlink's new CFB command.
This allows bulletin numbers to be specified in advance, and the requested bulletins will be formatted as
messages and transferred on the next connect (see the Catalog WIndow »Page 87 for more information).
This feature can be used with the capture of bulletin lists as follows: (1) Download a Bulletin List update
with Winlink's LB command (or by including LB in an auto-pull specification); (2) Open the captured
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Bulletin List from the Message Index; (3) right-click on the bulletin number of any desired bulletins from
the list, and select "Add to Pull" from the pop-up menu. The specified bulletins will be added to a one-time
auto-pull list for that station. (Use the Bulletins page of the Tools/Options window to review or modify the
auto-pull lists).
Many Winlink/Netlink stations also make weather bulletins available from the internet, typically updated
multiple times per day. The special Winlink command "WX" can be used in keyboard mode to list the
available weather bulletins. Weather bulletins usually keep the same message number for each update,
so that it is not necessary to use the WX command to find the bulletin number. These bulletins can be
pulled automatically using the AirMail/Winlink auto-pull feature.
Terminal Window
The Terminal Window is used to control connection to the MBO and message upload and download. The
Terminal Window is opened by selecting Window/Terminal from the AirMail main menu, or clicking the
right-most Terminal Window button on the toolbar. Once open, F6 switches from the AirMail main window
to the Terminal Window and vice-versa.
The Terminal Window shows text being sent to and received from the connected station. Incoming is
shown in black a black font if the station is connected, and gray if unconnected (i.e. if "monitoring" is
enabled and another station is connected). Outgoing data which has been transmitted is shown in blue,
and informational messages from Airmail are shown in green. Messages from the modem are shown as
red text, if "Show Link Messages" is checked (Tools/Options window, Connection tab).
A "keyboard mode" is also available, but not generally used when connecting to a mailbox station. In
keyboard mode a lower "pane" is added to the window which shows text entered from the keyboard.
Characters not yet sent to the modem are shown as red text, and are changed to black when sent to the
modem. If "Word" is checked, then text is sent as each word is completed, otherwise Airmail waits until
the line is complete.
A toolbar is provided with shortcuts for (from the left) connecting and disconnecting, and setting the
operating mode, and drop-down lists for selecting a station and frequency to connect to. The right-most
button returns focus to the main window.
For more information, see:
Connection Modes »Page 19
Connecting to an MBO »Page 19
Using Unprompted mode for QSO's »Page 21
Using the Log FilesIDHlogfile
Connection Modes
AirMail has two operating modes: BBS mode (the default), and Keyboard mode. The Terminal Window is
initially in the BBS mode, which is used to automatically send and receive messages from the mailbox
station. Keyboard mode can be used to "chat" with another station.
The default mode is BBS mode, and once connection is established with a mailbox station and
identification is exchanged (the codes in square brackets), messages are forwarded each way following
the general BBS-to-BBS protocol, followed by automatic disconnection. This is the most efficient method
for transferring messages, and should work with virtually all mailbox software. No functions except
message transfer are available, and the local keyboard is not available. Posted outgoing messages are
forwarded first in response to the prompt by the remote station, then incoming messages are received.
To communicate in a normal QSO with another station, including a connection initiated by the other
station, then the Keyboard mode should be selected. Select Mode/keyboard from the Terminal Window
menu, or click the Keyboard mode button. (Note: this is the "Unpromoted" mode of Airmail ver 2).
To initiate a connection, see Connecting to an MBO »Page 19.
Connecting to a Mailbox station:

Page 20 of 135

AirMail Help

Airmail.RTF

To connect to a mailbox station (mbo), first open the Terminal Window if it is not already open (click the
right-most toolbar button or select Window/Terminal from the menu). Next, select a station from the
station list (or type the callsign into the box if the station is not in the list), then select a frequency. (If there
is a remote control connection to the radio then the frequency will be set automatically, otherwise Airmail
shows the correct radio dial-frequency in the status bar).
Finally check that the frequency is really clear. A Pactor connection is a one-to-one connection, not a
shared frequency. If two different stations try to connect on the same frequency then neither will have any
success. This seems like an obvious point but misunderstood by many VHF packet users, where shared
channels are the norm. So be sure no one is already using the frequency. (With PTC-II-family modems,
the "Connect" button will be yellow when digital signals are detected on the frequency, but this ony works
when Monitoring is disabled).
With a clear frequency, click the green "Connect" button. The station will be called for a period set by the
decoder (normally about 60 seconds), and if a connection occurs then message transfer will proceed. The
program is "done" when no messages are left to upload, and no messages are waiting to download.
When propagation is poor and data is being transferred very slowly, disconnecting and trying later is the
courteous thing to do, as well as saving connect time.
If it is necessary to disconnect immediately (or to stop calling), click the red "Disconnect" button. When
clicked once, the modems attempt an "irderly disconnect". This only works if data is getting through, in the
case of a bad connection it is necessary to click the Disconnect button twice. This performs a "dirty
disconnect" and will disconnect immediately.
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AirMail can also be used for ordinary QSO's, although there are many more suitable programs. But if you
are comfortable with AirMail, there are some features which are useful.
"Keyboard" mode should always be used for QSO's, this is selected by clicking the "Keyboard" button in
the toolbar (or selecting "Keyboard" from the Modes menu).
Calling CQ: If you want to call CQ, or send a test message, use "Unproto" mode (also called FEC-mode).
This sends a "broadcast" message as opposed to being linked with another station with full error
checking. To transmit unproto mode, select Xmit Unproto from the Control menu, and enter the text to
be transmitted. When finished enter Control/D or click the red "Stop" button to disconnect.
Calling another station or Answering a CQ: To initiate a call to a specific station (or answer a CQ),
enter the station callsign into the Station box (or select it from the list), then click the green Connect
button (or select Connect from the Control menu) to initiate a call to the other station. The status bar at
the bottom of the window will indicate whether or not a connection occurs. To abort the attempt click the
red "Stop" button to disconnect, or press the Esc key.
Controlling the link: Once connected, enter Ctrl+O ("Over", or or Control-Y) to change the link direction
from sending to receiving (and don't forget to ID once in a while, ctrl-I will take care of it). To "grab" the
link and change from receiving to sending, enter Ctrl+B ("Break", or Control-X)
Disconnecting: When finished enter a Ctrl+D or click the red "Stop" button once (when sending) to
initiate a disconnect. (The Control/D or a single "Stop" sends any buffered transmit characters before
disconnecting. Clicking "Stop" twice executes an immediate "dirty" disconnect).
Canned text files: It is convenient to set up a few "canned text" files, for sending a CQ message in
Unproto mode, for sending station or personal particulars, etc. Open Windows Notepad (or any other
editor), enter the text and save the file in the AirMail folder (normally C:\Program files\Airmail\) as "CtrlQ.txt", for example. Now when you are connected (or composing a message) you can press the ctrl and
'Q' keys and the text from the ctrl-Q.txt file will be copied to the keyboard buffer and sent. Not all keys are
available, D, X, Y, and Z are reserved for controlling the Pactor link, and C and V are used as edit keys
(copy and paste).
Settings: There are two settings in the Options window that effect Unprompted mode: If "Send whole
lines" is checked then keyboard text is held until the Enter key is pressed (to allow editing), otherwise text
is sent word-by-word. And "Max line length" sets the maximum line length before an automatic carriage
return is inserted, this is normally 72.
Setting Options
The Options Window is opened by selecting Options from the Tools menu in the main AirMail window.
Settings that effect the Terminal Window (controller and radio settings, callsign and station identification,
etc) will not take effect while the Terminal Window is open. It is not necessary to close the main program
window, but if the Terminal Window is open then it must be closed and re-opened.
Six Options pages are available with settings as follows:
Controller Options »Page 22: Page Controller and radio settings
Callsign/ID Options »Page 23: Station callsign and identification
Folders and Filing Options »Page 24: Message folders and file routing
Auto Answer Options »Page 24: Options relating to the Auto-Answer mode
Posting/Routing Options »Page 24: Maintenance of auto-posting for send messages
Note that the Terminal Window must be restarted for any changes to take effect.
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Connections Page
The Connections page contains three sections: Controller (TNC) Connection, Radio Connection, and
Audio Tones. These settings work together to define AirMail's hardware environment, and proper settings
are critical for successful operation.
Modem (TNC) Section: The settings in the Controller section allow selection of the modem type, and
specification of the Comm port and baud rate used for the connection to the controller.
Modem Type: Select the appropriate modem from the list.
Comm Port: Select a serial comm port from the list (COM1-COM8) or type in another port name.
Baud Rate: Select the appropriate baud rate, normally 57600 for the PTC-II and 9600 for other
controllers. The KAM or MFJ-1276 controllers don't set baud rates automatically, and the baud rate
must match that set for the controller. The PK-232 will autobaud if JP-1 is removed, which is
recommended (see Connecting a PK-232 »Page 46).
Show Link messages: Normally not checked. Check this box to show the Link Messages (status
messages) in the Terminal Window. It is recommended that this box be checked until initial testing is
complete, and then not checked once things are working reliably.
Ignore CTS: Normally not checked. Airmail checks for the presence of the CTS ready signal when
the serial port is opened, and periodically during operation, in order to sense a disconnected
controller. If the cable does not include the CTS signal then check this box.
Reset Controller: Normally checked only for PTC-II modems. Some modems (PTC-II, MFJ) allow
the software to perform a hard reset on startup, restoring all settings to their default values. This
slows down the initialization process but may solve some controller problems if settings are being
changed by other programs.
Audio Tones Section: The settings in this section define the tones used by the controller for sending and
receiving Pactor signals, and also determine the appropriate dial frequency to be used, either for the
optional remote frequency control or for the "Hint" in the Terminal Window's Status Bar.
Center Frequency: Enter the appropriate center frequency for the two audio tones used. 2100 Hz is
the most common value but there may be a reason to use another, see Choosing Audio Tones »Page
67. For the PK-232 and MFJ controllers the default is 2210 Hz, this can be changed if the modems
have been re-aligned.
Set Controller Tones: Normally checked. Check this box to have Airmail set the controller to the
selected Center Frequency. If you do not check this box, make sure the value entered for Center
Frequency matches what the controller is set to, otherwise the calculated dial frequency may not be
correct. Tones for the PK-232 and MFJ controllers are fixed and cannot be set by Airmail.
LSB / USB / FSK / AFSK: Check the appropriate box for the desired operating mode. Normally LSB
is checked for Pactor with a ham transceiver. Some marine and ham transceivers (e.g. Icom M710)
provide an AFSK (or J2B) mode with a narrow filter; if this mode is used then check AFSK. If the
controller is wired to key the transceiver directly in FSK mode rather than using audio tones, then
check FSK. This setting effects the dial-frequency calculation and is also used for remote frequency
control.
FSK dial=center: Normally not checked for ham, and checked for marine transceivers. In FSK (or
AFSK) mode, the dial frequency for most ham transceivers represents the frequency of the Mark tone
and this box should not be checked. For Marine transceivers the dial frequency in FSK or AFSK
mode represents the center of the Mark and Space frequencies and this box should be checked.
Effects only the dial-frequency calculation.
Tx Delay: Normally 20ms. This is the delay between activating the transceiver's PTT (transmit) line
and beginning to send audio data, to provide time for the transmitter to switch from receiving to
transmitting. Most modern transceivers switch in 5-10 ms. Increasing this value may improve the
reliability of a link when using an older transceiver or an external power amplifier, but excessive
delays (more than 30ms) will limit the maximum range over which you can reliably link due to
propagation delays of the radio signals.
Amplitudes: Some transceivers (PTC-II, KAM-98) provide software control for the transmit audio
amplitude, rather than a hardware adjustments in the controller. See Setting Audio Levels »Page 67
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Radio Connection Section: This section is for setting up a remote frequency control if desired. This is
completely optional and allows AirMail to set the operating frequency from the Terminal Window or for
Autocalling.
Via PTC-II: Check this box if the transceiver is connected to the HF-Transceiver Control connector on
a PTC-II, and you want the PTC-II to generate the control codes. Kenwood, Icom, Yaesu and SGC
radios are supported in this mode but only for basic frequency control.
Direct using PTC-II control port: Check this box if the transceiver is connected to the HFTransceiver Control connector on a PTC-II, but you want AirMail to generate the control codes and
use the PTC-II's port as a pass-thru. The advantage of this mode is that operating mode (i.e.
USB/LSB) and filters are set along with frequency, but only Kenwood and Icom radios are supported
at this time (TS-450 compatible, or Icom with NMEA or CI-V interfaces).
Direct via COM port: Check this box if the transceiver is connected to a serial comm port. As above,
only Kenwood and Icom radios are supported at this time
None: Check this box if there is no remote-control connection to the transceiver.
Radio type: Select a radio type from those available in the pull-down list.
Baud: Enter the appropriate baud rate. Icom Ham radios use 1200 baud by default (but most can be
set faster), while Kenwood radios and Icom NMEA interfaces usually use 4800 baud.
VFO/Memory: Normally "A". In "Direct" mode either VFO A or B can be used, or in some cases a
memory channel (00-99).
Icom Addr (hex): Used only for Icom radios, "01" should be entered for an Icom-NMEA radio, and
"00" will address most ham radios. See Icom Ham transceivers »Page 48.
Set Narrow Filters: Check this box if a Pactor-compatible 500hz filter is provided, and if the audio
tones are set appropriately for the filter's passband. If in doubt leave this box unchecked as tones
outside the filter's passband won't work at all.
The Terminal Window must be restarted for any changes to take effect.

Settings Page
Callsigns:
Callsigns are specified by box in the upper-left of the the Settings options page. The "Callsign" is used as
the automatic Pactor identification, and should be your normal callsign (i.e. no prefix or suffix characters).
This callsign is used to connect to the mailbox station, and is also sent as plain text periodically during the
connection to provide required identification.
Hams who want to send ID with a prefix or suffix should use the "ID string" box. This ID string is entered
in the format that it will be send and must include the same callsign, and can indlude a prefix or suffix.
If AirMail is configured for more than one system then additional tabs will appear on the Settings page for
those systems. The appropriate marine callsign should be specified for each system.
BBS options:
The "BBS Forwarding Options" box specifies which BBS protocol will be used for automatic message
forwarding in BBS mode. The default is the highest level supported by the modem, generally "B2F". If the
mailbox station does not understand this protocol (e.g. older Winlink stations) then the highest level
understood by both stations is used automatically.
Other available protocol options include Basic BBS Protocol (sometimes called the W0RLI protocol) is
understood by virtually all BBS software. The F6FBB protocol is more efficient, and used by Winlink and
F6FBB systems. The "FBB ASCII" mode sends messages in plain text, while the "Binary Level 0" mode
sends text as compressed binary files. Binary Level 1 allows the sending of binary files and is yet
currently implemented.
Note that the protocol actually used depends on the capability of the connected station also, these
options simply specify the highest level that will be offered by your station. If you specify "Binary Level 0"
and the other station only understands the Basic BBS protocol, then the Basic BBS protocol will be used.
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So there is no harm in specifying the highest level.
Also note that some controllers (PK-232 and the MFJ-1276 and 1278B) cannot transfer binary data and
the FBB Binary modes are not available.
Checking "FBB Receive first" specifies that AirMail will defer to the connected station until all pending
messages have been received, before sending outgoing messages. Use this only when the link is
marginal and you want to clear the incoming traffic first.
Other Settings:
This page also has settings for setting the maximum line length and send-whole-lines mode, these are
used for unprompted mode communications. The "Show Header Panel" check specifies whether the
Message Header »Page 15 is used.
Folders and Filing Options Page
The Folders Options Page is used to manage the folder (directory) structure that is available to AirMail for
the storage of messages. The left panel shows the current folder structure, including any hidden folders
(i.e. folders that do not appear on the Folder Tree display). Folders can be created, deleted , renamed
and hidden by clicking the appropriate button.
Filing: Right side of the page shows the current message filing routes. The six entries where incoming
messages and bulletins are stored, and where outgoing messages are taken from. A "Saved" folder is
defined for each message category to specify where messages are transferred when the "Save" function
is used. These entries can be changed to any existing folder, but should normally be left set to the default
settings.
AutoAnswer Options Page
This page defines the options for AirMail's Auto-Answer mode. Auto-Answer is enabled by default, and if
the Terminal Window is left open in BBS mode, then incoming calls are accepted and AirMail will respond
with its System ID [SID] and a welcome message. If the calling station is a WinLink or another AirMail
station in BBS mode then messages are exchanged automatically. If the connecting station is a keyboard
user, then they will be able to enter messages manually (with a "SP" command) and read any new
messages addressed to them.
To enable Auto-Answer mode, "Accept Incoming Connects" must be checked. The Welcome Text will
displayed on each connection and should include the phrase "Type H for Help".
AirMail will accept messages addressed to other users or to a WinLink MBO. If AirMail knows these
stations (i.e. they have been connected or posted to) , the messages will be auto-posted and sent on the
next connect. In that case it is necessary to stamp the messages with a Routing Line to show the routing.
AirMail will do that by default for messages that already been stamped, but will not add the first Routing
Line unless Home BBS has been entered.
To properly identify yourself as a personal mailbox, enter the callsign and full H-address for your Home
BBS in the "Home BBS" box, i.e. N0ZO.#LAKE.FL.USA.NA. (See the general discussion of AutoAnswer
Mode »Page 32 for more information). The contents Routing Line ID box will not be used (the ID will be
"from YOURCALL").
If the sysop of your Home BBS agrees that you should identify as a BBS, then enter your own callsign
with the agreed-upon H-Routing. It is important that this be coordinated so that return messages can be
routed properly by all MBO's. You can also stamp all incoming and/or outgoing messages by checking the
appropriate box.
The right side of this page allows you limit incoming connects to designated stations only (a blank box
allows any connect), or to exclude designated stations from being able to connect.
Posting/Routing Options Page
The settings on this page control how messages are handled posted with the "Mailbox" button or
Message/Post from the menu. These settings are accumulated automatically by the Post-To window
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when messages are posted, so the utility of this page is primarily to delete unused entries.
The right panel is the Auto-Posting list, and defines postings that will be made automatically without
confirmation (provided that (one of) the designated station has been connected to within 14 days).
The format of each line is "CALLSIGN=MBO" which means that whenever CALLSIGN appears in the
"TO" or "AT" part of an address, the message will be posted to station MBO. Multiple MBO's can be
specified, separated by commas.
For example, the entry "Nexus=KN6KB,N8PGR" will cause any message with a to-address of "Nexus" to
be posted to both KN6KB and N8PGR, and the message will be sent to whichever station connects first.
The keyword "default" can be used on the left side, for example "Default=N0ZO" means that all messages
will be posted to N0ZO unless specifically posted elsewhere (using File/Change Posting). System names
can also be used, for example "Default=WL2K" or "Default=Sailmail".
File Menu (Main Program Window)
New:

Create a new outgoing message. The Address Book is first displayed, either select a
recipient or cancel (click "Cancel" or press the Esc key) to enter a send command and
address manually. Same as clicking the "New Message" toolbar button.

Save:

Saves the contents of the current Message Window, and automatically assignes a file
name to a new message.

Close:

Closes the current Message Window. The same as pressing the Esc key.

Move:

Works only when one or more messages are selected from the Message Index; opens
the Move File dialog box to allow selection of destination folder for the selected
messages. If the Folder Tree is visible, the same as dragging selected messages from
the Message Index to the selected folder in the Folder Tree.

Print:

Opens the Print Message dialog window for printing the selected message.

Post:

Works when one or more messages are selected from the Message Index, or a message
is open in a Message Window. Saves the message and marks it for sending the next time
the selected MBO is connected. Prompts for the MBO to be posted to if not known, and
provides the option to always use that MBO.

Change Posting: Works when one or more messages are selected from the Message Index, or a
message is open in a Message Window. Opens the Post-To dialog window, to allow
selection of the MBO(s) to send the message to. Multiple MBO's can be selected, and the
one connected to first will get the message. A check box is provided to specify that the
path is always used.
Unpost:

Works when one or more messages are selected from the Message Index, or a message
is open in a Message Window. Removes the messages from the list of messages to be
posted.

Reply:

Formats a reply message for the current message in a Message Window, or the (first)
selected message in the Message Index.

Forward:

Formats the selected or open message as a new forwarded message, and opens the
address book to allow the selection of a "To" address.

Archive:

Moves the selected message(s) to the "saved" folder (as specified in the Folders and
Routing pages of the Tools/Options window).

Delete:

Moves the selected message(s) to the "Trash" folder (or deletes them if there is no Trash
folder).

Import/Export: Opens a sub-menu for importing or exporting messages:
Import:

From the Message Index, opens a File-Open box, allowing one or more files to be
selected to be imported as messages. Messages that have a proper message header
will be automatically posted.The BBS export format is also recognized. From a
message being edited, inserts the (first) selected text file into the body of the
message at the Insertion Point (|). If a binary file is selected then it is uu-encoded
prior to being inserted.
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From the Message Index, opens a File-Save box to allow the specified files to be
saved in another folder as email-style messages. From an open message, allows that
message to be saved in another folder, or, for a message containing a UU-encoded
binary file, saves the converted file.

Export BBS format: Formats the selected message(s) as an export file, which is compatible with
the export format used by Winlink and other BBS systems. This is an easy way to
move a collection of messages to another BBS, including another of Airmail.
Attach File:

Attaches a file to a message. Files are only transmitted when a compatible protocol is
used, such as FBB level-2 (see Options/Settings) or where the connected station is
supports the Mime format. Winlink-2000 will handle attached files, traditional ham Packet
or Winlink stations will not. .

Exit:

Closes all windows and exits AirMail.

Edit Menu (Index Window)
Copy:

Copies message files from the Message Index to the clipboard, so that they can be
pasted into Windows Explorer or other program that accepts files.

Paste:

Pastes a message in text form from the clipboard into a new message (if a proper
message format), or one or more message files copied from a Windows Explorer window
(again, if in a proper message format). Messages must start with an email-style header
(To/Subject etc) or the traditional "SP" radio format.

Delete:

Deletes the selected message(s) by moving them to the Trash folder, or deleting them if
there is no Trash folder.

Select All:

Selects all messages currently in the Message Index (i.e. in all open folders, including
those not on the visible part of the window).

Font:

Opens font-selection window for choosing a font style and size for the Message Index.
The Index font is also used for the Option window and Address Book.
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Undo:

Reverses the effect of the most recent edit change.

Cut:

Moves the selected text to the Clipboard for transfer to another window, deleting it.

Copy:

Makes a copy of the selected text in the Clipboard without deleting it.

Paste:

Pastes whatever text is contained in the Clipboard into the message at the Insertion
Point. The text is not removed from the Clipboard and can be pasted multiple times.

Paste >Quote: As above, except that each line of text is preceded by a ">" character, commonly used to
delimit quoted text in a reply message. For text that spans multiple lines, an option to reformat the lines is offered.
Delete:

Deletes the selected text.

Select All:

Selects all text in the message for a Cut or Copy operation.

Spell Check:

Performs a spell check on the current message (or selected text), marking misspelled
words. The right mouse button can be used to show suggested corrections in a pop-up
menu, or the option to add the word to a personal word list.

Mime Filter:

Converts any Mime-format codes ("=XX" and trailing "=") into normal text. The changes
are temporary, and can be saved if desired.

Unlock Read-only: Unlocks the read-only status for incoming messages. Use this only if you need to
make changes to incoming messages.
Font:

Opens font-selection window for choosing a font style and size for either the message
body or the message header, depending on which is currently selected. Separate font
settings are maintained for the header (normally MS Sans Serif) and the message body
(normally Courier New, a fixed-pitch font).

Find:

Opens the Find-text dialog, to search for a word or a phrase in the current message.

Find Next:

Repeats the Find-text operation for the next occurrence of the same word or phrase.
Same as pressing the F7 key.

Find Previous: Same as above except searches in the reverse direction.
View Menu (Main Program Window)
ToolBar:

Hides (or shows) the Toolbar across the top of the Main Program Window.

StatusBar:

Hides (or shows) the Status Bar across the bottom of the Main Program Window.

Message Header: Hides (or shows) the header panel on the top of each message. When the header
panel is visible the message header is shown as boxes in the panel; when hidden, the
message header is shown in its text format. This resets back to its default state (defined
in the Options window) when the message is closed.
Folder Tree:

Splits the Message Index to show a Folder Tree. With the Folder Tree visible, individual
folders can be opened or closed for inclusion in the Message Index. A simple click on a
folder will close all others and open that one, while clicking with the shift key down will
open (or close) that one folder without changing the status of the others.

MBO Bulletin: Opens the special Frequency List window, displaying the most recent list of MBO stations
in the text format. Changes can be made to the list, and an additional toolbar is provided
for selecting Center or Mark frequency, to display Text Format or List Format, or to save
the list. (This is the text format of the Frequency List display).
Frequency List: Opens the special Frequency List window, displaying the most recent Frequency List
file. An additional toolbar is provided for selecting Center or Mark frequency, to display
Text Format or List Format, or to save the list. Use the List format to change the station
selection for the Terminal Window's Station Box. (This is the List Format of the MBO
Bulletin display).
Station List:

Shows a new tree-format list of Systems, Stations and Frequencies. This can be used to
selecte individual stations to be include in the Terminal Window's Station list.
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Propagation: Opens a propagation-prediction window (if the ICEPAC propagation program is installed).
See Propagation Window »Page 94 for more details.
Tools Menu (Main Program Window)
Options:

Opens the Options Window. See Options WIndow »Page 21 for more information.

Dumb Terminal: Opens a "Dumb Terminal" Window for diagnosing controller problems. See Dumb
Terminal Window »Page 38 for more information.
Update PTC-II Firmware: For the PTC-II-family modems only, opens a special window to upload a
firmware file. See Updating PTC-II Firmware »Page 104 for more information.
Housekeeper: A background program which checks for unneeded files. This is the skelaton for a future
auto-filing system.
Address Book: opens a submenu with the following selections:
Import Addresses: Opens an address-import window to import address lists which have been
exported from Outlook, Outlook Express, Netscape Messenger or Juno, or other
programs that support compatible formats. Addresses can be edited before they are
merged with existing Address Book entries.
Export Addresses: Opens an file-save window, to save address-book entries as a Comma-Separated
Variable (CSV) format, compatible with Excel and Outlokok
Message Index:

Opens a submenu for the following utilities:

Refresh Address: Updates the "From" and "To" addresses in the Message Index for the selected
message(s). Used only for testing and to update the index when changes are made
to the address book.
Rebuild Index: Rebuilds the Message Index for each folder. This is not normally required and should
not be used unless messages are added to (or deleted from) the folders from outside
AirMail. The index is also rebuilt automatically if the MsgList.txt file for that folder is
deleted.
Make Frequency List: Opens the special Frequency List »Page 81 window (for HAM stations only), with
the selected message(s) as a new Frequency List. Multiple messages can be selected
and will be combined into a single list.
Update Catalog: If the selected message is a downloaded bulletin list, this function updates Airmail's
Catalog files. This function is normally done automatically, and this menu is provided for
testing only. See Catalogs for more information..
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Tile Vertically: Arranges the open MDI windows as vertical tiles.
Tile Horizontally: Arranges the open MDI windows as horizontal tiles.
Cascade:

Arranges the open MDI windows in a "cascading" arrangement.

Arrange icons: Reduces all MDI windows to icons along the bottom of the Main Window.
Terminal (F6): Opens the Terminal Window for communication with an MBO. The Terminal Window is a
separate window, not an MDI window in the Main Window. Use F6 or the corresponding
Toolbar buttons to go from the Main Window to the Terminal Window and back.
Address Book:

Opens the Address Book for review or changes. The Address Book is opened
automatically for address selection whenever a new message is created.

Catalogs

Opens the Catalogs Window »Page 87

Position Reports: Opens the Position-reports Window, see Position Reports window for more
information.
Winlink-2000

Opens the Winlink-2000 »Page 82 sub-menu:

Options Message Opens a window to format and send a WInlink-2000 Options message »Page 86
Position Report Opens the Position Report window to format and send a Winlink-2000 Position
Report »Page 84. (same as Position reports above except the Winlink-2000 format
tab is automatically selected).
Position Request Opens a window to format a request Position reports from Winlink-2000
Catalogs

Opens the Catalogs Window »Page 87 showing only Winlink-2000 stations.

Autocall Status Opens a window showing the current Autocall »Page 31 status
Files:

Opens the Files sub-menu:

Detailed Log:

Opens the detailed log file, a record of contacts and any errors

Capture File:

Opens a recent capture file, showing terminal-window activity

Autocall Schedule: Opens the autocall schedule file for editing.See Autocall »Page 31 for more
information
Controller startup: Opens a file of commands which are send to the modem when terminal window is
opened optional, and not normally used)
Controller shutdown Opens a file of commands which will be send to the modem when the terminal
window is closed (optional, and not normally used)
Autocall Status: If autocall is enabled, opens the Autocall Status window. See Autocalling »Page 31
for more information.
Help Menu
Contents:

Opens the AirMail Help system contents window.

About:

Opens the Help-About window, with revision and copyright information and how to
contact the author.

File Menu (Terminal Window)
Exit:

Closes the Terminal Window and returns to the Main Program window.
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Edit Menu (Terminal Window)
Copy:

Copies selected text into the Windows Clipboard.

Paste:

pastes text from the Windows Clipboard into the Keyboard Box for transmission.

View Menu (Terminal Window)
ToolBar:

Hides (or shows) the Toolbar at the top of the Terminal Window.

StatusBar:

Hides (or shows) the Status Bar at the bottom of the Terminal Window.

Show Link Messages: Toggles the show-link-messages setting, to show of hide the modem link
messages shown in red text.
Message/Index (F6): Switches back to the Main Program Window to view the Message Index or
Messages.
Control Menu (Terminal Window)
ChangeOver: Same as typing a Control/Y in the text, executes a link change-over from sending station
to receiving station when the buffer is empty. Normally used only in Unprompted (dumb
terminal) mode for ordinary QSO's, not for MBO operation.
Break:

Executes a "break", forcing a change from receiving station to sending station to interrupt
incoming text.

Connect:

Same as the green "Connect" button, used to initiate contact with the select station. Be
sure the frequency is clear before attempting to connect!

Disconnect:

Same as the red "Stop" button, executes a "Dirty Disconnect". Normally used to
terminate an unsuccessful connect attempt before the time-out, but can also be used to
force a disconnect while connected. This is sometimes necessary but a normal "controlD" disconnect is preferred whenever possible.

Xmit Unproto: Starts an "Unproto" transmission, for calling "CQ" and also uselful for setting audio levels.
Terminate by typing Control/D or clicking the Disconnect button.
PSK Unproto: (PTC-II only): Starts an "Unproto" transmission in PSK mode, primarily used for setting
audio levels. Terminate by typing Control/D or clicking the Disconnect button.
Set Amplitude: (PTC-II only): Opens a special toolbox for setting audio amplitude levels. See Setting
Audio Levels »Page 67 for more information.
Output Command: Allows direct output of a controller command. (Note that there is no echo or reply with
most controller types, this is a limitation of using the host-mode).
Mode Menu (Terminal Window)
Pactor:

Selects pactor Mode (the default)

Amtor:

Selects Amtor mode

Monitor Enabled: Enabled display of decoded data when not linked to another station
Long Path:

Set the Long Path calling option, which adds propogation delay to the Pactor timing to
accomodate very long signal paths.

Autocall Enabled: If autocall is set up, enables or disables the autocall mode.
Frequency Scan: When checked, allows frequency scanning using any selected station (not just the
SCAN station-box entry)
BBS Mode:

Selects the BBS-to-BBS transfer protocol (fully automatic).

Keyboard Mode:

Selects the Winlink Keyboard dialog mode (semi-automatic).

Unprompted Mode: Selects manual "dumb terminal" operation, with no protocol.
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Send All Messages: Only for Keyboard mode, Sends all pending messages.
Logoff When Done: Only for Keyboard mode, does an automatic logoff when other traffic is finished.
Close When Done: Closes the Terminal Window (and frees the radio and controller ports) when the
current connection is finished.
Help Menu (Terminal Window)
Contents:

Opens the AirMail Help system contents window.

About:

Opens the Help-About window, with revision and copyright information and how to
contact the author.

Introduction to Auto-Calling
An Airmail Autocall mode is available for PTC-II (and IIe) users. This allows messages to be forwarded
automatically on a scheduled basis, and also permits scheduled periods of standby operation for
incoming calls. To be fully effective, a remote control interface for the transceiver needs to be provided to
allow automatic frequency setting. For mobile operation an optional power-control circuit can be
constructed and connected the serial port's DTR pin for automatic power control. The PTC-II's busychannel detector is utilized to minimize the chance of transmitting on an occupied frequency, therefore
the limitation to only PTC-II controllers. PTC-II firmware version 2.3 or later must be utilized, as the busychannel detection algorithm in earlier versions was not effective.
AirMail's Autocall mode is not for beginning users, as it adds a level of complexity to the operation of the
program. If you are not yet completely comfortable with computers, digital radio and the AirMail program
then we suggest that you put off trying it out.
Also keep in mind that your station must operate without causing interference to others, whether it is a
computer or a finger pressing the buttons. It is not intended that Autocalling be used for unattended
operation, but in any event it is your responsibility alone to operate your station without causing
interference.
It must also be noted that, for hams operating under US rules, automatic operation is only permitted in
certain narrow sub-bands per FCC rule 97.221. These sub-bands are 3620-3635, 7100-7105, 1014010150, 14095-14099.5, 14100.5-14112, 18105-18110, 21090-21100, 24925-24930 and 28120-281289
KHz. Different regulations may apply in other countries.
Another important consideration is that dangerous voltages can be present on exposed antenna elements
and connections, and any hazard is increased with automatic operation of the transmitter. Appropriate
safeguards must be taken to avoid accidental contact, including insulation and notices where appropriate
and any other measures appropriate for the installation. Be careful, and don't take chances!
For more information see the sections that follow:
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Setting up Autocalling
The first step to setting up Autocalling is to decide what you want to do. Autocall is just a dumb robot, and
cannot think for you. So step one is to some experimenting and determine which stations you want to
exchange traffic with, and choose time periods when both propagation and access are good.
Autocalling is all done with designated time slots with starting and ending times. Each time slot is
associated with a single station. At the beginning of the time slot the Terminal Window is opened
automatically, and the first designated frequency is set. That frequency is monitored for digital traffic
(QRM) for 10 seconds, and if QRM is detected then the program will wait up to 30 seconds before
selecting the next designated frequency in rotation (if specified). If no QRM is detected for a 10 second
period then the station is called. If there is no contact then the Terminal Window will remain open for the
duration of the time slot, and the call will be repeated at an interval of 3 minutes (unless specified
otherwise). If no contact is made then the Terminal Window closes at the end of the time slot (or earlier if
the end of the wait interval would be past the end of the time slot). If contact is made then the Terminal
Window stays open for the duration of the contact and closes when finished irrespective of the time slot.
Time slots can also be defined for Standby operation, when the Terminal window will be open for
incoming calls. A single frequency can be designated, or a list of multiple frequencies can be specified
and the transceiver will be stepped through the list in rotation at 3-second intervals. Alternately a Scan
List »Page 34 can be defined and the keyword "Scan" used instead of a specific frequency.
See the next section Autocall Schedule »Page 33 for details on setting up a schedule.
AutoAnswer Mode
AirMail provides support for handling incoming connects. If the Terminal Window is left open (either
visible or minimized) with BBS Mode enabled, then another AirMail or WinLink station can connect to your
station and exchange messages automatically. Keyboard users can also connect, and can send and read
messages manually. The ONLY messages that can be read, either automatically or by keyboard users,
are those addressed to the other station. So security is not a problem, and there is provision to access
any other messages or files.
AutoAnswer mode is enabled by default, to disable it un-check the "Accept Incoming Connects" box on
the AutoAnswer page of the Options window (Tools/Options menu).
Messages to stations that are expected to connect are posted in the same way as any other message.
Start the message with SP CALLSIGN, followed by the subject and the message text, and post it to the
same station's callsign. When that station connects then those messages will be automatically forwarded
(or made available to be read by a keyboard user).
Messages received from other stations in Auto-Answer mode are stored into the Message Index just like
any other new incoming message.
Messages may also be received addressed to other stations, to be forwarded. This would normally only
happen by prior arrangement, as the result of a WinLink intercept to forward messages to a station that
cannot connect directly. In this case a message can be sent to your station, addressed to a third station. If
the third station is known (i.e. recently connected or appears in the Auto-Posting list - see Posting/Routing
Options »Page 24) then the message is posted onwards automatically and will appear in the Index as a
"Thru" message with a "mailbox" icon. If the station is not known (i.e. not in the Auto-Post list and no
recent connect) then the message will appear in the Index with a yellow "?" icon and will have to be
posted manually.
There is also the issue of Routing Lines to be considered. Routing Lines are the "R:" Lines that get
stamped onto each message as passes through successive MBO's, and provide a record of the routing.
The most important component of each Routing Line is the full MBO address prefixed by "@:". The last
Routing Line (the first added) is the originating MBO and defines the return address, so this line is the
most important - the others are only used for tracking purposes. An incorrect MBO address in the original
Routing Line will result in return messages getting lost.
Since only the original R-Line defines the return address, adding additional lines is safe and AirMail will
always add its own to incoming "Thru" messages (messages addressed to other stations). Your own
outgoing messages are normally sent without any R-Lines, and will be stamped by the receiving MBO
and carry that MBO address as the return address.
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The tricky case is a message sent to you, to be forwarded onward, from another AirMail user or from
keyboard entry in auto-answer mode. These messages will not normally carry any R-Lines and are
required (by the regulations) to be stamped before being sent onward. If you have defined a Home BBS
(see AutoAnswer Options »Page 24) then that will be used for the Routing Line, along with your zip code
(if defined).
Unless the sysop of your forwarding MBO indicates otherwise, the proper thing to do is set Home BBS to
the full hierarchical address (H-Address) of your forwarding MBO (e.g. KN6KB.#MLBFL.FL.USA.NA). This
sets the message return address to your forwarding MBO, not yourself, and the Routing Line ID (the part
in the square brackets) will be [from YOURCALL] to provide tracking information.
The other possible option, with the coordination of the sysop of your forwarding MBO, is to set Home BBS
to your own callsign and H-Address, and then your station will appear as the return address. In this case
the Routing Line ID will be taken from the AutoAnswer Options page. Be careful about this choice,
because if the H-Address is not sensible then other MBO's will not know how to route messages to you.
Since mobile users rarely have sensible H-Addresses, this is not generally a good choice for a mobile
station.

Setting up an Autocall Schedule:
The heart of Autocalling is a Schedule File. This is a plain-text file that defines stations and time slots for
calling. The schedule can be accessed by selecting Window/File/Autocall Schedule from the main
menu, or by editing the file directly with Notepad or any other plain-text editor. (The file is named
Autocall.txt unless changed in the Airmail.ini setup file).
The schedule file consists on one line per event, each line consisting of fields separated by one or more
spaces. The fields designate the start and stop times (in UTC), the frequency, action, callsign, and any
modifiers. A typical schedule might contain the following:
06:05
"
08:58
"

06:20 7104.4,10140.4 autocall kn6kb power=50
"
7101.4,7104.4,10140.4 autocall n8pgr inhibit=6
10:15 scan standby
"
7101.4,10140.4 autocall n0zo inhibit=2

The fields are as follows:
1) Start time, hh:mm (UTC), ditto marks can be used as illustrated.
2) Finish time, hh:mm (UTC)
3) Frequency, can be multiple frequencies, comma-delimited (no spaces!), use a single frequency or
the keyword "Scan" for Autostandby
4) Operation, "Autocall" to initiate an auto call, "standby" for Auto standby
5) Station to be called
6) Any modifiers (optional), separated by spaces:
inhibit=H means skip the call if connected within previous H hours, unless traffic is pending (default is to
call every time)
interval=M means repeat the call every M minutes until end of period (default is 5 minutes)
Maxtries=X means to attempt contact a maximum of X times (default is three).
power=XX means reduce PTC-II power to XX percent (default is 100%, use this option for nearby
stations).
Defer=NNNN means that messages larger than NNNN bytes will be deferred. This overrides the default
"Defer" setting in Tools/Options/Settings, and a specification of 0 means that messages of any size
will be downloaded. This feature can be used to defer downloading of long messages to off-peak
hours.
Note that autocall entries can overlap, and all active autocall tasks will be handled on a rotating basis until
they are either satisfied (i.e. contact has been made) or three attempts have been made, three strikes
and they are out. Once all active entries are satisfied or struck out, Terminal Window will close unless
there is also an overlapping standby period defined. If the end of the time period is reached before all of
the entries are satisfied or stuck out then Terminal Window will close at the end of the current activity.
The schedule file can be given any name (skedfile.txt for example), and the name is defined by an entry
in the existing [AutoAnswer] section of AirMail.ini as follows:
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[AutoAnswer]
Timer File=c:\program files\AirMail\skedfile.txt
(Do not create a new [AutoAnswer] section, there should be one already, stick the "Timer File" line
anywhere after the [AutoAnswer] header and before the next header).
If AirMail finds a Timer File entry under [AutoAnswer], and the file exists, and the controller type is a PTCII, then an "Auto" menu item will appear in the Main Window menu. This menu item can be used to
enable or disable the Autocall and Autostandby modes.

Setting up a Scanner:
For the ham version, Airmail can scan multiple channels for incoming connections. This is done by
entering a scan-list, which then adds a special callsign "SCAN" to the Terminal-window's station-list.
Whever the "SCAN" entry is selected, the frequencies in the scan-list are selected sequentally at a twosecond interval. Scanning stops when a connection is made, and resumes after a 10-second pause at the
end of the connection. (These timings are all changeable, see below).
To enter scan freuqencies, select Airmail's View/Station List menu, select the appropriate system name
and click the "Settings" button. This brings up the "System Properties" window. Click the "Station" tab,
and enter the scan frequencies in the "Scan List" box (in kHz, seperated by commas). If you want
scanning to start automatically whenever Terminal-window opens, then check the "Auto" box. (Otherwise
it is necessary to select "SCAN" from the station-list).
Advanced users: The frequency list is stored in the "system.xxx.ini" file (where "xxx" is the system name),
under the "[Frequency Setup]" heading. The frequency list is stored as "Scan List", the scan interval
(seconds per channel) is "Scan Interval", and the delay (in seconds) before resuming scanning after a
connection is "Scan Delay".
Be sure to understand and respect the appropriate rules for unattended or automatic operation.
Troubleshooting Autocall
Do you see an "Auto" menu in Airmail's main window? (between "Tools" and "Window"). If not, then
either there is no "Timer File=xxx" line under [AutoAnswer] in the airmail.ini file, or the file was not
found, or you have not selected a PTC-II controller. The full file name and path must be specified, i.e.
Timer File=C:\Program files\Airmail\AutoCall.txt
If the Auto menu is there, click it: Is "Autocall Enabled" checked? If not, click on "Autocall Enabled"
to check it, then look at it again (don't click it again unless you want to un-check it, the checkmark toggles
with each click). Ditto for "AutoStandby Enabled" if you have specified a standby period for incoming calls.
There should be a "Autocall Schedule" entry in the Windows/File menu, this allows viewing and
editing of the schedule file. This gets enabled at the same time as the "Auto" Menu.
Be sure that the times in the schedule file are UTC, and be sure that Airmail is displaying the correct
UTC time in the lower-right corner of the status bar. This is Airmail's master clock, used to control
autocalling, and is taken from the Windows system settings. If the indicated UTC time is not correct then
go to Windows Control Panel, Date/Time, and check the Time Zone page. If your time and time zone
settings are correct then Windows should report the correct UTC time. If you want to set your computer
clock to UTC time, select GMT/Monrovia and not GMT/London, because London uses Daylight Savings
Time.
Once everything else is set up, check the Main Window status bar for a message such as "Next
Autocall 00:00 WA6OYC" on the right-hand side (next to the time display). This message pops up in place
of the "999 messages, 1 selected" message after 5-10 seconds.
Be sure the Terminal Window is closed. If the terminal window is open then the autocall will not
happen. If you want to leave the terminal window open for incoming calls, interspersed with periodic
autocalls, then specify an overlapping autostandby period such as:
06:00 08:00 scan airmail
06:50 06:55 14072.9 autocall oe4xbu
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Airmail maintains a number of log files for reference and to aid in debugging. These files are generally
stored in the Airmail\Logfiles folder and are as follows:
Capture Files: A transcript of each session is copied into a capture file automatically, and saved in the
airmail\capture\ folder. A separate file is written for each day, named "cayymmdd.txt" where yymmdd
represents the year, month and day (in UTC). These files are for reference only and not used by AirMail,
and may be deleted as desired. The most recent capture file may be opened by selecting "Capture File"
from the Window menu.
Log File: A summary log is accumulated into file called Logfile.txt This log file may be viewed or edited
by selecting "Log File" from the Window menu. As this file grows it can get unwieldy, and should be
periodically trimmed (by deleting lines and saving) or renamed (for example Logfile.save1.txt) or moved to
an archive folder. AirMail will automatically start a new log file if the current one is not found.
Scrollback file: The most recent Terminal Window activity can be viewed without opening the Terminal
Window by selecting "Scrollback File" from the Window menu. This is the color-coded text from the upper
Terminal Window box and is basically the same information as the Capture File.
Frequency-Control Window
A special control window is provided for exercising Airmail's radio control interface. This is only available if
a frequency-control interface is provided to the radio, e.g. through a PTC-II controller or via a second
serial-port cable. The Frequency Control Window allows setting of all available modes, and provides
memory for storing frequencies and modes. The primary purpose is to provide means of testing the radio
interface, but also to provide general remote-control operation of the radio where desired.
The Memory panel has an upper box for entering or selecting a "group" name, and a lower box for a list
of frequency settings. To add a new group, type a new name into the upper fox, set the frequency and
mode in the appropriate boxes, and click Save. The new settings will be shown in the format
'RxFreq/TxFreq/Mode/VFO/Filter" (TxFreq is only used for duplex frequencies).
The Frequency panel allows transmit./receive frequencies to be entered. Checking Duplex allows a
separate transmit frequency to be entered, checking Track causes the transmit frequency to track
up/down changes to the receive frequency. Buttons are provide to select the up/down increment, select
the frequency box and use the up/down arrow keys to increment it. The VFO or memory channel can also
be entered, and filters selected. A tune button is provided to initiate a tune cycle (if available- see below).
The Mode panel allows selection of the operating mode. Not all modes are available for all radios, see
below.
Important note: Not all features are available for all radios. In particular, if the control mode is "via PTCII" (Tools/Options/Connection, Radio Connection settings) then only a simplex frequency can be set, the
other features are unavailable (this is a limitation of the PTC-II's radio-control mode). AFSK (Audio FSK)
mode is only available with certain marine SSB radios (e.g. Icom M710 family). Filter settings are only
available with certain radio types and if the radio is equipped with a suitable filter. The remote-tune is only
available with "Icom-NMEA" radio types (e.g. Icom M710 family).
Winlink Commands
The
The
You
the

following commands are supported.
first column lists the primary command (short form).
may optionally spell out commands as listed in
second column (alias).

Cmd
Alias
Function
-----------------------------------------------------A
ABORT
Sending station shall Stop Sending
B
BYE
Log off from WinLink
CANCEL #
Delete my message number # (1)
CHANGExx
Remote control commands, reserved for remote Sysops
D #
DELETE
Delete my message number# (1)
E
EXPERT
Expert Mode (ON/OFF); Show current mode w/o parameter
H
HELP
Read the Main Help file (this file)
K #
KILL
Delete my message number # (1)
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I
INFO
L
LIST
LM
LIST
LB
LB #
LLB # (loc)
LF
LH
LI
LL
LL # (loc)
LN
LOGOUT, LOGOFF, QRT
LR
LT
LY
L> CALL LTO
L< CALL LFM
L@ CALL
NTS
PAGE
R #
READ #
RC
RH #
RM
RN
RMM # # ...
RMMC # # ...
SP CALL S
SP CALL@BBSCALL.HR
SB TOPIC
SB TOPIC@DESTN
SFM
ST
TIME
T
TALK
V
VERSION
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Read the Information File for this mode
List all my PRIVATE and NTS messages
List all my PRIVATE and NTS messages
List new Bulletins since your last inquiry
List Bulletins in the system, starting with Bul #
List last # Bulletins filed, beginning at "loc" (2)
List stations' FORWARDING file (for MBOs only)
List all HELP messages/files
List stations' INTERCEPT file (for MBOs only)
List new Messages since your last inquiry (2)
List last # messages filed, beginning at "loc" (2)
List all my unread messages
Log out from WinLink
List users in last 24 hours
List all NTS messages in the system
List this station's usage statistics
List all messages addressed to "CALL" 2 (1)
List all messages from "CALL" (2)
List all messages addressed "@ CALL" (2)
List all "pending" NTS messages
Page Mode (ON/OFF). Show current mode w/o parameter
Read a specific message number WITHOUT headers
Read all my pending messages without confirmation
Read a specific message number WITH routing headers
Read all my unread messages WITHOUT headers
Read multiple messages
Read multiple messages without confirmation
Send a PRIVATE message to CALL. (3)
Send a PRIVATE message to CALL at BBSCALL (4)
Send a BULLETIN to TOPIC
Send a Bulletin to TOPIC at DESTINATION
Send a file of contiguous messages
Send a NTS message
Show daily BBS usage limit and time left
Alert the Sysop
Ask for the current WinLink software version

Messages are terminated with the /EX character sequence
starting at the beginning of a new line and followed by an <ENTER>.
Notes:
(1): You may still re-read a Deleted message until the next MBO message purge cycle,
but you must remember its message nummber.
(2): MBO users can see any message in the system while Keyboarders can only see
messages addressed TO or FROM themselves. (loc) allows you to start the list with
that message number, the oldest message ('O') or the newest message ('N') See the
LIST help file for a more detailed explanation.
(3): Sending a message w/o routing information may stay at that MBO until the
recipient connects to that same station to read it.
(4): BBSCALL.HR = Callsign of BBS with hierarchical route, where the message will
automatically be forwarded to!
e.g. VK2AGE.#NE.NSW.AUS.OC
^^^ ^^^^^^^^^^^^^^^
|
|____ Hierarchical route
|____BBS-callsign

Message Formats
Airmail stores messages internally with email-style headers (per RFC-822). The following header fields
are used:
To:
Cc:
X-To:
X-Date:

Email "To" address (not used for radio messages)
Email "Cc" address for copies (ditto)
Radio "To" address, either the radio recipient or the email gateway name
Date that the message was last modified by Airmail
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X-Type:
X-Status:
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The message subject line
The message type, the first field indicates incoming ("inmsg"), outgoing ("outmail") or a
message being passed trough ("thru"). The second field indicates Email, Radio, Bulletin
or NTS message (the latter two applicable to ham systems only).
The current message status, a mirror of the message index "Status" column.

The traditional "SP" message formats are also understood and can be used for importing messages.
Troubleshooting Guide
See the following sections for specific topics:
Using the Dumb Terminal Window »Page 38
Error message - Comm Port Unavailable »Page 38
Error message - Controller Initialization Fails »Page 39
Terminal Window "Hangs" when connected »Page 39
Transceiver frequency not set »Page 40
Characters not displayed properly »Page 41
Errors in Binary Mode »Page 41
Can't connect to station »Page 80
Messages can't be downloaded »Page 42
Messages can't be uploaded »Page 80
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Dumb Terminal Window
A "Dumb Terminal" Window is available for diagnosing problems with recalcitrant modems. It is opened
by selecting Dumb Terminal from Terminal Window's Tools menu. A Dumb Terminal window allows
sending characters to the controller with no intermediate processing, and displays all characters sent from
the controller. Typical uses are to establish the correct baud rate if not known, to send a hard-reset
command (the Kantronics "RESTORE DEFAULTS" for example) or to set options not available from
within AirMail.
Drop-down boxes are provided for selecting a COM port and baud rate, and changes to these boxes take
effect immediately with a warning for unavailable ports or no port-ready (CTS) signal from the controller
(the port remains functional in this case, however). Changes here are NOT saved back to the modem
settings, if the change is permamnent then change the modem setting sin Tools/Options also.
A check box controls local echo. Anything typed on the keyboard goes to the controller and is displayed in
blue text (if "Local Echo" is checked), and anything the controller sends is displayed in black text.
A button is also provided to reset the Kantronics Host Mode if the controller type specified in the Options
page is a KAM. This button sends the FEND-q-FEND combination required to reset the Kantronics host
mode (a power cycle will not do it). Indication that the KAM is in host mode is display of just a few
characters including "S00" when the power is cycled. Clicking the Reset-Host button should restore
keyboard operation.

Comm Port Unavailable:
If you get a message box "COMx is unavailable or in use" when opening Terminal Window it means that
Windows has assigned the specified serial comm port to another application and it is not available to
AirMail's Terminal window. A serial port can only be used by one application at a time. If another
application such as a weather fax program or another terminal program is using the port, then the port will
not be available to Airmail and the other program will have to be closed first.
Airmail itself can make use of multiple serial ports (one for the modem, optionally a second for the radiocontrol interface, and optionally another for a NMEA interface for the position-reporting window). The
same Comm-port number cannot be assigned to more than one of these ports.
The other common reason for a port to be reported as "unavailable" is that W indows has assigned it to an
external modem. If a modem is configured in Windows as an external modem attached to a serial port,
then that port becomes unavailable to other applications even when the modem not connected and not in
use. The only remedy is to remove the modem (or assign it to a different serial port) using the Windows
Device Manager (Start Menu/Control Panel/System/Device Manager).
Besides an external modem, other devices such as a Handheld PC (HPC) link program can have a comm
port reserved.

Troubleshooting Serial Ports
AirMail uses the standard Windows communications drivers with 32K buffers, so compatibility problems
are rare, and Airmail can use any serial port that Windows supports. In case of difficulty, one important
test is whether a general terminal program such as Windows Terminal or HyperTerminal (in the
"Accessories" group) can be used to communicate with the modem.
Airmail does not use the RS-232 control lines for most modem types (the MFJ family excepted), but it
does check for the presence of the CTS signal to indicate that the modem is powered on, and the use of
a fully-wired serial cable is recommended. AirMail sets DTR true when the Terminal Window opens, and
sets DTR false when it closes. This can be used, if desired, to control power to the decoder and/or
transceiver.
If AirMail reports that a Comm port is unavailable or in use, that means the port was reported by Windows
as being unavailable. The usual cause is that the port is in use by another application, a weather fax
program or another terminal program. A port can only be assigned to one application at a time. (AirMail
only utilizes the port when the Terminal Window is open). Another less-obvious cause for a port being
unavailable is that it is assigned to an external modem. If a modem (internal or external) is set up to make
use of a Comm port, then that port will not be available for other applications until the modem is removed.
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Modem assignments can be checked and removed via the Windows Device Manager (Start/Control
Panel/System/Device Manager).

Controller Initialization Fails:
When the Terminal Window opens, Airmail attempts to establish communications with the controller. If
successful, "Init OK" is displayed in the Terminal Window status bar and the red/green
connect/disconnect buttons will be enabled. If communications cannot be established with the controller
then a "Initialization Failed" message is displayed.
If this happens, first check the settings on the first Tools/Options page, particularly the controller type and
baud rate. Some controllers (PTC-II, PK-232 with the jumper removed, MFJ-1278B) always power-up in
an autobaud state, others are set to a fixed baud rate which has to match the baud rate selected in
Airmail's Options page.
The other common problem is that the controller has been set to an incompatible state by another
program. The Kantronics KAM+ in particular has a number of operating modes which change the normal
computer dialog. As these have been identified they have been corrected but there are undoubtedly still
more, and feedback is most appreciated.
Some comments for particular controllers:
PTC-II: Airmail is sometimes unable to initialize a PTC-II that is left in host mode, for example by another
program or if Airmail was not shut down properly. Turning the power on and off will reset host mode and
solve the problem. It is also possible to defeat the initial autobaud and set a fixed baud rate using the
Serbaud command, it is recommended that this NOT be done. There is also an option (on the
Tools/Options page) to restart the controller, this slows the initialization slightly but is recommended if he
controller ever exhibits a problem with carriage returns (displaying "[28]m" instead of carriage returns).
This is a PTC-II firmware problem apparently triggered by rapid power cycling, and requires a hard reset
(Restart command) to clear it.
KAM+: First, use 9600 baud if not already set (see below). The Kantronics KAM+ has a multitude of
commands and operating modes, some of which may interfere with operation by AirMail. The best option
is to perform a hard reset and restore all default settings, this is done as follows: Power on the KAM+,
open Airmail's Dumb Terminal window (from the Tools menu), make sure that the correct COM port and
baud rate are selected, and then hit the enter key to get a "cmd:" prompt. (If you don't see a "cmd:"
prompt, toggle the power off and on. If you only see a couple of control characters, then click the "Reset
Host" button). When you get a "cmd:" prompt, enter the command RESTORE DEFAULTS command
(spelled out, all caps). This will restore all settings and start the autobaud sequence. (If you get a "not
allowed in Newuser mode", then enter the command INT TERM, then try the RESTORE DEFAULTS
again).
If you are not using 9600 baud then this is the time to change it- after entering the RESTORE DEFAULTS
command but before doing anything else, change the baud rate box at the top of the Dumb Terminal
Window to 9600.
Next, watch the window text and when you see "Type an asterisk" then type an asterisk (*) so that the
autobaud routine can identify the baud rate. It will ask for your callsign, and then display a "cmd:" prompt.
Close Dumb Terminal window. Now open Airmail's Tools/Options window, connection tab, and make sure
that the modem baud-rate there is also set to 9600. Click OK, and try opening Terminal Window again.
If you do this with some other program than Airmail's Dumb Terminal window, then it is critical is that the
data bits and parity be set to 8 bits and no parity, otherwise the incorrect settings will be latched by the
KAM's autobaud detection. Airmail's Dumb Terminal window is OK, but if you use anther program then
check the settings).
PK-232: The PK-232mbx controller has a jumper (accessible through a hole in the bottom cover) to
disconnect the backup battery. Removing this jumper causes the PK-232 to power-on in a reset state,
with autobaud active (only the "Baudot" indicator lit). Disconnecting this jumper solves all potential
configuration problems and is strongly recommended.
MFJ-1278B: Try NOT checking the "Restart controller box (Tools/Options, first page on the left).

Terminal Window "Hangs" when connected:
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Keyboard "hangs" during a QSO with another (non-MBO) station: Terminal Window is most likely in
BBS or Keyboard mode. Switch to Unprompted -- click BBS or Keyboard mode buttons until both are up,
or select Unprompted from the Terminal Window's Mode menu.
Program "hangs" during Keyboard-mode connection to an MBO: Keyboard mode only works reliably
for WinLink MBO software. Other MBO's may work in keyboard mode if they follow the same command
protocol exactly, but in general Unprompted Mode will be required.
With a WinLink MBO, it is also possible that an error message was not recognized or that a change to the
WinLink dialog is causing problems. Use Control/Force Prompt to allow the dialog to proceed, and
forward a relevant excerpt of the capture file (including the WinLink logon ID) to the author (see the
Help/About window).
If Airmail hangs when forwarding mail,. the most common cause would be RF interference to the
computer. The solution is a better ground system and more ferrites. See RF Isolation »Page 70.

Transceiver frequency not set:
This discussion assumes that the remote frequency-control cable is properly wired and connected:
Recheck all of the settings in the Tools/Options window, and check the cable connection between the
transceiver and the PTC-II or serial port. Be sure the transceiver has a compatible interface, often an
option (or unavailable altogether) for many older radios. Also consider voltage levels: the PTC-II provides
a TTL-level interface appropriate for Kenwood radios, and also a special Icom interface connection. SGC
radios will need an RS-232 converter if connected to the PTC-II (available from SCS) or a direct
connection to a serial port.
The "via PTC-II" mode supports Kenwood, Icom, Yaesu and SGC transceivers. The two "Direct" modes
support mode and filter setting, but only support Kenwood, Icom ham, Icom marine, and Yaesu radios at
this time. In any mode the baud rate must be set correctly and for Icom transceivers the correct hex
address must be specified (although the address of "00" works for all Icom ham models unless their
"transceive" option is turned off). Common Icom hex addresses are 48 for the IC-706, 28 for the 725, 04
for the 735, and 1C for the 751).
For Icom marine radios (Airmail's "Icom-NMEA" option), the radio's remote-ID must match the "Icom
Addr" set in Airmail's options page. The "00" default value will not work here. Common values are either
"01" or "04", and can be checked or changed by using the radio's power-on setup menu (press power-on,
"F" and "1" keys together). Also note that the "d-Sub" or "RS-232" setting is used whether the cable is
connected to the 1/8" "Clone" jack, or the 9-pin NMEA connector. The Icom-NMEA baud rate is always
4800.
If you still have problems, refer to the respective manuals for more information or drop us an email.
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Some characters are not displayed properly:
The ANSI character set defines characters with codes in the range 32-127. An 8-bit character defines 256
character codes, and a number of different extensions to the ANSI character set are in use, the DOS
character set being the one most-often used for Pactor. Windows of course uses a different extended
character set, with the extra codes properly used for additional local-language characters rather than
character-mode graphics. AirMail does the standard Windows translation from DOS to the Windows
character set, and for messages that contain character-mode graphics the results will be hopeless.
Additionally, email messages are often Mime-encoded but the identifying headers have been stripped, so
again we do our best but the results are sometimes unpredictable.

Format errors in Binary Mode
If an error is detected in the binary protocol, then a disconnection will occur and an error code will be
shown on the upper terminal window display, in black if received from the other station, and in blue of the
error was detected by your station. Most errors indicate a problem with data transmission between the
computer and modem.
Error- Unknown reply
Error- FS reply not found
Error- Proposal checksum mismatch
These messages indicate that an error was detected during the proposal phase of the transfer, when the
"FA/FB" proposal lines are exchanged. The usual cause is a dropped character, most likely due to RF
interference with the serial-port communication between the computer and TNC. Another possible cause
is that the power-saving circuitry in the computer is shutting down the serial port. Try disabling all powersaving modes. Most serial-port errors on incoming data are detected and logged in the log file, but errors
in data to the TNC are not usually detected. The exception is the PTC-II controller which detects errors in
both directions and retransmits the bad data.
Binary
Binary
ErrorBinary
Binary

format error (STX/EOT not found)
header format error
Invalid offset character
checksum error
file CRC error

These errors all indicate a format problem with the binary data being transmitted. The reasons are the
same as the above. For a PTC-II modem, another possible cause is a bug in Firmware Versions 2.9 and
prior, which causes a CR code to be displayed as "[28]m" in the Echo (blue) text. The fix is to reset the
modem with a "RESTART" command, either using Airmail's Dumb Terminal window or by checking the
"Restart Controller" box in Airmail's TOols/Options window, Connection tab.
Error- Binary CRC/Length mismatch: File has changed!
This does NOT indicate bad data, but rather that the file at the other station has been changed before an
interrupted transfer could be completed. When a link is broken, the binary protocol attempts to retransmit
only the part of the message that is missing. If the message has changed in the meantime, then the CRC
error-checking code or the length will indicate that the file is different and the transfer will be aborted. The
remedy is to simply reconnect, on the next connection the message will be resent in its entirety.
PTC-II CRC-Host Mode NAK code received
PTC-II host mode CRC error detected, retry
There indicate errors on the serial data connection between the computer and a PTC-II-family modem.
Airmail will automatically send the data again, and in most cases the error is rully recovered. These can
be considered warning messages, indicating a problem that should be addressed (usually RF
interference, possibly hardware FIFO buffers disabled on the serial port). These messages are only
displayed when "Show Link Messages" is enabled.
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Messages are not downloaded
If messages are indicated as being available (i.e. a message of "QTC xx msgs xxxx bytes" when
connecting) yet Airmail does not download them, the most likely cause is that the messages were already
received. If the message is a duplicate of what you already have, then you will see a message in the
terminal-window (in green) which says "message already received on xxxx/xx/xx" with a date and time.
This duplicate-message check is based on the Message-ID (MID) code, the first column of Airmail's
Message Index window, which will match the MID in the coded message-proposal from the station.
Airmail also includes size limits for deferring or rejecting a message. These settings are in the Options
window (Tools menu), on the Settings tab. If the Defer ir Reject limit size is set, then messages larger
than thoses limits will not be downloaded.
If you know that messages were sent to your address, yet the QTC-count from the station is zero, then
there is either a problem with the station, or an error with the internet address, not a problem at your end.
Address errors are common, for example it is very easy to confuse the number "0" with the letter "O". In
general, you should send your correspondants a note first, and ask them to send a reply message, and
save the return address in their address book without retyping it.

Connections:
The following sections deal with connecting specific modems to a SSB transceiver. The across the top
provide general information on each modem type, and the links down the left side provide general
information about the selected radio type. The link at the intersection of a modem and radio provides
detailed setup information, where available.
PTC-II
PTC-IIe KAM+
KAMPK-232 MFJ
»Page
»Page
»Page
98
»Page
»Page
44
45
45
»Page
46
46
46
Icom
Ham Click
»Page 48
»Page
56
Icom
IC-706 Click
»Page 49
»Page
57
Icom
Marine Click
»Page 50
»Page
61
Kenwood Ham Click
»Page 50
»Page
60
Yaesu »Page
53
SGC »Page 53
There is also some good general information available here »Page 64.
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Connecting a Pactor Modem (general notes):
These are general notes for connecting a Pactor modem, refer to Connections »Page 42 for detailed
information.
A Pactor modem (also known as a controller or TNC) converts the computer's digital data into tones that
the radio transceiver can transmit, and separates the received audio tones and converts them into digital
codes for the computer. The connection between computer and modem is a standard RS-232 serial-port
connection. The connection to the radio consists of three signals: an outgoing audio signal to be
transmitted, an incoming audio signal from the receiver, and a signal to tell the radio when to transmit.
This latter signal is usually called "PTT", from "Push-to-transmit", a reference to the push-to-transmit
button on the side of the microphone. Neither the microphone or its PTT button are used of course, but
the nomenclature has stuck.
Power: The power connector used by the PTC-II, Kantronics, PK-232 and MFJ controllers is a 5.5mm x
2.1mm coaxial-pin connector (the only thing they all agreed on). The center pin is positive, not negative,
and the penalty for wiring it backwards is severe. (Note that the PTC-II has an alternate 12V input on its
HF audio connector which can be used if 12 volts is available from the radio‟s accessory connector).
Serial Cable: The computer connection for the PTC-II and KAM-98 modems is a 9-pin female connector
that matches the standard 9-pin serial port connector used on modern PC computers, so a standard 9-pin
female to 9-pin male serial extension cable can be used. The Kantronics KAM+, PK-232 and MFJ
controllers use a 25-pin modem connector and can be connected with a standard 9-pin female to 25-pin
male modem cable.
Baud rate: Whichever type of modem is used, use of the highest available baud rate is recommended.
There is no additional burden on either controller or computer and the response of the controller will be
better. There is much more communication between Airmail and the mmodem than simply the pactor
data.
The PTC-II starts in an autobaud routine by default, and should be generally left in that state (i.e. don‟t set
the baud rate with the SERBAUD command). Setting the AirMail baud rate to 38400 or 57600 baud is
recommended.
The KAM+ has a fixed baud rate, set by an autobaud routine when the unit is first initialized, AirMail will
do this if required (i.e. a new controller or one which has just been reset with the RESTORE DEFAULTS
command). Initializing the baud rate to 9600 baud is recommended.
The MFJ-1276 modem has a switch-selected baud rate, and 9600 baud is recommended. The baud rate
for the MFJ-1278B is initially set with an autobaud sequence and 9600 is also recommended.
The PK-232 has a jumper option (JP-1) to always reset defaults on power-up and start in autobaud, and it
is recommended that this mode be used and JP-1 be removed. Set AirMail's baud rate to 9600.
Use Airmail‟s Startup Wizard »Page 117 or Connection Options »Page 22 page to set the controller type
and baud rate.
Audio Cable: A 4-wire cable connects carries transmit audio from the modem to the transceiver, receive
audio from the transceiver to the modem, a push-to-talk (actually "ground-to-transmit") signal from the
modem to the transceiver, and ground.
This cable MUST be shielded, with the shield connected to the connector shell at each end, and clip-on
ferrites should be added to each end to reduce RF interference (see RF Interference »Page 70). The pin
connections are different for each controller and for each radio, so generally a cable must be made up
specifically for each configuration.
If the radio has a rear-panel "Accessory" connector then that would be the first choice by far, otherwise
the front-panel microphone connector can be used. An accessory jack generally provides line-level input
and outputs and (on most radios) and on some radios disables the microphone when the rear-panel
"PTT" connection is activated.
If you do use the microphone connector, check for a speaker or audio-out connection on same connector,
otherwise a rear-panel speaker or audio-out connector must be used. You do NOT want to disable the
speaker completely, however, as it is very important to be able to listen on a frequency before
transmitting to avoid causing interference. Also consider MFJ's TNC/microphone switch
(http://www.mfjenterprises.com/mfj/switches/tncmic.html). The problem with using a microphone
connection is that they are designed for a low-level, high-impedance signal while the modem output
represents a relatively high signal level. One solution, to reduce the signal level and reduce noise
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sensitivity, is to add a resistor from the mic input to ground (470 ohms would be a suitable choice).
Whatever connection you use, be sure that the transmitter audio is not being over-driven, particularly with
Pactor-2 (PTC-II controller). The audio distortion will dramatically reduce the effectiveness of the signal as
well as making you a very bad neighbor on the airwaves. With a ham radio, the best way to check is with
the ALC meter, you want it well into the "green", towards the bottom of the dial. Also be sure that any
speech compression is turned off for the same reason. See Setting Audio Levels »Page 67 for more
information.
You may also be able to adjust the transmit audio with the Mic gain control, and sometimes there in an
internal adjustment, or you can adjust it at the modem. (The PTC-II uses the PKSA and FSKA
commands, the KAM+ has a jumper and a potentiometer, and the PK-232 has a rear-panel trim pot).
An optional remote control cable can also be connected to allow AirMail to set the operating frequency
automatically, see Remote Control »Page 56.

PTC-II connections:
Audio Connections:
The PTC-II controller uses an 8-pin DIN connector for its audio connections. All of the interesting signals
are on pins 1 to 5 so a 5-pin DIN connector will work just fine. And in fact the German pin layout for an 8pin connector does not match the geometry of the US-style pin layout, so if you need a replacement for
the original SCS connector then a 5-pin connector is the safe choice.
The relevant PTC-II pin connections are as follows (5 or 8-pin DIN connector):
HF-Transceiver Audio connection (8-Pin DIN) »Page 77
-------------------------------------------Pin 4
(green)
Rx Audio from the receiver to the modem
Pin 1 (violet)
Tx Audio from the modem to the transmitter
Pin 3 (yellow)
Push-to-Talk (PTT), ground to transmit
Pin 2 (white)
Ground (audio signal return)
Pin 5 (blue)
12V power connection - see "Power" below
Shell Cable shield
(Pins 6-8 are not used for Pactor applications)
Note: The colors noted are those for recent SCS pigtail cables, check them before using. These signals,
or something equivalent, will be present on the transceiver's rear-panel accessory connector or frontpanel mike and speaker jacks, so simply match up equivalent signals (and keep a drawing of how you did
it!).
Power: The power connector used by the PTC-II controller is a 5.5mm x 2.1mm coaxial-pin connector
(same as the KAM and PK-232 -- the only thing they all agreed on). The center pin is positive, not
negative, and the penalty for wiring it backwards is severe. (Note that the PTC-II has an alternate 12V
input on its HF audio connector but no corresponding ground return, so we would suggest using the
separate power connection for RFI reasons).
Frequency control: The PTC-II also has an 8-pin mini-DIN control port for sending remote-control
information to compatible transeivers.
Transceiver Remote Control (8-pin mini-DIN) »Page 78
------------------------------------------Pin 1 (violet)
TxD (0-5v data output from PTC-II)
Pin 2 (white)
Audio out
Pin 3 (yellow)
Signal Ground
Pin 4 (green)
RxD (0-5v data input from transceiver)
Pin 5 (blue)
+12volts out (Caution- do not short!)
Pin 6 (black)
Bi-directional Icom CI-V connection
Pin 7 (brown)
CTS (handshake input from transceiver)
Pin 8 (red)
RTS (handshake output from PTC-II)
Shell (cable shield)
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PTC-IIe connections:
Audio Connections:
The PTC-IIe audio connection is identical to the PTC-II. An 8-pin DIN connector is used, although all of
the interesting signals are on pins 1 to 5 so a 5-pin DIN connector will work just fine. And in fact the
German pin layout for an 8-pin connector does not match the geometry of the American pin layout, so if
you need a replacement for the original connector then a 5-pin connector is the safe choice.
The relevant PTC-IIe pin connections are as follows (5 or 8-pin DIN connector):
HF-Transceiver Audio connection (8-Pin DIN) »Page 77
-----------------------------------------------------Pin 4 (green)
Rx Audio from the receiver to the modem
Pin 1 (violet)
Tx Audio from the modem to the transmitter
Pin 3 (yellow)
Push-to-Talk (PTT), ground to transmit
Pin 2 (white)
Ground (audio signal return)
Pin 5 (blue)
12V power connection - see "Power" below
Shell Cable shield
(Pins 6-8 are not used for Pactor applications)
Note: The colors noted are those for recent SCS pigtail cables, check them before using. These signals,
or something equivalent, will be present on the transceiver's rear-panel accessory connector or frontpanel mike and speaker jacks, so simply match up equivalent signals (and keep a drawing of how you did
it!).
Power: The power connector used by the PTC-IIe controller is a 5.5mm x 2.1mm coaxial-pin connector
(same as the KAM and PK-232 -- the only thing they all agreed on). The center pin is positive, not
negative, and the penalty for wiring it backwards is severe. (Note that the PTC-II has an alternate 12V
input on its HF audio connector but no corresponding ground return, so for long cables we would suggest
using the separate power connection for RFI reasons).
Frequency control: The PTC-IIe does not include the PTC-II's remote-control port, so control of
transceiver frequency is not possible through the modem. But another serial port is easily added for radio
control (see Adding Serial Ports »Page 76). Note that remote frequency control is strictly optional, and not
required for normal operation.

Connecting a KAM-Plus:
The KAM+ uses a US-style 8-pin DIN connector for its HF audio connections. Either order a special
cable, make a cable with the pigtail that comes with the KAM or obtain a USA-style 8-pin connector from
Radio Shack. A 5-pin connector will fit the female connector but will not include pin 6 which is required.
Cables for many popular HF transceivers are available from Kantronics, and if available for your
transceiver will save a lot of trouble (http://www.kantronics.com).
The KAM+ pin connections are as follows
HF Radio COnnection (8-pin DIN connector) »Page 78
Pin 6
Rx Audio from the modem to the controller
Pin 1
Tx Audio from the modem to the transmitter
Pin 3
Push-to-Talk (PTT), connect to ground to transmit
Pin 2
Ground (audio signal return)
Shell
Cable shield
Note that some DIN connectors are also prone to melting while being soldered, so use a clip-in heatsink
(or hemostat) on the other end of the pin while soldering, and work quickly.
Power connection: The power connector used by the KAM controller is a 5.5mm x 2.1mm coaxial-pin
connector, also available from Radio Shack (if the controller did not come with one). The center pin is
positive, not negative, and the penalty for wiring it backwards is severe.
Audio Output Level: The KAM's audio output level is adjusted is adjusted via an internal trimpot (R-28)
and jumper (K-9). Jumper K-9 is used to set the output range (20-400mV when disconnected, or 2004000mV when connected). Most transceivers require 100-400mV of audio drive. Refer to Setting Audio
Levels »Page 67 for details on checking and setting the audio levels.

Page 46 of 135

AirMail Help

Airmail.RTF

Connecting a KAM-98:
The KAM-98 uses a female 9-pin DB-9 connector for its HF audio connections. Cables for many popular
HF transceivers are available from Kantronics, and if available for your transceiver will save a lot of
trouble (http://www.kantronics.com).
The KAM pin connections are as follows (9-pin DB-9 connector). Note that this is not the same connector,
nor the same pin assignments as a LKAM-plus.
Pin 5
Rx Audio from the receiver to the modem
Pin 1
Tx Audio from the modem to the transmitter
Pin 3
Push-to-Talk (PTT), ground to transmit
Pin 6
Ground (audio signal return)
Shell
Cable shield
Power connection: The power connector used by the KAM-98 modem is a 5.5mm x 2.1mm coaxial-pin
connector, also available from Radio Shack (if the controller did not come with one). The center pin is
positive, not negative, and the penalty for wiring it backwards is severe.
Audio Output Level: The KAM-98's audio output level is adjusted is adjusted via a software command,
using either the CAL command or the XMITLVL command. Refer to the KAM-98 documentation for
details on using these commands, and Setting Audio Levels »Page 67 for the general procedure.
Airmail's Dumb Terminal window provides an easy way to send commands directly to the KAM-98
modem.

Connecting a PK-232:
The PK-232mbx model with the Pactor upgrade is required for operating Pactor, and upgrades are
available for most early models from Timewave, Inc. who bought the controller line from AEA. A DSP
audio filter option for the PK-232 is also available from Timewave (http://www.timewave.com). The PK900 modem is equivalent for Pactor and can also be used. In order to use any of Airmail's binary modes,
current firmware is required (ver 7.1 or later).
The PK-232 uses a small 5-pin in-line connector for audio connections, and comes with a short pigtail
cable coded as follows:
Green Rx Audio the receiver to the modem
White Tx Audio from the modem to the transmitter
Red
Push-to-Talk (PTT), connect to ground to transmit
Brown Ground (audio signal return)
(The extra wire is squelch, only used for VHF packet applications- do not connect it).
The PK-232 has a jumper option (JP1) which disconnects the backup battery. This causes a hard reset
on power-up, resetting all parameters to default values and starting the autobaud mode (indicated by the
single "Baudot" LED lighting on power-up). It is recommended that this mode be used and JP1 be
removed. JP-1 can be accessed through a small hole in the bottom cover.
Power connection: The power connector used by the PK232 modem is a 5.5mm x 2.1mm coaxial-pin
connector, also available from Radio Shack (if the controller did not come with one). The center pin is
positive, not negative, and the penalty for wiring it backwards is severe.
One precaution is that the PK-232 is particularly sensitive to RF interference, especially in maritime
applications where the ground system is not always what it should be. See RF Isolation »Page 70 for
more information, and pay particular attention to filtering the 12-volt power to the PK-232 and consider
running a ground wire to one of the case screws.
Audio Output Level: The PK-232's audio output level is easily adjusted via a rear-panel potentiometer.
Refer to Setting Audio Levels »Page 67 for the general procedure.

Connecting a MJF-1276 or 1278B:
The MFJ-1278B is a multi-mode TNC which includes Pactor mode and can be used by Airmail for HF
Pactor communication. The older 1278 does not include Pactor mode and cannot be ugraded. The MFJ1276 is a Packet/Pactor controller which can also be used with Airmail. Neither of these controllers
support binary communications in Pactor mode, and can only be used in ASCII mode. Other MFJ models
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The MFJ controllers share the same pin connections, using a 5-pin DIN connector. The pin connections
are as follows:
Pin 4
Rx Audio from the receiver to the modem
Pin 1
Tx Audio from the modem to the transmitter
Pin 3
Push-to-Talk (PTT), connect to ground to transmit
Pin 2
Ground (audio signal return)
Shell
Cable shield
(Note that these are the same as the connections for the PTC-II and PTC-IIe, providing a painless
upgrade path).
Power connection: The power connector is the same 5.5mm x 2.1mm coaxial-pin connector used by the
other controllers, center contact positive.
Audio Output Level: The audio output level is easily adjusted via a potentiometer accessible through the
side of the modem. Refer to Setting Audio Levels »Page 67 for the general procedure.
The MFJ controllers do not include a host mode for Pactor operation, so AirMail uses ordinary keyboard
commands for control and binary operation is not possible (the FBB binary protocols will not be available
in the Options window).
Other differences include character echo: Transmitted characters are echoed as sent but not separated
from incoming characters or status messages. AirMail separates transmit echo characters by counting
and shows them in the usual blue color-code, but color-code errors can occur in unusual situations. This
will have no effect on the transmitted messages.
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Transceiver Connections:
In order to operate Pactor, a digital-capable SSB transceiver must be used. Most modern amateur radio
and marine transceivers will do the job well. (To be "digital capable", a transceiver should be able to
operate continuously at full power, much tougher duty than SSB voice. It should also have fixed-level
audio input and output connections; microphone and speaker connections can be used if necessary but
that is not recommended). There is also an issue of frequency stability, and a ham radio without a
temperature-controller crystal oscillator (TCXO) will need careful attention to the actual transmitted
frequency (see Checking Frequency »Page 70).
There are two primary modes used for digital communications on HF frequencies: Pactor and Pactor-2.
Pactor is an FSK (frequency-shift-keyed) mode, a single tone shifted in frequency, while Pactor-2 uses
phase-shift modulation on two independent audio signals. Pactor can be transmitted using a radio's keyed
FSK/RTTY mode, but it is more common to let the modem generate the audio signal and let the radio
transmit that as a FSK signal using one of the SSB modes (LSB, USB or AFSK). This is the mode that is
discussed here. For Pactor-2 the complex audio signal must be generated in the modem and transmitted
using the radio audio circuits using SSB (or AFSK) mode. There are three signals (plus ground) to be
connected between the controller and the radio. In SSB mode they are: 1) received audio, from the radio
to the controller for decoding; 2) transmitted audio from the controller to the radio; and 3) a PTT ("push-totalk") connection to allow the controller to put the radio into the transit mode. See Icom »Page 48,
Kenwood »Page 50, Yaesu »Page 53, and SGC »Page 53 for more specific information on getting
connected:
AirMail also has the capability to set the operating frequency automatically when a station is selected
from the Terminal window. This mode is strictly optional, and for those utilizing only one Pactor mailbox
station and a small number of frequencies using the transceiver's memory is almost as easy. (The real
advantage of remote frequency setting is for automatic weather fax reception but that's a whole different
story). See the Frequency Setting »Page 56 section for more information.

Icom Ham Transceivers (except IC-706):
(See Icom IC-706 »Page 49 for information on the Icom IC-706m and Icom Marine Transceivers »Page
50 for information on the M710 and M700pro marine transceivers).
All recent Icom amateur transceivers are digital-capable and also provide a CI-V remote control interface
that is compatible with either the PTC-II or AirMail control software.
Audio connections:
Most Icom ham transceivers use an 8-pin DIN "ACC-2" connector with pin assignments as follows:
Audio input (Mod)----Pin 4
Audio (AF) out ------Pin 5
Ground-to-send (PTT)-Pin 3
Signal ground--------Pin 2
Shield---------------Shell
Viewed into socket
Remote-frequency control:
The CI-V interface is a TTL-level (0-5V) serial interface utilizing a 1/8" (3.2mm) mini-phone jack for
connection. It is an "open collector" bus connection, which means that multiple devices can share the
same connection. For example, the CI-V connection is used by some models of Icom antenna tuners, and
connection of a remote-control cable simply requires an audio-style 1/8" mini-phone plug "Y" cable.
Each device on a CI-V bus has a two-digit hex address. AirMail uses the controller default of "E0" as its
own address when sending commands. A "wildcard" hex address of "00" can also be used to address any
Icom ham transceiver. Unless multiple radios share the CI-V connection it is recommended that "00" be
used in the Airmail option settings. The only catch is that for "00" to work the radio must be a transceiver,
and certain radios (notably the IC-706) have an option that allows the "transceiver" flag to be turned off. If
"00" doesn't work then that's the first thing to check. For a PTC-II, either the "Via PTC-II" mode or the
"Direct using PTC-II control port" mode can be used without a level translator, and for any other decoder
the CI-V connector can be connected through a level translator (Icom CT-17 or equiv.) to a COM port and
the "Direct via COM port" mode used.
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A note on filters: If the transceiver has a narrow-bandwidth 500hz CW filter, check to see if it also works
in the SSB modes. If the filter does work, check the center frequency of the passband to see if it is a
reasonable value (between 1200 and 2300 Hz) and set the decoder tones to match (if possible - the PTCII and KAM have programmable tones, the PK-232 and MFJ do not). Do not attempt to use a filter which
has a bandwidth narrower than 500Hz
TCXO: A high stability oscillator (TCXO, or temperature-compensated crystal oscillator) is a
recommended option.

Icom IC-706 Ham Transceiver:
The IC-706 uses a 13-pin DIN connector, with the following connections:
Audio input (Mod)----Pin 11
Audio (AF) out-------Pin 12
Ground-to-send (PTT)-Pin 3
Signal ground--------Pin 2
+12V output----------Pin 8
Shield---------------Shell

(view into Socket)

(Note that this is the same connector as used by many Kenwood models but of course the pin
assignments are not the same).
Icom also has an optional adapter which allows the use of cables configured for the standard Icom 8-pin
DIN accessory connector.
The Icom IC-706 (and IC-706 mk-II) is a great little transceiver and in most respects is a perfect choice for
mobile Pactor users. The Icom-706 mk-II"G" model originally had switching-time problems in Pactor mode
and may require modification.
A high-stability oscillator (TCXO) is available (p/n CR-502), a good option for serious Pactor users. A
500Hz filter (FL100) is also available this is useful for Pactor-1 and 2 but not for Pactor-3. Using the
500Hz filter with Pactor is not straightforward, however. The problem is that the 706 is too smart. If the
FL-100 is installed as a CW/RTTY filter, then it cannot be selected in USB or LSB, the modes usually
used with Pactor (and required for Pactor-2).
One option is to define the FL-100 as a SSB filter, which will allow it to be selected in USB or LSB mode
(but not CW or RTTY). Get into the radio's Set Mode, dial up option 19 "OPTION FIL", and select "FL223", the code for the optional SSB filter which is selected in USB/LSB mode. The radio doesn't know that
the installed filter is a FL-100 500Hz CW filter instead of a FL-223 SSB filter, it will take your word for it
and will allow the filter to be selected in SSB mode. There are two drawbacks however: the 500Hz filter is
no longer available for CW or RTTY use (but that shouldn't matter to a real Pactor-head), and the audio
passband is very high (the center is about 2300Hz) in USB mode, and too low to use at all in LSB mode.
Using the if-shift control will adjust the passband, but this is a nuisance and a continuing source of
potential trouble if you switch voice and Pactor modes.
A second option, attractive if you have a remote-control connection to the radio for setting frequency, is to
let Airmail use a special split mode, transmitting in LSB mode as usual but receiving in RTTY mode with
the 500Hz filter. To set this up, first select the radio's RTTY mode, then go into the radio's Quick Set
Mode (hold down the "Disp" button) and set Q2 RTTY TONE to 1615, and Q3 RTTY SHIFT to 200. Get
into Set Mode, be sure that "transceive" mode (item 27) is set, and set baud rate (item 26) to 19200 baud
rather than "auto".
Now go to the Airmail Options and select LSB and set the Center Frequency box to 1715 (the 1615 Hz
was a mark tone). Set the radio mode to "Direct using PTC-II Control Port" (or "Direct via COM port" if
appropriate). Set Radio type to "Icom", Icom address to 00, baud rate to set to 19200 (if Set Mode item 26
CI-V BAUD is set to AUTO, otherwise match the 706 setting), and check "Set narrow filters". Finally, and
this is the trick, select "AFSK" mode. This selects the special split mode, and will program VFO A and B
as described above and select Split mode. The only drawback is that it takes slightly longer to select a
channel, therefore the suggestion to use 19200 for the radio's baud rate.
Also, do not attempt to use Icom's 250 or 350Hz CW filters, as they are too narrow for Pactor and will
increase the error rate dramatically. And of course Pactor-3 uses the normal SSB filter.
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Kenwood Transceivers:
Most Kenwood ham transceivers work fine with Pactor. The most popular models for mobile use are the
TS-440, TS-450 and TS-570 family, which all include rear-panel "ACC" connectors for modem
connection.
Audio connections: Audio connections are straightforward, with audio out, audio in, and PTT available
at a rear-panel DIN-style accessory connector. A 13-pin DIN connector is used for the TS-450S and
compatible radios, with pin assignments as follows:
Audio input (from modem)--Pin 11
Audio out (to modem)-----Pin 3
Ground-to-send (PTT) -----Pin 9
Signal ground ------------Pin 8
Cable shield -------------Shell
view into socket

Audio-input levels: The TS-440 requires a very high audio-input level (on the order of 1000mV) which
causes problems with some modems. The TS-450 went the other way, and is overly sensitive. Kenwood
has a fix for this, alternately the TS-450 has an internal adjustment for the ACC-jack input sensitivity: VR13, labeled "PKD", and located on the bottom, towards the rear panel. This should be adjusted so that a
500mV audio level from the modem provides full output with the front-panel mic-gain control at a normal
setting.
A note on filters: Kenwood offers 500Hz IF filters for most models. If the transceiver is fitted with 500hz
filters, check to see if they also work in the SSB modes. If do, check the center frequency of the passband
(1500hz for the TS-450S) and set the decoder tones to match. For the TS-450, the 500Hz filters do work
in USB or LSB mode, and the passband center is 1500Hz with no IF shift, which is a convenient value to
use. The TS-570 includes DSP audio filtering, which is of little value (the modems all include audio
filtering), but also has provison for an optional 500Hz IF filter (YK-88C-1). This filter is normally only used
in FSK and CW modes, and requires using the radio's "Split" mode to make effective use of it (see PTCII/Kenwood TS-570 »Page 78).
Do not attempt to use a filter which has a bandwidth narrower than 500Hz.
TCXO: A high stability oscillator (TCXO, or temperature-compensated crystal oscillator) is a
recommended option.

Icom Marine Transceivers:
The Icom M710, M700pro and M802 transceivers are fully digital capable and are excellent choices for
use with Pactor. They also offer a remote-control input that can easily be used for remote frequency
setting with AirMail. The M710 and M700pro models both share the same chassis and RF sections and
are quite robust, and are capable of transmitting full power indefinitely. The difference between the M710
and M700pro is with the front-panel control layout- the M700pro is marginally easier for general ham use,
although no marine radio is particularly convenient for hopping around on the ham bands. (The FCC rules
for marine type-acceptance prohibit most of the controls which hams find useful). The new M802 has a
remote control head with lots of features, and is quite easy to use for both marine and ham use.
(Of the earlier M700 and M800 radios, only certain models are capable of continuous full-power digital
transmission and generally must be used at reduced power levels, consult the manual for details. This is
less of a limitation for the PTC-II controller, because the average power for Pactor-2 is only about half the
peak value due to their complex waveforms. The older M700 also did not incorporate a connector for
external audio connecitons, and hooking up a modem requires modifying the radio).
Audio connections: Audio connections for Icom's marine transceivers use the same 8-Pin DIN
accessory connector as most of the Icom ham models, and the same cables will work. The pin
assignments are as follows:
Audio (Mod) input----Pin 4
Audio (AF) out ------Pin 5
Ground-to-send (PTT)-Pin 3
Signal ground--------Pin 2
Cable shield---------Shell
Viewed into socket
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Remote control for mode and frequency is available using either a TTL-level (0-5 volt) connection, or a
RS232-compatible "REMOTE" connection, depending on model.
The Icom M710 (and M710RT) includes both a TTL-level (0-5 volt) "Clone" jack which can be used for
remote control, as well as a RS232-compatible "REMOTE" NMEA connector. The TTL-level jack is a 1/8"
mini-phone jack which can be directly connected to the "remote" connector on a PTC-II or PTC-IIpro
modem, using a specially-wired cable (see PTC-II/M710 »Page 61). The 9-pin "REMOTE" connector
looks like a RS232 connector but is not wired the same, and requires a specially-wired cable to connect
to a computer serial port (see Com Port Control »Page 52) or the PTC-IIpro's "remote" connector (using
RS232 mode, see PTC-IIpro/M710 »Page 108).
The Icom M700pro has only the 1/8" Clone jack described above. This can be connected directly to a
PTC-II or IIpro as above, or a suitable level-shifter (e.g. Icom's OPC-478 cable- see Note »Page 91) can
be used for connection to a computer serial-port.
The M802 has a standard RS232 "REMOTE" 9-pin connector, which can be directly connected to a PTCIIpro or a computer serial port. Connection to a PTC-II will require the SCS RS232 level-shifter.
For information on adding serial ports to a computer, see Adding Serial Ports »Page 76.
Radio programming
Some models of the M710 and M700pro are only set up to transmit on marine frequency bands. These
bands exclude all of the ham radio frequencies and most of the Sailmail marine frequencies, which are
assigned for marine data use but are outside the traditional marine voice bands. The differences between
the models are strictly a matter of the programming of the radio (except "GMDSS" models- see below).
Programming (or "cloning") the radio is a simple matter given the special software and cable »Page 91,
and can be done by any Icom dealer. Most dealers will reprogram a radio that they have sold without
charge, others charge for this. When purchasing a M710 or M700pro radio, be sure to specify "all-band
transmit".
The M802 can be "opened up" for all-band transmit with a special key sequence: First urn off the radio,
then press and hold the “2”, the “MODE” and the “TX” button, then (while holding these three buttons),
turn on the radio.
GMDSS models
Icom also sells "GMDSS" models of the M710 in Europe and elsewhere (not in the US). These models do
not include the standard Icom 8-pin DIN connector noted above, but external audio connections are
available via a 9-pin "DB"-style connector. See the respective manuals for connections. There is also
connection information at the Farallon website, www.farallon.us.
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COM-port remote control for Icom Marine Transceivers:
The Icom M710 is equipped with a 9-pin connector for NMEA control. The connections are not the same
as RS-232 but can be connected to a computer serial port with a suitable cable. The M700pro may not
have the NMEA connector (depending on version), but does have a 1/8" mini-phone jack which can be
connected to a serial port with an appropriate level converter (see "Using the Clone jack" below).
M710, M700pro:
The 9-pin NMEA "Remote" connector (labeled "DSC" on some models) can be used for remote control of
the transceiver mode and frequency with any controller type, by using an additional computer serial COM
port. NMEA signal levels are a differential version of RS-232 voltage levels, approximately +8 and -8
volts. With appropriate wiring the "+" NMEA connections can be connected directly to a RS-232 serial
port. (Note that the "-" input must be grounded as a reference, but do not ground the "-" output).
A cable to a standard PC serial port can be made up as follows:
ICOM 710
Computer serial port
(9-pin male)
(9-pin female)
-----------------------NMI+ 5-----------3 TxD
NMO+ 7-----------2 RxD
NMI- 6-----------5 GND
GND 9-----------5 GND
Shell--(shield)--Shell
Radio Settings:
In order to use the NMEA interface, it must first be selected using the front-panel "Set Mode" functions
(turn power on while holding down the "Func" and "1" buttons- or "Ent" and "1" for the M700pro). Select
the "REMT-IF" (remote interface) setting and change it "d-Sub" (or "RS-232" on some models). Also
check that the "REMT-ID" setting matches Airmail's "Icom Addr" setting).
AirMail Options Settings:
Modem (TNC) connection: Select the appropriate modem
Audio Tones:
Center Frequency: 1500
Check "USB"
TxD: 20 ms
Check "FSK dial=center" (for marine radios)
Amplitudes (PTC-II-family only): as appropriate, start with 130/170 (See Setting Audio Levels »Page
118)
Radio connection:
Check "Direct via COM port", enter the appropriate COM port for the radio connection
Radio type: Icom-NMEA:
Baud: 4800
Icom Addr (hex): 01 for the M710, 02 for the M700pro, 03 for the M710/RT (must match radio setting)
Dial offset: 00
Note: Entering the radio modes with the "Modes" button is no longer required.
Using the "Clone" jack:
All Icom M710 and M700pro radios have a 1/8" TTL-level jack labeled "Clone". This can be used directly
with the PTC-II controller but requires a level converter for use with a COM port (such as the Icom OPC478 cable available from Icom dealers). This connector is normally used by dealers for radio setup but
can also be used for NMEA remote control. Setting up the radio and Airmail is the same as for the M710
above (including selection of "d-Sub" or "RS232" for the radio's REMT-IF setting).
Note that some Icom documentation refers to this as a CI-V jack, but it only works with NMEA data
formats. It is also important that the radio's REMT-IF menu be set to "d-Sub" (or "RS-232"), the radio may
work with "pin" (or "clone") selected but the input is unbuffered in that mode, and the timing is marginal.
Also note that Icom does not officially support the use of this jack for remote control, and if you go to Icom
with questions they will disavow all knowledge. But in our experiece it has been completely reliable.
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Yaesu Transceivers:
All recent Yaesu ham transceivers will work fine with Pactor. Yaesu does an excellent job of engineering
the radio but with respect to digital modes there are a number of issues which must be considered.
Unfortunately there is little standardization by Yaesu from one model to the next, and both the modem
audio-interface and remote-control connections vary by model. Given the proliferation of models over the
years it is not possible to provide details for each radio. This page will attempt to outline the issues and
requirements as a basis for consulting the manual for specific information.
Audio connections: In order to use any digital mode three connections are required: Audio from modem
to radio, audio from radio to modem, and transmit control (PTT). These modem connections are RCA
jacks on some Yaesu models and a standard or mini-DIN connector on other models. In addition a 1/8"
(3.2mm) mini-jack "data in/out" connector is available on some recent models, this can be used as an
alternate connection for the audio in/out signals in conjunction with a separate connection to a rear-panel
PTT jack. An additional complication is that certain rear-panel audio connectors may be enabled (or have
different effects) depending on the operating modes. For example, the popular FT-817 enables the rearpanel "ACC" connector only in "DIG" mode. .
Remote Control: Remember that remote-control is strictly optional. All recent Yaesu transceivers include
a "CAT" computer interface, which on most models can be used to remotely-control the radio frequency
from Airmail. The Yaesu "CAT" interface is not well standardized, and some radios use a TTL-level
connection (0 - 5 volt) on a 5 or 6-pin DIN or mini-DIN connector, while others use RS-232 levels with a
standard 9-pin connector.
At least three different command-formats have used for Yaesu radios. The "traditional" Yaesu commandset works with most older Yaesu models and also the FT-100D, 890, 920, 1000 and others. This
command-set is characterized by a mode-command of 0C (hex), a frequency-command of 0A, and a "43-2-1-op" byte order. This command-set is supported by Airmail's "Yaesu" radio-type code. A different
format is used for the "8x7" series, e.g. FT-817, 847, 857, 897. This "8x7" command-set is characterized
by a mode-command of 07, frequency-command of 01, and a 1-2-3-4-op byte-order. This command set is
supported by Airmail's "Yaesu-8x7" radio-type code. Note that the "8x7" radios in particular incorporate a
"DIG" mode, which for most models must be used in order for the rear-panel "ACC" jack to be useable.
The command-codes used for each mode is selectable for the Yaesu 8x7 radios via Airmail's "modes"
button, but this also requires that the radio's "DIG" mode be properly set up. See the Yaesu FT-817 help
page »Page 113 for details, these also apply to most other "8x7" radios. Also note that a "lock radio"
option is available, this is optional for all 8x7 models except the 847 where it MUST be checked to put the
radio in "CAT" mode. And yet another format is used for the Yaesu System-600 commercial radio, same
commands as the "traditional" Yaesu format but a different byte-order. This is supported by Airmail's
"Yaesu-600" radio-type code.
The TTL-level interfaces can be connected directly to the remote-control port of a PTC-II or IIpro, or to a
computer serial-port via a level-shifter. The RS-232 connections on newer models can be connected to
directly to a computer serial port or to the remote-control port of a PTC-IIpro modem, or to the control port
of a PTC-II using the SCS level-shifter adaptor. For some radios a straight-through cable is required, for
others a "null-modem" cable is required that crosses the Tx and Rx data wires. Note that there is a
reference in the PTC-II manual about a transistor being required on the remote-control RxD signal, this
can be ignored as Airmail does not currently utilize data returned from Yaesu transceivers.
Filters: In general, the narrow-band filters in Yaesu radios will only work in CW mode, not the USB/LSB
modes. The exceptions are some recent models which include a special "DIG" or data mode. CW mode is
not suitable for Pactor reception because the audio tones are too low, and most Yaesu models do not
have an FSK mode. So it is generally not possible to make use of a narrow-band IF filter for Pactor. This
is not a serious loss, as most modems are quite good at filtering adjacent signals and with pactor-3 a
narrow filter is not useable in any event. .

SGC SG-2000 Transceiver:
The SG-2000 transceiver can work well for Pactor, but has some special considerations (see below).
Connections:
Modem connections (transmit/receive audio and PTT) are made to a terminal strip on the rear of the
transceiver box as follows:
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SG-2000 terminal strip
----------------J301-1 = audio-in (see note)
J301-2 = ground
J301-3 = audio-out
J301-4 = PTT in
J502-2 = +12 volts (see note)
Notes:
1. The SG-2000 is sensitive to RF interference on the audio-in connection, causing distortion of the
transmitted signal. SGC suggests the addition of a resistor from the Tx Audio connection to ground
(between J301 pins 1 and 2), see below under "Audio levels" and "RF feedback".
2. Power for the modem can be optionally connected to the +12 volt terminal for the tuner power, J-502
pin 2 but this may cause additional problems with RF feedback- see below.
Remote control (optional):
SGC transceivers incorporate an RS-232 connector for remote control. Airmail supports this either using
the PTC-II (or IIpro's) remote-contrl port or via an additional serial port.
With a PTC-II, an external TTL-to-RS-232 voltage converter is required in order to connect the remotecontrol port to the radio, this is available from SCS (http://www.scs-ptc.com) or SCS dealers. In Airmail's
Options window, select the "Direct using PTC-II control port". (Alternately, the "Via PTC-II" setting can be
used, this sets frequency only, not USB/LSB mode).
The PTC-IIpro provides RS-232 output levels in addition to TTL-levels, and can be used directly with the
suitable cable (see PTC-IIpro connections »Page 93, the SG-2000 uses the standard serial-port pin
connections). In Airmail's Options window, select the "Direct using PTC-II control port" setting and make
sure that the "RS-232" box is checked.
Alternately, Airmail can provide remote control using an additional COM port and a standard 9-pin serial
cable (see Adding Seial Ports »Page 76). SG-2000's RS232 connector is a 9-pin connector with the same
pin connections as a standard computer serial port. A straight-through 9-pin serial extention cable can be
used. Note, however, that the SG-2000 has an internal plug (J3) which can be reversed (reversing Rx
and Tx data). The correct orientation is with the purple wire (pin-1) closest to the side of the chassis.
To utilize Airmail's frequency control wth a PTC-II or IIpro, select "Via PTC-II" or "Direct using PTC-II
control port", radio type SGC-2000, baud rate 9600. If using the "Via PTC-II" setting, then USB mode
should be selected as the PTC-II's frequency control for the SGC-2000 automatically selects USB mode.
For a PTC-IIpro, be sure to check the "RS-232" box. For other modems, check "Direct via COM port" and
select the appropriate port (different from the modem's COM port). Audio tones are typically set to 1500hz
for marine radios but this is not critical as long as the appropriate dial frequency is used
The SGC transceiver offers a FSK mode for telex operation, with a narrow-band audio filter. Unfortunately
this sort of filter in the audio stage is not helpful, as the modem already incorporates audio filtering, and
an audio filter will not prevent strong adjacent signals from reducing the sensitivity of the receiver.
Therefore the use of "Telex" or FSK mode is not recommeded, use USB (or LSB) instead
Special Considerations:
The SG-2000 can work well with Pactor, but there are a number of special considerations relating to RF
interference and maximum output power
RF Feedback:
RF interference or feedback is a significant issue with the SG-2000. The 12V power connection is not
filtered, which allows RF energy to be conducted into the boat's 12V wiring and from there throughout
the vessel. In addition, the radio's rear-panel audio-input connection is not well filtered, so
interference results from the radio's own tranmitted signal getting back into the input. This creates a
feedback loop (RF feedback), which creates the same type of "squeal" that a mis-adjusted PA system
does. A good grounding system is essential, as is careful attention to filtering (see RF interference
»Page 103). Also, add a resistor at the Tx-audio input, below.
Connecting the radio directly to the batteries (through a suitable 30A fuse or circuit breaker) will be a
significant help, as the low impedence of the batteries will help absorb the stray RF. Alternately, add
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an EMI filter to the 12V connection a the back of the radio, as close as possible to the radio (i.e.
within inches). A suitable filter is Corcom's "Series R" 20 amp line filter, Digi-Key part# CCM1335-ND,
www.digikey.com).
Power output:
The SG-2000 is not rated for continuous full-power output (see the "Continuous Duty Ratings" section
of the manual). The peak (instantaneous) power rating is 150 watts, but continuous (average) power
is limited to 80 watts or less (80-100 watts with the fan kit). This is not a serious limitation when the
SG-2000 is used with a PTC-II-family modem, because the complex waveform of Pactor-2 (PSK)
signals uses about half the average power level compared to FSK. But calling a station is done in
FSK mode, and a series of long calls in sequence can cause temperature problems in warmer climes.
A fan kit is available from SGC, this increases the power that the radio can handle without
overheating (especially in warm climates) but is an expensive option ($400 installed). With the fan kit
fitted, SGC recommends using 80-100 watts in FSK mode. Monitor the "overheat" inidicator carefully
and reduce power as necessary (see below).
Remember that the average power level in Pactor-2 (PSK) mode is about half of the peak power. The
SG-2000's maximum peak power is about 150 watts, which would be an average power in Pactor-2
(PSK) mode of 70-80 watts. This is within what SGC states is the continuous average power
capability of the SG-2000. In FSK mode, used by Pactor-1 and also when calling and establishing a
link in Pactor-2 mode, the average power is the same as the peak power. The PTC-II modems have a
separate audio-level adjustment for FSK power, and it is important that the FSK setting be reduced to
produce an output of 80 watts or less in FSK mode (80-100 watts with a fan kit).
Audio Levels:
Current models of the SG-2000 have a very sensitive audio input connection, requiring low drive
levels and also making the input very sensitive to RF feedback (see RF feedback, above). There is
also no RF filtering on the audio-in connection. It is helpful to add a resistor to the SG-2000's audio
input, to reduce the input impedence and hence the sensitivity to RF feedback. (This also requires a
higher audio drive level). A suitable value is 220 ohms between terminals 1 and 2 of J301. Also
consider adding a 0.001 uF capacitor in parallel, to further reduce the impedence at RF frequencies
and filter some of the RF.
Very early models of the SG-2000 required very high audio input levels, typically a couple of volts
(compared to the more typical 500 mV). PTC-II modems have a maximum output of 1000 mV (1 volt),
and it is sometimes necessary to mnodify the modem by removing R20 (330 ohms to ground at the
PTC-II's audio output). The maximum audio outpout for the PTC-IIe and IIpro is 2000 and 3000 mV
respecitvely so this is not a problem. See the Audio Levels »Page 67 section for information on
setting the correct audio transmit level.
The SG-2000's power output should vary in a smooth fashion as the audio drive levels are adjusted,
up to a maximum level (150 watts peak). If the power output does not decrease as the audio level is
reduced, then this is an indication of RF feedback- i.e. the radio is in "squeal" mode, transmitting its
own output signal and not the audio from the modem.
Other RF Considerations:
Make sure that the audio cables are shielded, with ferrites at both ends. Large ferrites, with 3 or 4
turns through them are much more effective than small ferrites (impedence goes up with the square
of the turns). Make sure that the ferrite-halves fit together tightly, without any gap. We usually take the
ferrite halves out of the plastic case and tape or tie-wrap them together tightly.
Make sure that the tuner has a good, low-impedence ground. A 3" copper strap to an external lead
keel is effective. Alternately, a counterpoise can be provided, consisting of copper foil, metal tanks,
engine, through-hulls, etc. The usual recommendation is 100 sq. ft., connected to the tuner with 3"
copper foil. If the tuner ground is adequate then ground to the radio chassis is unimportant and is
provided for safety only.
Add a ferrite line isolator (e.g. Radioworks T-4) between the radio and the tuner, close to the tuner if
possible. This prevents stray ground currents from using the coax shield as an unwanted ground path
via the radio and connected equipment. Noe that without an adequate tuner ground, adding a line
isolator may make the problem worse. Also add ferrites to the tuner control wires.
Also, carefully check the SG-2000's frequency calibration accuracy. When operating in marinas or
busy anchorages, be aware that the SG-2000's receiver is easily overloaded by strong signals.
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Frequency Setting
In order to use AirMail's optional remote frequency setting, the transceiver must have a remote-control
interface that is either compatible with TTL (0-5 volt) levels or RS-232, and use a supported data format.
Airmail supports a number of radios, either using the PTC-II/IIpro's remote-control port, or connected
directly via an additional COM port (see Adding Serial Ports »Page 76 for more info).
The PTC-II modem provides a TTL-level output which can be connected directly to many radio models.
For radios which require a RS-232 connection, an optional external TTL-to-RS232 level-shifter is
available from SCS or dealers. The PTC-IIpro includes both TTL and RS232-level connections, and a
level converter is not required. A number of radios are supported by Airmail either connecting through the
PTC-II control port or direct via a serial port. Virtually all Icom ham radios use the Icom-CIV format, with a
TTL-level connection. Recent Icom marine radios (M710, M700pro) use a NMEA protocol which can be
connected either to a RS232 connection using the "REMOTE" connection or to a TTL-level connection
using the "clone" jack. The newer M802 marine radio uses a standard RS-232 connection. Most Kenwood
radios use the standard Kenwood format, with older radios (e.g. TS0450S) using a TTL-level connection
and newer radios (TS-570D) using a RS-232 connection (and standard 9-pin RS232 connector). Other
supported radios include most of the Yaesu models, SGC, etc.
Any of these radio formats can be used either through the PTC-II/IIpro control port (Airmail's "Direct using
PTC-II control port" selection) or with a direct connection to an additional computer serial port (Airmail's
"Direct via COM port" selection). Except for a PTC-IIpro modem, a level-shifter may be required. For most
modems (other than the PTC-II and IIpro) the COM-port connection is used.
For more information, see the Help Index for "Connections", and the specific modem and radio types.

Connecting a PTC-II* modem to an Icom Ham Transceiver (except IC-706):
This page covers connecting the SCS PTC-II-family modems to most Icom Ham transceivers (the IC-706
is covered separately).
Audio connections:
PTC-II Audio
Icom "ACC" connector
(8-pin SCS DIN) »Page 77
(8-pin Icom DIN) »Page 78
------------------------------(Tx audio) Pin 1----(vio)-----Pin 4 (Mod)
(Rx audio Pin 4----(grn)-----Pin 5 (AF out)
(PTT)
Pin 3----(yel)-----Pin 3 (PTT in)
(Gnd)
Pin 2----(wht)-----Pin 2 (ground)
(+12V)
Pin 5----(blu)-----Pin 7 (12V out- see note)
Shell---(shield)---Shell
Notes:
1. The colors shown above are for the pigtail cable supplied with the PTC-II and IIe. Check the colors with
an ohmmeter, errors have occurred.
2. The German-style DIN connector has a different physical pin geometry, and is not interchaneable with
the US-style DIN connector used by Icom. Label the cable ends to avoid confusion over which end goes
where.
3. The PTC-II has provision for an alternate 12V input on its HF audio connector. This provides a
convenient way to connect power to the modem, but if the cable is particularly long then could be a
source of RF interference. For this reason we suggest using a separate power connection if the audio
cable is over 6 ft (2 meters).
Remote frequency control:
Icom ham transceivers can be remotely controlled by Airmail using the PTC-II and IIpro's "Control"
connector, or via an additional serial port using an appropriate level-shifter (e.g. Icom OPC-478 or OPC552).
Connections for the PTC-II are as follows:
PTC-II remote
(8-pin mini-DIN) »Page 78

Icom CI-V "Remote" jack
(1/8" mini-phone plug)
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----------------------Tip contact
Ring (ground) contact
Ring (ground) contact

Connections for the PTC-IIpro are as follows:
PTC-IIpro "Control"
(13-pin DIN)
----------Pin 6 (black) ------------Pin 13 (orange) ----------Shell (shield) ------------

ICOM CI-V "Remote" jack
(1/8" mini-phone plug)
-----------------------Tip contact
Ring (ground) contact
Ring (ground) contact (with orange wire)

With a PTC-IIe or IIex, the radio can be connected to an additional COM port are possible using a levelshifter such as an Icom OPC-478 or OPC-552. Also see Adding serial ports »Page 76.
Radio Settings:
No special settings are usually needed but there are some settings which, if changed from the default, will
interfere with remote-control operation. The baud rate should match the Airmail setting, the default is
1200 or "Auto", and setting it to the highest specific baud rate is recommended (and set Airmail‟s radio
baud rate to match, below). Also, if there is a "Transceive" option then it must remain set to "On" in order
for the wildcard "00" address to work.
AirMail Options Settings:
Modem (TNC) connection:
Modem type: PTC-II* (appropriate model)
Comm port: COM1 or as appropriate
Baud rate: 38400 or 57600
Show link messages: no check
Audio Tones:
Center Frequency: 1500 (or to match filter passband, if equipped)
Check "USB"
Do not check "FSK dial=center" (used for marine radios only)
Amplitudes: as appropriate, start with 300 & 400
Radio connection:
Check "Direct using PTC-II control port"
(NO check for RS232, for PTC-IIpro)
Radio type: "Icom-CIV"
Baud: 1200 (or to match radio setting, see above, faster is better)
VFO: A
Icom Addr (hex): 00
Set narrow filters: check only if equipped with a 500 Hz filter AND not using Pactor-3
Dial offset: 00 (or to compensate small frequency errors <100 Hz)

Connecting a PTC-II*to an Icom IC-706 Ham Transceiver:
This page covers the connection of the SCS PTC-II-family modems to the Icom IC-706 transceiver
(including the 706-mkII and mk-II"G").
Audio connections:
PTC-II Audio
Icom M706 ACC
(8-pin DIN) »Page 77
(13-pin DIN) »Page 77
-----------------------------(Tx audio) Pin 1----(vio)-----Pin 11 (Mod)
(Rx audio) Pin 4----(grn)-----Pin 12 (AF out)
(PTT)
Pin 3----(yel)-----Pin 3 (PTT in)
(Gnd)
Pin 2----(wht)-----Pin 2 (ground)
(+12V)
Pin 5----(blu)-----Pin 8 (12V out- see note)
Shell---(shield)---Shell
Note that the PTC-II has provision for an alternate 12V input on its HF audio connector. This provides a
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convenient way to connect power to the modem, but if the cable is particularly long then could be a
source of RF interference. For this reason we suggest using a separate power connection if the audio
cable is over 6 ft (2 meters).
Also note that Icom has a conversion cable available (OPC-599) which will allow the use of cables made
for the 8-pin DIN connector found on other Icom ham and marine radios. If you use the OPC-599 adapter
then connect the cable per the Icom ham transceivers »Page 48 but use the other settings from this page.
Remote frequency control:
The IC-706 can be remotely controlled by Airmail using the PTC-II and IIpro's "Control" connector, or via
an additional serial port using an appropriate level-shifter (e.g. Icom OPC-478 or OPC-552). The IC-706
is equipped with a 1/8" mini-phone jack which will accept Icom's CI-V protocol. This can be directly
connected to the PTC-II or IIpro as follows:
Remote-control connection to a PTC-II modem:
PTC-II remote
Icom CI-V "Remote"
(8-pin mini-DIN) »Page 78
(1/8" mini-phone plug)
--------------------------------(Icom)
Pin 6--------------Tip
(ground) Pin 3---(shield)---Ring (shell)
With a PTC-IIe or IIex, the radio can be connected to an additional COM port are possible using a levelshifter such as an Icom OPC-478 or OPC-552. Also see Adding serial ports »Page 76.
AirMail Options Settings:
Modem (TNC) connection:
Modem type: PTC-II* (select appropriate model)
Comm port: COM1 or as appropriate
Baud rate: 38400 or 57600
Show link messages: no check
Audio Tones:
Center Frequency: 1500
Check "USB"
Amplitudes: as appropriate, start with 250 & 450
Radio connection:
Check "Direct using PTC-II control port" (or "Direct via COM port")
Radio type: Icom:
Baud: 19200 (or to match the radio setting, faster is better)
VFO: A
Icom Addr (hex): 00
Set narrow filters: no check (see below for more info)
Dial offset: 00 (or as needed, less than 100Hz)
Use of narrow filters (Pactor-2 only):
If a 500hz filter is fitted, it normally only operates in RTTY or CW mode. The radio can be "fooled" into
using it in LSB mode by setting the filter code to the FL-223, but the IF shift control will have to be offset
to adust the passband into a reasonable range. Every time you forget, the link will not connect- not a
good solution. A better choice is to the radio's "split" mode, receiving in RTTY mode (with the filter) and
transmitting in LSB mode (no filter needed). Airmail has a special "AFSK" mode, which makes this easy
(and thanks to Stan Honey WA6IVA who figured this out).
To set up the split ("AFSK") mode, first select the radio's RTTY mode, then go into the radio's Quick Set
Mode (hold down the "Disp" button) and set Q2 RTTY TONE to 2125, and Q3 RTTY SHIFT to 200. Then
get into Set Mode (power-on while holding down the Lock button), be sure that "transceive" mode (item
27) is set, and set baud rate (item 26) to 19200 baud rather than "auto".
AirMail Options Settings:
As above, except:
Audio Tones:
Center Frequency: 2225 (center of RTTY passband)
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Check "AFSK" (this enables the special "Split" mode)
Do NOT check "FSK dial=center" (for marine radios only)
Radio connection:
Set narrow filters: checked
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Connecting a PTC-II to a Kenwood TS-450S Ham Transceiver (and other compatible
models):
This page covers connecting the SCS PTC-II to a Kenwood TS-450 and compatible ham transceivers.
Audio connections:
PTC-II Audio
Kenwood "ACC-2"
(8-pin DIN) »Page 77
(13-pin DIN) »Page 77
-------------------------------(Tx audio) Pin 1----(vio)-----Pin 11 (PKD)
(Rx audio) Pin 4----(grn)-----Pin 3 (AF out)
(PTT)
Pin 3----(yel)-----Pin 9 (PTT in)
(Gnd)
Pin 2----(wht)-----Pin 8 (ground)
Shell---(shield)---Shell or pin 12
Notes:
1. The colors shown above are for the pigtail cable supplied with the PTC-II and IIe. Check the colors with
an ohmmeter, errors have occurred.
2. The German-style DIN connector has a different physical pin geometry, and is not interchaneable with
the US-style DIN connector
3. The PTC-II has provision for an alternate 12V input on its HF audio connector. This provides a
convenient way to connect power to the modem, but if the cable is particularly long then could be a
source of RF interference. For this reason we suggest using a separate power connection if the audio
cable is over 6 ft (2 meters).
Remote frequency connection:
All recent Kenwood transceivers are digital-capable. Older radios (e.g. TS-450S) have a 6-pin DIN
connector for remote control with TTL-level voltage levels which can be directly connected to the PTC-II's
HF-Control connector as follows:
PTC-II remote
Kenwood "ACC-1"
(8-pin mini-DIN) »Page 78
(6-pin DIN) »Page 78
--------------------------------(TXD out) Pin 1----(vio)-----Pin 3 (RxD in)
(RXD in) Pin 4----(grn)-----Pin 2 (TxD out)
(RTS out) Pin 8----(red)-----Pin 4 (CTS in)
(CTS in) Pin 7----(brn)-----Pin 5 (RTS out)
(Ground) Pin 3----(yel)-----Pin 1 (ground)
Shell---(shield)---Shell
Notes:
1. The colors shown above are for the pigtail cable supplied with the PTC-II and IIe. Check the colors with
an ohmmeter, errors have occurred.
2. Be very careful to avoid shorts to any unused pins on the mini-DIN connector, as there is +12 volts on
pin 5. If you short this pin to one of the data pins you will "toast" the PTC-II's driver chips, trust us on this.
And, as always, be sure that the power is off at both ends before plugging or unplugging cables, as radios
and modems are expensive.
Newer Kenwood radios (e.g. TS-570) provide a RS-232 connector, which can be connected directly to a
second computer serial port. The PTC-II's remote-control port can also be connected to the radio's RS232 connector by using a special voltage-conversion cable available from SCS or dealers. See PTC-II* to
Kenwood TS-570 »Page 78 for more info.
AirMail Options Settings:
Modem (TNC) connection:
Modem type: PTC-II
Comm port: COM1 or as appropriate
Baud rate: 38400 or 57600
Show link messages: no check
Ignore CTS: no check
Restart controller: checked
Audio Tones:
Center Frequency: 1500 Hz
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Check "USB"
Amplitudes: as appropriate, start with 100/200 for a TS-450S.
Radio connection:
Check "Direct using PTC-II control port" (or "Direct via COM port" as appropriate)
Radio type: Kenwood:
Baud: 4800
VFO: A
Set narrow filters: check only if equipped with a 500Hz filter
Dial offset: 00 (or to compensate small frequency errors <100 Hz)
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Connecting a PTC-II to an Icom M710/M700pro Marine Transceiver:
This page covers connecting the SCS PTC-II in combination with an Icom M710 or M700pro marine
transceiver.
Audio connections:
PTC-II Audio
Icom M710 ACC(1)
(8-pin SCS DIN) »Page 77
(8-pin Icom DIN) »Page 78
-------------------------------(Tx audio) Pin 1----(vio)-----Pin 4 (Mod)
(Rx audio) Pin 4----(grn)-----Pin 5 (AF out)
(PTT)
Pin 3----(yel)-----Pin 3 (PTT in)
(Gnd)
Pin 2----(wht)-----Pin 2 (ground)
(+12V)
Pin 5----(blu)-----Pin 7 (12V out- see note)
Shell---(shield)---Shell
Notes:
1. The colors shown above are for the pigtail cable supplied with the PTC-II and IIe. Check the colors with
an ohmmeter, errors have occurred.
2. The German-style DIN connector has a different physical pin geometry, and is not interchaneable with
the US-style DIN connector used by Icom. Label the cable ends to avoid confusion over which end goes
where.
3. The PTC-II has provision for an alternate 12V input on its HF audio connector. This provides a
convenient way to connect power to the modem, but if the cable is particularly long then could be a
source of RF interference. For this reason we suggest using a separate power connection if the audio
cable is over 6 ft (2 meters).
Remote frequency control:
Both the M710 and M700pro are equipped with a 1/8" mini-phone jack which accepts NMEA data with
TTL (0-5 volt) voltage levels, and which can be directly connected to the PTC-II. This is normally used by
dealers for radio setup but can also be used for remote control. Note that the same type of connector is
used for the CI-V interface on an Icom ham transceiver, but this is a NMEA interface, not CI-V.
The pin assignments for the PTC-II's Control connector (8-pin mini-DIN) to the Icom 1/8" mini-phone (pin)
jack are the same as for Icom ham radios, as follows:
PTC-II remote
Icom M710 "Clone"
(8-pin mini-DIN) »Page 78
(1/8" mini-phone plug)
--------------------------------(Icom)
Pin 6--------------Tip
(ground) Pin 3---(shield)---Ring (shell)
Radio Settings:
In order to use the NMEA interface, it must first be selected using the front-panel "Set Mode" functions
(turn power on while holding down the "Function" and "1" buttons). Select the "REMT-IF" (remote
interface) setting and change it "d-Sub" (or "RS-232" on some models). Also check that "REMT-ID" is set
to "01". Note that the "d-Sub" or "RS232" setting is used for either the 9-pin or pin (1/8" miniphone) jack.
AirMail Options Settings:
Modem (TNC) connection:
Modem type: PTC-II
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Comm port: COM1 or as appropriate
Baud rate: 38400 or 57600
Show link messages: no check
Audio Tones:
Center Frequency: 1500
Check "USB"
Check "FSK dial=center"
Amplitudes: as appropriate, start with 130/170 (See Setting Audio Levels »Page 118)
Radio connection:
Check "Direct using PTC-II control port"
Radio type: "Icom-M710" (or "Icom-M710RT" or "Icom-M700pro")
Baud: 4800
Icom Addr (hex): 01 (or to match radio setting. M710RT is usually 03, M700pro 02)
Dial offset: 00
Note: Setting the radio modes with the "Modes" button is no longer required.
AFS/J2B mode: For Pactor-2 connections (NOT Pactor-3), the radio's AFS/J2B mode can be used in
conjunction with an (optional) 500Hz filter. The settings above are used, except set the audio centerfrequency to 1700 Hz, select "AFSK" mode, and check the "Marine radio" box. If a Pactor-3 frequency is
selected then Airmail overrides these settings with 1500Hz/USB.

Connecting a PTC-II to a SEA-235 Transceiver:
Important: See the SEA-235 transceiver »Page 128 page for general notes.
The Audio connections for the PTC-II modem are the same as for the PTC-IIe/ex »Page 129 or the
PTC-IIpro »Page 125 modems, refer to those pages for details.

: The audio cable from the modem can either be connected to the rear-panel "P3" terminal strip, or to the
9-pin "P2 RS-232" connector.
The connections for the "P3" terminal-strip are as follows:
PTC-II Audio
SEA-235 "P3 Accessory Conn"
(8-pin SCS DIN)
(12-pos terminal strip)
------------------------------------(Tx audio) Pin 1----(vio)-----term-12 (TXAF)
(Rx audio) Pin 4----(grn)-----term-11 (LLAF)
(PTT)
Pin 3----(yel)-----term-2 (PTT)
(Gnd)
Pin 2----(wht)-----term-1 (GND-AF)
(+12V)
Pin 5----(blu)-----term-8 (13.6S)
Shell---(shield)---term-7 (GND)
(Note: the AF and SPKR terminals are jumpered to operate the internal
speaker).
Note: To utilize the "P2" data connector for modem connections, the internal switches must all be in the
"OFF" state (see manual).
The connectios for the "P2 RS-232" connector are as follows:
PTC-II Audio
SEA-235 "P2" connector
(8-pin SCS DIN) »Page 77
(9-pin DB-9- see note)
-------------------------------(Tx audio) Pin 1----(vio)-----Pin 7 (audio-in)
(Rx audio) Pin 4----(grn)-----Pin 6 (audio-out)
(PTT)
Pin 3----(yel)-----Pin 4 (PTT in)
(Gnd)
Pin 2----(wht)-----Pin 9 (ground)
(+12V)
Pin 5----(blu)-----Pin 8 (+12V out)
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Shell---(shield)---Shell
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Note: To utilize the "P2" data connector for modem connections, the internal switches must all be in the
"ON" state (see manual).
Remote control: Remote frequency control is recommended and requires an RS-232 connection to the
radio's "P2 S-232" connector. If the audio connections are wired to the "P3" terminal-strip then use a
standard RS-232 cable can connect to "P2 RS-232" connector, alternately a specially-wired Y-cable is
required.
See the SEA-235 transceiver »Page 128 page for important notes regarding regarding the microphone
input in USB mode.
either by wiring the PTC-II HF Audio connections to the terminal strip instead of P2, and using P2 for the
SCS RS-232 cable (with the internal switches OFF). Alternately, build or buy a Y-cable to merge the RS232 TxD, RxD, and ground signals from the SCS RS-232 cable to pins 2, 3, and 5 or the SEA-235 "P2"
connector.
Without remote control (important!): The SEA-235 has the odd characteristic that the rear-panel
modem connection is only enabled in "Telex" (J2B) mode, and the microphone is only enabled in "USB"
mode. Pactor-2 can use teh radio's telex mode but to use Pactor-3, USB mode must be used. The radio
menu is used to select the rear-panel connector in USB mode (and must be switched back to Mic when
finished, otherwise the radio will not work in voice mode). If only Pactor-2 is used, then Telex mode can
be used (set the audio center-freq to 1700 hz, select AFSK mode, and check "Marine radio").
If remote-control is used (and it is strongly recommended for this radio), then Airmail handles switching
USB from Mic to modem and back-- however it is essential that you know how to switch USB mode
back to Mic input (e.g. if the computer is inadvertantly shut down before Airmail closes and switches
back to the microphone).
Airmail Options Settings (the following assumes Pactor-3 is used):
Modem (TNC) connection:
Modem type: PTC-II
Comm port: COM1 or as appropriate
Baud rate: 38400 or 57600
Show link messages: no check
Audio Tones:
Center Frequency: 1500
Check "USB"
Amplitudes: as appropriate, start with 100/130 an increase as needed
Radio connection:
Check "Direct using PTC-II control port"
Radio type: SEA-235
Baud: 1200 (or to match radio setting, faster is better)
VFO: not used
Dial offset: 00
Caution -- Output power: The SEA-235 is not capable of continuous full-power output. With a fan-kit
approxamatly 50% average power can be used continuously (depending on ambient tempeature), this is
adequate for Pactor-2 and 3. Without a fan kit, power must be reduced. The modem‟s audio output levels
must be carefully adjusted to keep the average power at a reasonable level. The proper way to set the
audio levels is with a RF wattmeter, but a DC ammeter that measures the radio‟s power consumption can
be used in a pinch. See "Audio levels" for more information.

Connecting a PTC-II to a SGC SG-2000 Transceiver:
The SG-2000 transceiver can work well for Pactor, but has some special considerations (see the notes on
SGC-2000 transceivers »Page 53).
Modem connections:
PTC-II Audio
(8-pin SCS DIN) »Page 77

SG-2000 terminal strip
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-------------------------------(Tx audio) Pin 1----(vio)-----J301- 1 (audio-in, see note 1)
(Rx audio) Pin 4----(grn)-----J301- 3 (audio-out)
(PTT)
Pin 3----(yel)-----J301- 4 (PTT in)
(Gnd)
Pin 2----(wht)-----J301- 2 (ground)
(+12V)
Pin 5----(blu)-----J501- 2 (+12, see note 2)
Shell---(shield)---Shell
Notes:
1. The SG-2000 is sensitive to RF interference on the audio-in connection, causing distortion of the
transmitted signal. SGC suggests the addition of a resistor from the Tx Audio connection to ground
(between J301 pins 1 and 2), see SGC Transceivers »Page 53 for more information.
2. The PTC-II‟s +12 volt power connection (pin 5, blue wire) can be optionally connected to the +12 volt
terminal for the tuner power, J-502 pin 2. This terminal is switched on with the radio.
Remote Control Connection:
The SG-2000 accepts remote-control input via a RS-232 connector. This can be connected to the PTCII's HF control port with a special RS-232 cable, available from SCS or a dealer. Airmail includes a driver
for the SG-2000 (select "Direct using PTC-II control port" or "Direct via COM port" in Airmail's
Tools/Options window). Alternately, the PTC-II's driver can be used (select "Via PTC-II"). Airmail's driver
can be used with USB or LSB, the PTC-II driver selects USB only.
AirMail Options Settings:
Modem (TNC) connection:
Modem type: PTC-II
Comm port: COM1 or as appropriate
Baud rate: 38400 or 57600
Show link messages: no check
Audio Tones:
Center Frequency: 1500
Check "USB"
TxD: 20 ms
Amplitudes: see note
Radio connection (optional):
Check "Direct using PTC-II control port"
Radio type: SGC-2000
Baud: 9600
Dial offset: 00
Audio amplitude settings: With a 220-ohm resistor at the SG-2000's input connection, start with
280/500 for FSK/PSK then adjust for appropriate power output (80 watts in FSK mode, 150 watts
peak/70-80 watts average in PSK mode). Without a resistor, start with 130/250.
See SGC Transceivers »Page 53 for important installation notes.

General Connection Hints:
The following sections offer some guidance and ideas on issues common to all radios and controllers.
FSK vs SSB modes »Page 65 Issues relating to the choice of FSK vs. SSB modes for transmitting Pactor
signals
More on FSK mode »Page 66 Additional considerations for using FSK mode for Pactor
More on SSB mode »Page 66 Additional considerations for using SSB mode for Pactor and Pactor-2
Choosing Audio Tones »Page 67 Some comments on choosing appropriate audio tones for Pactor
Setting Audio Levels »Page 67 How to set the controllers audio output level for transmitting
Filters and Passband center »Page 68 Using a narrow-passband CW filter for Pactor in SSB mode.
Center vs. Mark Frequency »Page 68 Some notes on the two different frequency designations in use.
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Frequency Checking »Page 70 Checking your operating frequency

Page 65 of 135

RF Isolation »Page 70 Tips for reducing RF feedback and interference

FSK vs. SSB modes:
Some transceivers offer a RTTY or FSK mode. In this configuration, the radio accepts a digital keying
signal rather than audio tones, and the generation of the FSK signal is done by the transceiver directly.
The dial frequency will then be the Mark frequency of the FSK signal rather than the SSB carrier, even
though the signals are generated internally using the SSB modulator. Marine transceivers use the FSK
center frequency as the dial frequency. (See Center vs. Mark Frequencies »Page 68 for more
information). Reception is unchanged, and the controller still does the FSK decoding from audio tones.
The only advantages of using FSK or RTTY mode instead of LSB or USB mode is that the transmit signal
is generated internally to the transceiver and that may avoid some RF problems, and also the dial
frequency will more closely match the operating frequency (although with the center frequencies that are
now commonly used, there is still a 100hz offset from a ham rig's dial mark frequency). Note however that
the PTC-II controller generates a complex audio waveform, not a simple FSK signal, and must be used
with USB or LSB mode.
The choice of upper or lower sideband (USB/LSB) is an arbitrary one, and as long as the dial frequency
calculation is done properly there will be difference in the transmitted signal. That said, using LSB is the
preferred standard and should be used where possible, if for no other reason than to minimize confusion
when discussing frequencies with others.
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More on using FSK Mode
Many transceivers provide an FSK or RTTY mode. This can be used for regular Pactor communications,
but Pactor-2 is phase modulated, not frequency modulated, and requires SSB mode. So if you are using
a PTC-II then skip this whole section. The advantage of using the radio's FSK or RTTY mode over LSB or
USB is that the transmitted frequencies are generated by the transceiver, not as audio tones by the
decoder, and there is less potential for RF-related audio distortion. The drawback is that while the
transmitter is responsible for generating the outgoing signals, the decoder is processing the incoming
audio signals and if the two are not in agreement then there will be no communication.
Note that the default "RTTY Tone" (or offset) is usually 2125 Hz (mark tone) with a shift of 170 Hz. Pactor
does not especially like a 170 Hz shift, so the first thing to do is change it to 200 Hz if possible. RTTY
modes mostly use LSB mode so the mark tone is the lower audio frequency. The space tone is therefore
2325 Hz (with a 200 Hz shift) and the center frequency will be 2225 Hz. This is the number that should go
into AirMail's Tools/Options window in the Radio page, rather than the default 2100 Hz. If the transceiver
offers another choice for RTTY offset, that's OK also as long as AirMail and the decoders tones are set
appropriately.
When using FSK mode it is critical that the center frequency set in AirMail (and the decoder's audio tones
if set manually) match the transceiver RTTY Tone setting, otherwise you will be transmitting on one
frequency (according to the transceiver's Tone setting) and receiving on another frequency (determined
by the decoder's tone settings). Additionally if AirMail's Center Frequency is not right, and you are using
automatic frequency setting, then you will be off frequency completely.
And use the narrow-band filter if you've got it, it only makes a difference if there is a strong adjacent
signal that would crank down the AGC otherwise. The transceiver will take care of making sure that the
filter's passband matches the selected RTTY offset.

Some notes regarding SSB mode
PTC-II decoders will always be used with the transceiver's LSB or USB mode, and using a SSB mode is
an option for FSK-mode decoders also. Setting things up for LSB or USB is slightly more straightforward
than FSK. First, it doesn't matter whether LSB or USB is used, the end result is the same, but the ham
radio convention has been to use LSB for FSK (Amtor/Pactor) transmissions. SCS, however,
recommends USB (and 1200/1400 Hz tones) for Pactor-2. Trust us. The choice of sideband makes no
difference.
The mark signal is always the higher radio frequency, which is the higher audio tone in USB mode and
the lower audio tone in LSB mode (see the picture below). The only frequencies that have to match are
AirMail's Center Frequency and the decoder's audio tones, and if you check "Set Decoder Tones" then
AirMail will take care of that for you also. If you are not asking AirMail to set the radio dial, then you need
to make sure the dial is set to the correct frequency - check the "Dial Freq" indicator in the Status Bar at
the bottom of the Terminal Window.
There is one new issue when using LSB or USB mode, however, and that is the passband of the narrowband filter. If your transceiver doesn't have a narrow band filter or it doesn't work in LSB or USB mode,
then skip this discussion and don‟t worry about it, it's not important. But if you do want to use the narrowband filter then you need to determine the center of its passband, and then make sure that the decoder
tones are set appropriately. Otherwise nothing will get through the filter.

Space M a r k

LSB
Pas s band

(Carrier)

Space M a r k
USB
Pas s band

Also note that a filter bandwidth of less than 500 Hz should NOT be used for Pactor or Pactor-2. Things
might appear to work but some of the information in the signal will be clipped and the error rate will be
higher than it would be without the filter. No filter is better than one that is too narrow.
To check your filter passband, first switch to the SSB mode of your choice and find a plain carrier of
known frequency, such as a short-wave broadcast station. (WWV doesn‟t work ver well because of the
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audio tones - but that makes it a great test for frequency accuracy - see Checking Frequency »Page 70).
Next turn on the narrow filter and move the dial up (for LSB, down for USB)) to find what range of tones
the filter will allow through. The dial frequency tells you the audio tone. The Kenwood TS-450S, for
example, allows its narrow CW filter to be used in SSB modes and the audio passband happens to be
centered around 1500 Hz. So a carrier of 4,000.000 kHz, for example, will be strong in LSB mode with
dial settings of around 4,001.250 to 4,001.750 kHz. The center of that range is 4,001.500, which is
1500 Hz away from the carrier frequency. So for our TS-450S we set AirMail's Center Frequency to 1500,
check the box for Set Decoder Tones, tell it to set the radio frequency, and we're done. Simple as pie.

Choosing Audio Tones:
The radio signals transmitted in Pactor are simple RF signals shifted between two frequencies that are
200hz apart (hence FSK = Frequency Shift Keying). These signals are generated as SSB signals from
an audio signal generated by the Pactor controller, and in LSB mode the RF signal will be offset (lower)
from the transceiver's dial frequency by the frequency of the audio tone. So the choice of audio tones is
arbitrary, as long as the transceiver's dial frequency is adjusted accordingly. AirMail will do the dial
frequency calculation and either set the radio directly (if connected) or display the dial frequency in the
bottom status bar.
It is recommended that, in general, an audio center tone of 2100hz be used in conjunction with LSB
mode, as this will result in even dial frequencies for most MBO frequencies (for example, to operate
14072.9 set your dial to 14075.0 LSB).
There are lots of exceptions to this rule, however. Pactor-2 phase-shift encoded signals often work better
with lower audio tones, and SCS uses 1300/1500hz as the default tones for the PTC-II. Also some narrow
filters can be used in SSB mode but will not likely match a 2100hz center frequency, and many marine
SSB transceivers have filters centered on 1700hz (e.g. the Icom M710 in AFSK mode). As long as the
dial frequency is set appropriately then the end result is the same.
Also see Center vs. Mark Frequencies »Page 68 for more information.

Setting Audio Levels:
It is important that the audio output level from the Pactor mdem (TNC) is set appropriately. Unless direct
FSK keying is used, the modem generates the audio signal that gets transmitted by the radio in SSB
mode. If the audio level is too low then the output power will be reduced and communications will suffer. If
the audio level is too high then the transmitted signal will be full power but may be distorted, perhaps
severely, causing interference over a broad range of frequencies. Besides being prohibited by regulation,
such "splattering" is also quite un-neighborly. The good news is that setting the transmit audio level is
relatively easy.
First, locate the adjustment. The PTC-II-family modems have software-settable audio output levels which
can be set from AirMail using either the Options Window or the special audio-level toolbox from the
Terminal Window (Set Audio Level from the Control Window). The KAM-98 and KAM-XL modems have
software-settable audio levels, adjusted via the modem's CAL command (use AIrmail's Tools/Dumb
Terminal window). The KAM+ controller uses an internal trimpot, R28, and a jumper (J9) to select a high
or low range. The PK-232 and MFJ controllers use externally-accessible trimpots.
Also keep in mind that for many transceivers, the front-panel Mic gain control is also active for the rearpanel audio input connection (even though the Mic my be disabled), so be sure the Mic control is set to
the usual position before adjusting the controller.
To set the audio level you need to be transmitting. The objective is to transmit full power, or close to it,
without over-driving the transmitter and requiring the ALC (Automatic Level Control) to crank the power
back, this is what causes distortion. Most ham transceivers have built-in power-output meters as well as
an indication of ALC level.
First, find an unused frequency and start transmitting using Unproto mode (Xmit Unproto from Terminal
Window's Control menu). Starting from a minimum audio level, increase the audio level and watch the
transceiver's output power meter - the power should smoothly increase to the maximum level, or close to
it, with no increase on the ALC indicator. As you increase the audio level further, the output power will no
longer increase and the ALC will begin to increase instead. Back off the adjustment until the ALC is near
the bottom, well into the "green" range, and the power-output about 60% of maximum. Click the
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disconnect button to stop transmitting. Repeat this check on all of the bands used as there may be
differences. (If the differences are large it may be an indication of RF feedback - see RF Isolation »Page
70).
For a PTC-II controller there is a second audio level adjustment for the Pactor-2 phase-shift (PSK)
modulation. The PSK setting is typically about 30% higher than the FSK level. Selecting PSK Unproto
will transmit a PSK signal and the PSK level can be adjusted as above. Note that the average output
power will be lower, this is because PSK is a complex waveform and while the peak power is the same,
the average power density is about half of the peak.
Marine transceivers typically do not have an ALC meter, but the method is the same. Increase the audio
level until the output power level is close to maximum and stops increasing, and then back off slightly. If
there is no output power indication, a DC ammeter provides an excellent indication of output power. A
transmitter putting out 100 watts will draw about 20 amps from 12-volt supply, and a marine transceiver
will draw up to 30 amps when putting out 150 watts. So increase the audio level until the indicated current
stops increasing, and then back off to around 80 watts- 15-20 amps. .
Reducing the audio level, and operating with less output power, is much better than too high a level and a
distorted signal. The effect of reduced output power is much less than one might expect. Your signal will
be reduced by one S-unit by dropping the power to half; in other words to S-6 instead of S-7. A strong
signal will still be a strong signal, and a marginal signal will be only a little weaker. Choosing the right time
and frequency for good propagation, and minimizing any on-board electrical interference will have a much
better payoff than trying to squeeze the last watt out of the transmitter.

Filters and Passband Center:
An 500Hz receiver passband filter can be valuable to minimize the effect of strong adjacent-channel
interference for Pactor-1 and Pactor-2 signals. (Pactor-3 uses the full audio passband). The controller will
not be sensitive to signals outside its 500hz passband, but a strong adjacent signal can desensitize the
receiver by activating its AGC (automatic gain control). Some receivers allow a 500hz CW or FSK filter to
be used in USB or LSB mode, but the passband center may not be the same as for CW or FSK mode. A
little experimentation with the tuning dial will determine the passband center, and the decoder's audio
tones can be set appropriately. Do not attempt to use a filter narrower than 500Hz, as essential sideband
information will be lost.
The Pactor mode is insensitive to which tone is used for Mark and Space, but the convention is that Mark
is the higher radio frequency, the higher audio tone if USB is used and the lower tone if LSB is used. For
Pactor, the USB/LSB choice is completely arbitrary and has no effect on the resulting signals.

Center vs. Mark frequencies:
The amateur community has traditionally described frequency-shift (FSK) signals by the frequency of the
Mark signal, a holdover from RTTY days when transmitters spent a lot of time "idling" on the mark
frequency. The practice for commercial stations has long been to describe FSK signals by their Center
frequency, the midpoint of the mark and space signals. The mark frequency traditionally is the higher of
the two transmitted signals although for Pactor transmissions the choice is arbitrary. Clover transmissions
use additional audio frequencies and the mark/space designation is not appropriate, so Clover signals
have always been described by their center frequency. .
As new modes have been developed there has been a move towards describing all digital signals by their
center frequencies. As with most proposed changes in amateur radio, this will generate lively discussion
for years to come. AirMail accommodates either convention, and calculation of dial frequencies in either
case is straightforward.
Some transceivers provide an FSK mode, and the dial readout will usually be the Mark frequency for ham
transceivers or the Center frequency for marine or commercial transceivers. Pactor-2 is a two-tone phaseencoded signal, however, so SSB mode (USB or LSB) is always used for the PTC-II. The relationship of
the mark and space signal for either sideband is shown below.
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The dial frequency for SSB modes is always the (suppressed) carrier frequency, so the frequency dial
must be offset as indicated below. The following rules apply:
For signals designated as Mark Frequency:
USB mode: Dial frequency = Signal frequency minus mark tone:
LSB mode: Dial frequency = Signal frequency plus mark tone:
(of course the mark tone is different for USB and LSB mode)
For Signals designated as Center Frequency:
USB mode: Dial frequency = Signal frequency minus center tone:
LSB mode: Dial frequency = Signal frequency plus center tone:
The center tone is always the mean of the mark and space tones, and the center of the receiver
passband.

Page 70 of 135

AirMail Help

Airmail.RTF

Checking Frequency:
In order to make reliable contact, a Pactor signal needs to be within 100hz or so, and Pactor-2 needs to
be within about 50hz. A ham radio equipped with a temperature-controlled crystal oscillator (TCXO) and a
marine radio, once warmed up, will be accurate to within a few cycles. Checking the frequency is still
good idea but in general the desired frequency (plus or minus offsets) can simply be plugged in.
Ham radios without a TCXO will drift a little as they warm up, typically 50-100 Hz, which is not enough to
matter on SSB voice mode but is certainly a consideration for Pactor-2 mode and possibly also for Pactor.
Add a TCXO if you can, otherwise pay close attention to the operating frequency or you might waste a lot
of electrons calling a station that won't answer because you are off frequency.
Most of the MBO stations are pretty close in their frequency calibration, and if you can find their signal
when they are in contact with another station then your transceiver dial can be tweaked to center the
tuning bar display on the controller. Be sure that it is the MBO station you are listening to, however, or
you might wind up compounding small frequency errors.
The easiest way to check the frequency calibration of the radio is to dial up WWV in AM mode and then
wait for a period when they are sending a tone on top of the time tick. Switch to USB mode, and it will
sound about the same. Now switch back and forth between USB and LSB modes and listen for a change
in pitch of the audio tone. If your dial frequency matches WWV exactly then there will be no change in the
audio tone between USB and LSB, so fiddle with the frequency until you reach this "null" state. It's pretty
easy to get within a couple of hertz this way.
The next step is to let the radio warm up and keep checking the frequency the same way. If it is stable,
then no problem, but if it wanders as it warms up then you will have to keep fiddling the frequency, or wait
for the radio to warm up before trying to making contact.

RF Interference:
There are two types of interference problems which can cause problems for a radio-email installation:
Interference from the transmitted signal coupling into other equipment and causing problems, and
interference from other nearby equipment interfering with received signals. Transmitter interference can
largely be avoided with good antenna and ground-system design, but receiver interference often needs a
direct attack on the offending equipment.
Transmitted interference
Radio transmitters have a great fondness for causing interference. This is not surprising, since their
primary job is to pump 100 watts or more of radio energy into the sky. Ideally all of this energy would be
sent off towards the distant receiver, but this is not the case. Antennas, particularly small ones, radiate in
all directions, and worse yet, any imbalance in the antenna system causes the coax cable, power wires,
and every other interconnection to becme part of the antenna system and radiate also. In the days before
digital communications this was a nuisance at worse, but when modems and computers get
interconnected with transmitters and radios the potential for chaos is great. This is especially problematic
for small installations such as boats and RV's where the antenna and ground system literally wrap around
the radio and other components.
With respect to HF email, there are three primary symptoms that can be traced to wayward RF energy:
distortion of the transmitted audio signal, data errors between the computer and modem, and problems
with erratic mouse behavior. And also symptoms from other equipment, such as inverters spontaneously
powering on, propane alarms shreiking, autopilots turning left, etc. But those don't interfere with email and
can be safely ignored (just kidding!).
The distortion problem is subtle because you will rarely hear it yourself, you need to listen with another
receiver (with antenna removed to avoid overloading) or have a nearby friend listen to your signal. What
happens is that if your transmitted signal gets back into the audio connection between the modem and
transmitter, then it can be rectified and produce its own audio signal, which will be transmitted and
produce more interference, etc.. It is very much like the "howl" that emits from a public-address system
when the gain is turned up too high, noise feeding upon itself.
Data errors can occur in the modem's serial-port connection, where RF energy can change 1's to 0's and
vice-versa. Here we need to separate the PTC-II-family modems from the others. PTC-II modems provide
a "CRC-Host mode" for precisely this purpose, and errors will be detected and the data will be sent again.
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A log entry is made and if problems are suspected it is a good idea to check the "debug" log (Window
menu, Files, Logs).
For modems other than the PTC-II-family, data errors will cause either errors in the command-codes
leading to very unpredictable behavior, or can corrupt transmitted or received text (the radio transmits a
short "ack" burst even when receiving). In binary mode a data error causes a format or CRC error and a
disconnection. In text mode it is just another misspelling, who can tell?
The fix is (1) provide a good ground system, (2) add a ferrite line-isolator to any unbalanced antenna (e.g.
vertical whip or sailboat backstay), and (3) add ferrite chokes to the cables between radio and modem
and computer to break and ground-loops and kill whatever is left.
Ground systems:
The usual marine antenna/ground system consists of an automatic tuner at the base of the backstay or
stern-mounted vertical antenna, a grounding strap from the tuner to a ground system of some sort, and a
coax cable to the transceiver which itself is usually grounded. Ideally all of the antenna current flows
between the antenna wire and the seawater ground system through the tuner, and with a perfect ground
system at the tuner then that is what would happen (see Fig. 1).

But grounds are never perfect, and even a ground connected to a large external metal keel has a ground
strap of some length which can develop some resistance (impedance) at certain frequencies. If there
were no other path then the impedance of the ground system wouldn't matter, but the radio itself is
always grounded, either directly or via the DC power wiring, and the nice fat shield on the coax cable
provides a good ground conductor. Note that the transmitted signal is balanced between the inner
conductor and shield, this can be considered "inside" the coax caable and will not radiate. The stray
ground path is on the shield alone, an unbalanced current, and will radiate. This is called a ground loop
(see Fig. 2). Other loops are formed by the cables that connect the controller and computer, and their 12V
power connections (which themselves are always grounded somewhere).
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These ground loops have impedance just like any other wire, and DC wiring in particular makes a pretty
poor ground conductor. RF antenna currents using these ground loops as alternative ground paths will
radiate interference signals into other cables (just like an antenna) as well as by simple voltage drops due
to the impedance of the ground loops themselves. These interference signals will raise havoc with
everything.
It would seem attractive to simply beef up the ground system, i.e. reduce its impedance and make that
path more attractive. This will certainly help and is a good first step, but it is equally important to make the
unwanted paths less attractive.
The solution:
Changing frequencies will typically change the problem, making it better or worse depending on how the
impedance of the various ground paths change with frequency. Reducing the output power will always
reduce the interference, and is a definitive test to verify that the problem is RF-related (as long as there is
enough power to maintain a good link). A permanent solution has three parts:
Make the primary ground system as good as possible;
Make the tuner-to-radio-to-ground path via the coax shield less attractive by using a ferrite "line
isolator" add impedance to that loop;
and break up any additional ground loops between radio, controller and computer with clip-on ferrite
chokes.
Task 1.
The first task is a careful review of the ground system connected to the tuner. The backstay or vertical
antenna is only half of the antenna system, the other half being the ground system. Different frequencies
will "see" the ground differently, so what works on one frequency band may not work well on another.
Higher frequency signals (21-28 MHz) have a shorter wavelength and need a few square meters (tens of
square feet) of metal surface located close to the tuner. Because the square-footage requirement is
lower, a direct seawater connection is less important. Lower frequencies (7 to 10 MHz) have a longer
wavelength and need more square footage of ground plane than can easily be provided, so a good
seawater connection is required. This requires a few square feet of seawater contact but does not need to
be as close as it would in order to be effective at high frequencies.
So the ideal ground system is a combination of a ground plane laid against the hull near the tuner, plus a
connection to the engine, metal tanks, and any other large metal, and a connection to an external keel or
other large underwater metal. These should all be interconnected with a network of 3-4" copper strap
which will have a low impedance at all frequencies.
Consider electrolysis when connecting external metal parts (such as a through-hull or prop strut) to the
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ground system. You will never create a new problem by connecting underwater metal that are already
connected to the green-wire DC bonding system, but connecting metal that was previously isolated can
create a new electrolysis problem. If in doubt then provide a DC block. Stan Honey's method is simple
and effective: cut a quarter-inch gap in the copper foil, and bridge that gap with a dozen ceramic disc
capacitors (.01uF line-bypass caps would be a suitable choice). This blocks DC electrolysis currents while
providing a low-impedance RF path for antenna currents.
Henry VE0ME, a Canadian ham of some considerable experience, favors an separate antenna ground
with no connection to the rest of a vessel's ground system. In other words, run a ground strap from the
tuner ground to a large underwater plate (such as the largest-sized Dynaplate), but do not connect this
plate to the rest of the ship's ground system. Splitting the ground system this way would break up the
major ground loop shown in fig. 2. The key to making this method work is providing a large enough
ground plate for the isolated tuner ground, the smaller Dynaplates are not adequate. The disadvantages
are those associated with grounding plates in general, drag unless the plate is set flush, and concerns
about electrolysis.
For more information on grounding and electrolysis, see Stan Honey's excellent article in Practical Sailor,
October 15, 1996 issue, or a similar article published by West Marine which is available on the Sailmail
website, Sailmail Primer page under "Application Notes".
Task 2.
After we've done what we can with the ground, the second job is to make the alternative ground paths
less attractive to the antenna currents. That is done by adding RF impedance to the coax, in the form of a
Line Isolator (a large ferrite choke) or multiple clip-on ferrites. This adds impedance to unbalanced
common-mode currents such as the ground currents using the shield as an RF path. The transmitter
output to the tuner is a balanced signal, i.e. there are equal and opposite currents flowing in the shield
and inner conductor). The net current from a balanced signal through the ferrite is zero, so there is no
attenuation at all, i.e. zero impedance. But antenna currents using the shield as a ground path flow in one
direction only and see the ferrite as an impedance (see Fig 3).

A typical line isolator is about 20 turns of RG-8X around a ferrite rod inside a plastic housing with a
female coax connector on each end. Our favorite is the Radio Works model T-4 (ungrounded), about $30
from Radio Works (http://www.radioworks.com/ which also has a good discussion of grounding
techniques), or also available for a few extra dollars from Farallon Electronics (gofarallon@aol.com) or HF
Radio in Alameda (Don@hfradio.com). You will also need a male-male coax jumper to connect the line
isolator to the tuner, as the line isolator comes with two female connectors. Clip-on ferrites will do the
same job, but it would take a dozen or more to have the same effectiveness.
The best place to locate a line isolator is close to the tuner itself. In terms of ground currents it doesn't
matter where it is located, but if the coax is long then it will still be able to radiate some signal if the line
isolator is located at the radio end of the coax.
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In addition to the line isolator on the tuner coax, one or more clip-on ferrites should also be added to the
tuner control wires. These control signals are usually grounded to the tuner ground, and provide an
alternative ground path if not blocked. An alternative to multiple ferrites is to use the large size and loop
the wire through it a few times.
Adding a line isolator (and ferrites to the tuner control cable) should stop most of the ground currents from
taking the detour through the "radio shack", but will not substitute for an adequate ground system. And of
course never add any sort of ferrite choke to the ground connection itself. Many users have also reported
that adding a line isolator also cleans up other problems such as autopilot interference, but that will
depend on how the other equipment is configured.
Task 3.
Providing a good tuner ground and isolating the alternative coax path are the most important tasks, but
while we are cleaning things up we should also break up the ground loops between the radio, controller
and computer.
Isolating the ground loops is again done by adding common-mode impedance, in this case in the form of
clip-on ferrites (see Fig 3 again). These are small split ferrite cylinders, about 3/4" in diameter, 1-1/4" long,
with a 1/4" hole through the middle for a cable. Clip-on ferrites are sold by Radio Shack, but better ones
are made by Fair-Rite, their part number for type-43 material in a 1/4" hole size is P/N 04-43-164-251 and
available from Newark Electronics (http://www.newark.com/). Fair-Rite's type-31 material performs a little
better at HF radio frequencies, their part number is 04-31-164-281 for the 1/4" hole size, and 04-31-164181 for the 1/2" hole size. The type-31 parts are not sold by Newark but are available with a $50 minimum
from Amidon and stocked by many dealers.
Use one ferrite to each end of the computer-to-controller cable, and one at each end of the controller-toradio cable. And don't forget the tuner cable as noted above. The signals inside the cable will not be
effected, only the ground currents trying to use the cable shield as an "sneak" path.
Important: The ferrite halves must meet perfectly in order to be effective. If in doubt, remove the ferrite
halves from their plastic housing and secure with tape and/or tie-wraps.
And also make sure that the cables are properly shielded, with the shield connected to the connector
shell (and equipment chassis) at both ends. This can be verified with an ohmmeter, and if the metal shells
of the DIN or DB-style rectangular connector at each end are connected, then the shield is terminated
correctly.
Metal boats:
Steel or aluminum boats don't have a problem with the ground system, but aluminum boats in particular
usually have isolated 12V neutral wiring to protect against electrolysis and are subject to significant
interference problems. In some cases the problem seems to be much worse than with a fiberglass or
wood boat, probably because any stray RF energy is trapped inside a shielded box (the hull), analogous
to the proverbial "fox in the henhouse".
The steps outlined above should be equally effective with metal boats. The line isolator in particular
should eliminate the stray RF at the source and would be the logical first step. If additional help is
needed, the 12V negative connections to the computer, controller and radio can be RF-grounded using
capacitors to provide a RF ground with DC blocking. Also provide a similar capacitively-coupled RF
ground for the radio chassis. Ceramic-disc capacitors are a good choice for this duty, and a dozen 0.01
line-voltage type capacitors wired in parallel will provide an inexpensive and low-impedance path for HF
frequencies.

Receiver Interference
Lots of other equipment can act as a radio transmitter and cause interference with radio reception- not
just for email, but any reception on the HF bands. The biggest culprits are AC-powered battery chargers,
expecially the small "solid-state" or "smart" models. The unfiltered switch-mode regulators generate a lot
of RF energy. Also AC inverters, especially small ones often used to power computers. And sometypes of
12V refrigeration, some 12V flouro lighting, etc. Basically anything with an electronic ciruit is suspect. And
also many motors, but they are usually easier to filter.
As a baseline, the next time you have your boat or RV in a truley isolated location, far from power lines
and other equipment, shut down all of your own electrical equipment except the radio. We mean
everything, including battery monitors which may be directly wired, they will always have a fuse that can
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be pulled. Then turn on the radio, dial around the bands, and note the general noise level. It should be
pretty quiet. Now find a weak radio station, clear but not strong.WWV on 5 or 10 MHz sometime works but
is often too strong. And 5 to 10 MHz is best, that's where most of the interference (and much of the
communication) occurs. Now start turning on the various circuits, listening carefully to the radio. If the
weak-but-clear station disappears under static hiss, or squeals or beeps, then you found a noise source.
Turnt eh circuit off to confirm it, and then keep looking. There may be more than one noise source.
The first step is to contact the manufacturer, they may have had other complaints and have a fix
available. The questiopn to ask is whether the equipment meets Part-15 of the FCC regulations, class-B,
unintended interference from household equipment. (The problem is that Part-15 exempts vehiclesincluding RV's and boats- for some perverse reason, but if the equipment could be used in a home
environment then you can argue that Part-15 applies).
Ferrites may help, but likely not. (Remember that ferrites don't have much tolerance for DC current, clip
them around BOTH wires of a power-supply connection to isolate the ground currents- but they will not
stop RF traveling along the +12v bus, for example). The best solution is to add a filter at the noise source,
before the interference has a chance to radiate via whatever wires power it. If the filter cannot be located
directly at the offending device then shield the wires from offending-device to the filter. A good choice for
filters would be the EMI filters made for 120/240V service, they work fine for DC applications as long as
the max-current specification is respected. The various Corcom filters do well in this application and can
be purchased from www.digikey.com.

Windows Performance Issues:
AirMail is a 32-bit program designed to operate under Windows-95, 98, ME, NT4.0, Win-2000 or Win-XP.
It cannot be used under DOS or Windows 3.1 or 3.11. Airmail is reported to work well on a Mac under
either Virtual PC or SoftWindows.
The minimum configuration to run Windows-95 or 98 is 8 megabytes of memory (RAM), and AirMail
should run acceptably well as the sole real-time application. To run AirMail concurrently with any other
programs, particularly real-time programs such as a weather fax program, charting or data logging, 16 or
32 megabytes of memory should be provided. When Windows does not have enough memory to store all
active programs simultaneously, it begins to swap blocks of memory onto the hard disk, causing long
delays when starting new programs or switching applications. Providing additional RAM memory will
provide a much greater performance boost for Windows at a lower cost than a faster processor. Also
make sure that there is plenty of free disc space, preferably 50+ MB, for Windows to use as a swap file.
Airmail also works well under Windows NT/2000/XP, but be sure to provide plenty of memory.
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Adding Serial Ports
The simplest way to add serial ports to a computer is with a serial-port adapter connected to the USB
bus. (This requires a relatively new computer and at least Windows-98SE, for older computers see
below). Before making decisions consider the use of the computer and whether additional serial ports will
be wanted for radio control, a GPS connection for charting, automatic position reporting, weather fax, etc.
USB: If the computer is equipped with a (functional) USB port, then this is the simplest approach. USB
adapters can only be used with Windows-98SE and later, but have the advantage that they are simple to
install and multi-port boxes only require a single cable to the computer to connect as many as ports as
you could want.
There are two basic types of USB serial-port adapters. One type is a single-port "dongle" to convert one
USB port to a single additional serial port. These have a couple of drawbacks. One is the basic nature of
"dongles", with a short cable connecting to a relatively bulky male/female 9-pin connectior. The other is
that each adaptor only provides a single serial port per USB port. Most computers come with two USB
ports and a USB hub can be added for more, so this is not a serious limitation.
The other alternative is a multi-port serial-adaptor box, with a single USB cable to the computer. These
are available with 2, 4 or 8 ports. Besides providing additional ports for radio-control or a GPS, these
have the advantage that the rat's nest of serial-port cables for the modem, radio control, GPS, etc can all
be buried in a cabinet along with the adaptor box, with only a single skinny cable to the computer-- no
more "spaghetti" behind the laptop.
The "Edgeport" boxes (from Inside Out Networks, www.ionetworks.com) work well and are highly
recommended. These are available from www.cdw.com and elsewhere, at a cost which ranges from $130
for 2 ports to $360 for 8 ports. As always, make sure you have the latest drivers.
For single-port "dongles", our recommendation is the "Keyspan" adaptors (model 19HS) which give
consistently good results on most computers. (Older models 19QI and 19QW work well also, avoid model
"19" with no suffix, it is a low-speed device). These are inexpensive ($25-40) and available from
www.cdw.com and other outlets, but not generally available in most computers stores. Keypan also
makes a box with 4 serial ports (model 49WLC) which works well with Airmail and our fax program, but
occasional problems are reported with other software. The Startech serial-port adaptor has also been
recommended by others, and is around $30. Edgeport also makes a single-port adaptor, which would be
strongly recommended except for its relatively high cost (around $60).
There are lots of cheap USB adaptors with bad drivers which will not work properly, or (worse by far)
make your computer unstable. Many problems have been reported by users of Belkin, Aten and other offbrand single-port dongles, as well as D-Link and Quatech's QSU-series boxes. (Belkin's F5U103 adaptor
is widely distributed but is a terrible prouct- expensive, large and badly-written drivers which do not
support the latest versions of Windows). Some of the cheapest single-port adaptors also omit the RS232
control lines (requiring that Airmail's "Ignore CTS option be set).
There are two important issues to keep in mind when using USB ports: One is to make sure that you have
the latest drivers, and the correct version for your operating system. If in doubt, go to the manufacturer's
website and download the current drivers This is especially important if you have the latest version of
Windows, verify that the drivers are labeled for that version, and are preferably "digitally signed". If you
see a warning message, stop and check- lots of grief can be avoided by installing the correct drivers. The
new Windows versions have safeguards to avoid errors, don't bypass them.
A second issue with older (pre 1999) computers is whether the computer USB port is really compatible
with the USB standard. This is not a significant concern with newer computers, but older machines
(particularly those which were upgraded from Windows-95) should be viewed with suspicion. The USB
standards association has a test program for USB port compatibility called "usbready.exe" and available
from www.usb.org.
Finding the port numbers: One issue whenever serial ports are added is finding the correct COM-port
numbers. Airmail will show you the installed ports (according to Windows) when you expand the COMport selection list (click the little arrow). The built-in port is always first, if it exists. The computer's
telephone modem will be listed also, usually as COM2 or COM3, and any additional ports will be at the
bottom of the list. So one easy way to check is to open Tools/Options prior to plugging in the port, and
note the COM-port numbers. Close the Options window and then plug in the US port or box and re-open
the options window. The USB port(s) will appear as new COM-port numbers.
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Alternately open WIndows Device Manager (under Control panel/System, Hardware tab) and find the
"Ports" category and expand that. All ports will be listed, showing COM-port designations. (Note: the
telephone modem also uses a COM-port number but is listed separately under "Modems").
PCMCIA serial-port cards are compatible with any computer that has an available PCMCIA slot, the only
disadvantage being the relatively fragile connection cable (particularly for multi-port cards). Single-port
cards are available from SocketIO (www.socketio.com), dual cards from SocketIO and Quatech (DSP100, www.quatech.com), and 4-port cards from Quatech (QSP-100). Windows provides native support for
SocketIO‟s single-port cards, and Quatech supplies drivers for its cards for most versions of Windows
(although we have recently heard reports of poor support from Quatech). Keep in mind that PCMCIA
compatibility problems are common so "try before you buy" wherever possible.
Plug-in PCI cards: With a desktop computer it is alsopossible to add a PCI-card with additional serial
ports. One company that makes these is SIIG, there are others. The advantage is that there is no extra
box or "dongle", the disadvantage is that the computer box must be opened up and there must be an
available PCI slot.
Network adaptors: Another option, more expensive but might be a good solution for some cases, is to
use a ethernet-connected serial port adaptor. These are made by Comtrol ("Rocketport serial hubs") and
Equinox. The drawbacks are cost and (for Comtrol at least) driver availability.
Where to buy? One obvious choice is the dealer who supplied the modem, most are familiar with adding
serial ports and will be able to supply the right parts and provide support. For those who like the
adventure of doing it themselves, our advice is to stick with the name brands and either buy from a highend computer store (if there are any left) or by mail from the internet. Discount computer stores in
particular seem to carry a vast array of off-brands which are nothing but trouble with little support
available. We've had good luck with CDW (www.cdw.com), good web site, OK prices and they ship when
they say they will. Check the manufacturer's web site before you buy, make sure there is a link for
"support", and check for drivers for the product you are contemplating for your particular version of
Windows.
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Connecting a PTC-II to a Kenwood TS-570D Ham Transceiver (and other compatible
models)
This page covers connecting the SCS PTC-II to a Kenwood TS-570D and compatible ham transceivers.
Audio connections:
PTC-II Audio
Kenwood "ACC-2"
(8-pin DIN) »Page 77
(13-pin DIN) »Page 77
------------------------------(Tx audio) Pin 1----(vio)-----Pin 11 (PKD)
(Rx audio) Pin 4----(grn)-----Pin 3 (AF out)
(PTT)
Pin 3----(yel)-----Pin 9 (PTT in)
(Gnd)
Pin 2----(wht)-----Pin 8 (ground)
Shell---(shield)---Shell or pin 12
Notes:
1. The colors shown above are for the pigtail cable supplied with the PTC-II and IIe. Check the colors with
an ohmmeter, errors have occurred.
2. The German-style DIN connector has a different physical pin geometry, and is not interchaneable with
the US-style DIN connector
Without a remote-control connection, set Airmail's options as follows:
Modem (TNC) connection:
Modem type: PTC-II or as appropriate
Comm port: COM1 or as appropriate
Baud rate: 57600
Show link messages: no check
Audio Tones:
Center Frequency: 1500Hz
Select "USB"
Amplitudes: as appropriate, start with 300/400 (see radio settings)
Radio connection:
Check "None" (the remaining settings do not matter)
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TS-570 radio menu settings (Menu button, Multi/Ch to select, Up/Down to change):
menu 32: OFF (disables narrow filter for USB/LSB modes)
menu 33: 0 (sets AF input level to minimum sensitivity)
menu 34: 4 (sets AF output level to mid-level)
Remote frequency connection:
Most recent Kenwood transceivers (including the TS-570 family) provide remote-control capability via a
standard RS-232 connector. This can be connected directly to an additional computer serial port, if
available (see adding computer serial ports »Page 76). It can also be connected to the remote-control
port on a PTC-II by using a special level-shift cable available from SCS or dealers. For a PTC-IIpro, a
specially-wired RS232 cable can be connected to the PTC-IIpro's control connector (see PTC-IIpro to
RS232 cable »Page 122)
Airmail options settings:
Modem (TNC) connection box: as above
Audio Tones box: as above
Radio connection box:
Check "Direct using PTC-II control port" or "Direct via COM port" as appropriate
For PTC-IIpro, check the "RS232" box
Radio type: Kenwood, Baud: 57600
VFO: A
No check for "Set narrow filters"
TS-570 radio menu settings:
As above, plus:
menu 35: 576-1 (sets RS-232 baud rate to 57600)
NOTE: The radio must be powered off and on for baud-rate changes to become effective!
"AFSK" (FSK/LSB Split) mode (Pactor-2 only)
There is another option available for remote-frequency control for the TS-2000, which allows the use of
the 500 Hz narrow filter for Pactor-1/2 modes. The latter is recommended for Pactor-2 use as it allows the
use of a narrow-band filter for receiving. With newer Kenwood models, the 500hz filter can only be used
in FSK (and CW) modes, not LSB/USB. But Pactor-2 must use LSB/USB mode for transmit. The answer
is to use the radio's "split" mode, transmitting in LSB mode and receiving in FSK mode.
Airmail options for "AFSK" mode:
Modem (TNC) connection box: as above
Audio Tones box:
Center Frequency: 2225Hz
Check "AFSK" (this enables the FSK/LSB split mode)
(other settings as above)
Radio connection box:
Check "Direct using PTC-II control port" or "Direct via COM port" as appropriate
Radio type: Kenwood, Baud: 57600
VFO: A
Check "Set narrow filters"
TS-570 radio menu settings: as above, plus:
menu 29: 200 (200hz shift)
menu 30: off (normal polarity)
menu 31: 2125 (sets mark tone, center will then be 2225hz)
NOTE: The radio must be powered off and on for changes to become effective!
Rationale: With newer Kenwood models (e.g. TS-570), the optional 500hz filter can only be used in
FSK (and CW) modes, not LSB/USB. But Pactor-2 must use LSB/USB mode for transmit. The
answer is to use the radio's "split" mode, transmitting in LSB mode and receiving in FSK mode. If you
do not have the optional 500hz filter then you can use simple USB mode (above). For Pactor-3,
Airmail always overrides these settings with USB mode, 1500 Hz.
It is also possible to use the radio's narrow-band DSP filter by setting menu 32 "on", but it will be
necessary to determine the correct center-frequency. This is not a recommended configuration.
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Messages are not uploaded to the station
If you have messages in Airmail which have been composed and posted (with a "mailbox" icon in the
message index), then Airmail will send them to the designated station the next time you connect. The key
here is the designated station, which is the station specified in the "Via" column of the index. This is set by
the routing defaults (see Routing Options »Page 24) and by the Post and Change Posting commands (in
the File menu or the right-click Popup menu).
The Posted-to "Via" station can be any of the following:
A station callsign, in which case the message is sent only to that station.
A system name, such as "WL2K" or "Sailmail". In this case the message is sent to any station which
is part of that system, but only that system.
The designator "<any>", which means that the message will be sent to any station, regardless of
what type it is. This option is not recommeded, as it is very easy to send a message to an
inappropriate station.

Can't Connect to Station
First, before attempting to connect to a station, be sure the correct station is selected in Airmail's station
box (Terminal window) and that you have the radio set to the correct frequency. Next, make surethat the
frequency is not in use. If you can hear another Pactor station, or a signal of any sort, then the station you
are calling will not hear you and you will cause interference to others.
When you click the green "connect" button, Airmail begins calling the selected station (callsign in the
Terminal window's "station" box). Most stations scan multiple frequencies when they are not busy with
another user, so it may take as long as a minute for the station to scan the frequency you are using.
(Stations with fewer frequencies scan faster). So be patient. But if the station does not answer by the time
the modem times out (about a minute), either the station is busy or does not hear you. Do NOT simply call
again, try a different frequency or wait a bit, most likely the station is busy elsewhere.
What frequency? Generally speaking, for a contact of 1000 miles or more, use the higher bands (above
12 mHz) in the afternoon, the lower frequencies (below 8 mHz) at night. Stronger signals will result in
faster connections, and higher-frequency daytime connections are faster (in general) than lowerfrequency nighttime connections (but the stations are less crowded at night).
If you cannot connect at all, check the following:
Frequency: Are you really transmitting and receiving on the correct frequency?
Power output: Are you really transmitting at all? Check your power output with a RF wattmeter, or use
the radio's built-in power meter (if it has one).
Distortion: Is your transmitted signal possibly distorted? OSetting the audio levels too high, or RF
interference, can cause serious distortion of your transmitted signal. Listen with another nearby
receiver (with the antenna disconnected, or a very small antenna to prevent overloading the receiver)
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Frequency Lists
AirMail includes a list of Pactor ham MBO stations and their operating frequencies. Selected stations from
this list are available from the Terminal Window in the form of pull-down lists for Stations and
Frequencies. The station pull-down is used to select a MBO station for connection, the Frequency pulldown provides a frequency reference and, if a transceiver remote control connection is provided, also
sets the transceiver to the selected frequency.
AirMail's Frequency List is derived from a text-format listing of Pactor stations maintained and distributed
by ZS5S. The current list can be viewed by selecting View/Frequency List from the main menu, and you
can easily change the selected stations (the ones that appear in the Terminal Window's pull-down Station
List, see Changing Selected Stations). You can also modify the list and add stations (see Modifying the
Frequency List »Page 82) or replace it by an updated list (see Creating a new Frequency List »Page 81).

Changing Selected Stations
The AirMail Frequency List includes all of the stations on Joost ZS5S's Pactor MBO list, but only a few
selected stations are shown on the Terminal Window's pull-down list. To change which stations are
shown, close the Terminal Window, and select View/Frequency List from the main program menu.
You will see a long list of stations and frequencies with a checkmark beside each station. (If there are no
checkmarks then your comctl32.dll windows common controls driver needs updating, see
TroubleShooting). Clear the checkmarks for stations that you don't care about, and set checkmarks for
those you want to see in Terminal Window.
When finished, click the "Save" button (right-most on the lower toolbar) to save the changes and exit.

Creating a new Frequency List
Pactor frequency lists are available as bulletins from many Pactor MBO‟s. That makes it a bit like Catch22, of course, since you need the correct MBO frequencies to get a MBO frequency list. The good news
is that the ZS5S list is available from Joost‟s web site or by email subscription. The web address is
www.zs5s.com, and to subscribe to the email list, send an email as follows:
To:
zs5s@iafrica.com
Subj: SUBSCRIBE MBO
Text: yourcallsign
To get ONLY the list of Winlink-2000 stations, substitute "PMBO" for "MBO" in the above.
If you downloaded a Pactor bulletin from Joost's web site, simply drag-and-drop it into Airmail's message
index. If you received a Pactor bulletin from ZS5S as an email via Winlink-2000, open it then copy the text
and paste it into Airmail's Message Index. This will create a new message containing the MBO bulletin
text. Then proceed as follows:
To make a new frequency list, select one or more MBO bulletins in the Message Index, and then select
Tools/Make Frequency List from the main menu. A Frequency List Window will be opened. If multiple
bulletins were selected, then they all be included in the open window.
If there are additional stations that you want to add to the list, insert them now, either by typing them in or
pasting text from another document. Use the same format, with a blank line between entries.
Now click the "Update" button to start parsing the list. Callsigns will be changed to red text, frequencies to
blue, and ignored text remains black. Check that the parsing appears correct, and edit the text if required
to resolve any ambiguities (and then click Update again). The callsign is taken as at least one letter and
at least one number, and must be the first or second word on a line. Frequencies must look like amateur
frequencies, and can be separated by anything. Successive station entries must be separated by a blank
line.
If the parsed text looks correct, then the click the "Freq List" tab to view the list in tabular form. A check
box appears next to each callsign, these are the stations that will appear in the Terminal Window Station
List (carried over from the previous list). Click the check boxes to change the selected stations.
Finally, click the "Save" button to store the list and make it available to the Terminal Window. The edited
list is saved (as FreqList.rtf) and can be reopened and changed at any time by selecting View/MBO
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Bulletin from the Main Program menu.

Modifying a Frequency List
The current frequency list can be opened by selecting View/MBO List from the main program menu.
Select the "Text" tab to view the original text list, or the :"Freq List" tab to view the list-format. If the station
you want is not on that list (or the frequencies are not correct) then you can easily change the list.
To change frequencies, simply make changes to the appropriate entry in the text-format list (not the list
with the check boxes- click the "Text Format" tab).
The original list is in terms of Center Frequencies, so any changes must also be Center Frequencies (to
convert a mark Frequency to a center frequency, subtract 0.1 KHz).
To add a new entry to the frequency list, find a convenient spot and type in the new entry in a similar
format, callsign followed by frequencies in KHz on the same line or following lines, with blank lines
between entries. Make sure that there is a blank line before, and after, the new entry.
After making changes, click the "Update" button again, the program will go into a frenzy of formatting.
When it is done, check your new entry - callsigns are in red, frequencies are in blue. Be sure it was
parsed correctly, and if not then fix your format and click the "Update" button again.
Now click the "Freq List" tab, find your new entry (in the same order as the text format), and be sure it is
checked. The checked entries are the only ones that appear on the station list.
Lastly, and most importantly, click the "save" button to save and exit.
If the station that you are adding is a regular pactor MBO station (with mail forwarding) then you or the
sysop should drop a note to Joost ZS5S (zs5s@iafrica.com) and get the station on his MBO list.

Importing Bulletins into Airmail
A bulletin is a special message type which is used for sending messages of common interest via Pactor.
Airmail stores bulletins in a special "Bulletin" folder. Bulletins can be imported into Airmail by the following
steps.
First, open the document that you want to import using a text editor such as Notepad. The first two lines
of the document are the header, as follows:
SB PACTOR < ZS5S
Pactor MBO stations
(rest of document follows)
The first line must begin with "SB" ("SP" for a private message), then a space, then the destination
address for the message, in this example "PACTOR" which is a common code for Pactor users. If this is
your callsign, then Airmail will store the message as incoming. The "<" is next (with a space before and
after), followed by the originator of the bulletin, in this example the ham station ZS5S. If this is your
callsign, then Airmail will store the message as outgoing. A Message-ID (MID) code can be added,
following a " $ " (again with spaces before and after). If a MID is specified, then it must be unique or
Airmail will ignore the message as being a duplicate.
The second line is the bulletin subject line, which will appear in the Message index.
The body of the bulletin follows. No special terminator code is required at the end.
To import the message into Airmail, you can select and copy all of the text (Edit/Select ALL then
Edit/Copy), swtich to Airmail (Alt then Tab as needed), and paste it into the index (Edit/Paste). Alternately
save the text as a file, and drag and drop teh file from Windows Explorer into Airmail's Message Index.
Note that Pactor MBO bulletins which are downloaded from the ZS5S web site will have a "SB" header as
the third or fourth line. Airmail will recognize this and move it to the top, so that it is not necessary to
reformat the bulletins. Simply drag and drop the downloaded text file into Airmail's message index.

Introduction to Winlink-2000
Winlink-2000 (WL2K) is a new ham-radio mbo system introduced in late 1999 by Hans Kessler N8PGR,
Vic Poor W5SMM, Rick Meuthing KN6KB and Steve Waterman K4CJX. WL2K is fully integrated with the
Internet, and uses Internet message forwarding to make user messages available at any station which
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When using WL2K for the first time, there are a few important things to keep in mind: By default, you
are registered automatically as a "Mobile" user. This means that your mail is available from any WL2K
station. Also, your "attachment limit" is initially set to zero, this means that you will not receive any file
attachments (including non-text bulletins). To change this, see Winlink-2000 Options »Page 86. If you
want to make use of Winlink's bulletins, find out how to update your bulletin list (see Winlink-2000
Bulletins »Page 84), and you should know how to update Airmail's frequency list when new WL2K
stations are added (See Frequency Lists »Page 81).
WL2K utilizes a new binary protocol, FBB level-2 (B2F) which allows integrated file transfers as well as
incorporating a new header format. Mixed radio and email addresses are permitted, and the new protocol
will allow seamless forwarding of email attachments.
A new hierchical bulletin system replaces the packet-style Winlink bulletins. There is an extensive list of
bulletins available from any WL2K station, these are called "Global" bulletins and are divided into a few
dozen categories. The WL2K global bulletin-list is distributed with the Airmail download (ham version),
and can be updated from any WL2K station. In addition, each WL2K station can also host their own local
bulletins, these are updated whenever a bulletin-update is requested from that station. This is all
accessible via Airmail's Window/Catalog menu.
While WL2K incorporates most of the existing protocols used by Winlink and Airmail, it is not fully
compatible with the older "classic" Winlink system. In order to fully utilize the new system, the new "B2F"
binary protocol must be used. WL2K does support the FBB ASCII protocol but only for basic text-based
messages, the other features (including mixed addressing) are not available in ASCII mode. Some
modems are not capable of handling binary modes and can only operate in text mode, specifically MFJ
and the original SCS PTC-plus Pactor-1 modem. PK-232-family modems can handle binary if they are
updated to current firmware.
WL2K does not offer a keyboard mode, and a client program such as Airmail must be used for access.
Please note that these are decisions which were made by the WL2K design team, and not by the Airmail
author. Airmail operates as a "smart client" for accessing WL2K, but is otherwise an independent
development. Questions and comments regarding WL2K can be directed to the developers directly (their
callsign @winlink.org) or through Steve K4CJX (k4cjx@winlink.org).
For more information on WL2K using AIrmail to access WL2K features, see the following sections:
Message addressing »Page 83
Bulletins »Page 84
Position Reports »Page 84
Options Message »Page 86

Winlink-2000 Message Addressing
WL2K uses an expanded header format which allows mixed radio and email addresses for the same
message. AIrmail recognizes common address types automatically and converts the addresses to WL2K
formats. As long as the message is send directly to a WL2K station, any combination of Internet-email
and radio callsigns can be entered in the To and Cc-boxes.
(Traditional Winlink and Packet stations limit messages to a single radio address/callsign, or one or more
email addresses, but not both. Airmail still allows entry of any combination of addresses, and creates
additional messages as required to meet the address limitations of the connected mbo).
Radio addresses are recognized by context, either a callsign alone, callsign@callsign, or
callsign@callsign.h-route (for example "KE6RK", "KE6RK@KN6KB", or "KN6KB.#MLBFL.FL.USA.NA").
Airmail may prefix radio addresses by "radio:" for clarity in a mixed-address message. An "email:" or
"smtp:" prefix can also be added to Internet addresses, this is only needed if the address is ambiguous
(i.e. an email address that matches the format for a radio address, quite unlikely but theoretically
possible). WL2K prefixes email addresses with "SMTP:", Airmail accepts this but uses email-compatible
formats wherever possible.
There is no longer a "bulletin" message-type button, instead a bulletin can be sent by adding a "bulletin:"
prefix to the To-address (for example "bulletin:USERS"). This will work for Winlink, however sending
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bulletins is NOT supported by WL2K. The only way to get a bulletin posted and made available to WL2K
users is to send it as an ordinary message to the station sysop and ask him to post it as a bulletin.

Winlink-2000 Bulletins
Winlink-2000 bulletin lists are handled with specially-formatted control messages, created with Airmail's
"Catalogs" window (Window/Catalog menu). WL2K bulletins are divided into two cateogries: "Global"
bulletins, which are the same for all stations in the network, and "Local" bulletins, which are unique to
each station. Updates are always requested from a local station, and will include global updates (or a
complete new list, if requested), plus a complete list of all local bulletins.
When an "INQUIRY: LIST" message is received, Airmail parses it and extracts bulletin information and
updates the WL2K Catalog files. Global entries are marked in the list with a "[G]" code following the date,
and are inserted into the global list file (cat3.WL2K.global.txt). Local entries are stored into the file for that
station (Cat3.WL2K.XXX.txt where "XXX" is the station callsign).
To request a WL2K bulletin from the Catalog, open the desired category under "WL2K" on the left side
(click the little "+" to expand a folder and show categories). Then find the desired bulletin in the list on the
right side, and click the check-box next to it. (The tab, arrow and spacebar keys can also be used instead
of the mouse). Airmail then creates a request-message for that bulletin (or adds the code to an existing
request message). When a connection is made to a WL2K station then Airmail sends this request, and
the bulletin will be returned in a few minutes- maybe during the same connection depending on how often
the station communicates with the central server.
Airmail can also create requests on a regular basis, for example to request a weather bulletin each day at
12:00z. Do this by checking the button next to "Every" in the box at the bottom of the list, and then enter
the desired interval (hours or days) and the time. Any bulletin (including updates) can be requested on a
regular basis this way, but no check is made to see if the source has changed before it is sent again.
Note that this request is not stored at the WL2K server, Airmail formats a request-message and posts it
for sending each time. If Airmail is not running at the specified time, then the request-message is created
when Airmail is next started
Updates to the bulletin list can be requested by selecting a local station and checking the box labeled
"Request an update from ...". This will send a request message for an update, with the specified date of
the most-recently received LIST update (from the "processed:" line). WL2K will only return additions or
changes since this date, and Airmail will add them to the catalog. Note that updates are always
requested by first selecting a local station, then selecting "Update". There is no "Update" check-box in the
global list, because the request must be sent to a particular station.
Remember that Airmail only requests the bulletins, WL2K must deliver them. Depending on whether they
must be fetched from the Internet or are already cached, this can take from a few seconds to many
minutes. If the request message is in Airmail's Outbox folder, and was sent (has a green check), then
Airmail has done its part. Either connect again to check for a reply, or send a query to the system
operator (address the message to the station's callsign, or "sysop").
When selecting the "Global" cateogry on the left, the "global date" will be shown at the bottom. This is the
date of the last global update, and comes from the "Global_Modified" header in the INQUIRY message. If
a message is received with the same or older date then the global entries are not updated. This can
happen is a local station has not updated their global tables.

Winlink-2000 Position Reports
Airmail can send Position Reports to the WL2K system by formatting and sending a specially-formatted
message »Page 92. These are formatted and posted by the "Winlink" box in Airmail's Position Reports
window. See Data Input »Page 100 for general information on setting up a GPS connection or using other
position-report formats.
All fields are optional, enter as much or as little as appropriate (except that either Lat/Lon or Comment are
required). Enter the corresponding UTC time in the format "05 Nov 2003 22:09" or click the "Now" button
and Airmail will do it for you. (If the indicated UTC time is incorrect then your Windows Date/Time settings
need adjustment). Pressing the "Send" button causes a Position Report message to be formatted and
posted for sending on the next connection to the MBO specified in the "Via" box.
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For maritime users, additional marine weather information can be entered, which will be forwarded to
Yotreps »Page 114. At a minimum, wind direction and speed, and barometric pressure and trend should
be entered in order for the data to be useful. This is strictly optional, and a report can be sent with only a
Lat/Lon, or only a comment and no Lat/Lon. See the Yotreps »Page 114 page for information on the data
formats.
To enable sending a position report on each WL2K connection, check the "Auto report" box. When Airmail
connects to a WL2K station, a position report message will be automatically formatted and posted with
the current position. (If GPS data is not available then the last data entered in the Position Report window
will be sent). Auto reporting is an option, and need not be checked. If a GPS is connected then the
Lat/Lon/Speed/Heading boxes will still be updated and the "Send Now" button can be used to manually
post a Position Report message for sending.
Requesting Positon Reports:
Position reports can be requested via radio by using Airmail's Position Request window (Window/Winlink2000/Position Request from the menu). Enter a list of callsigns, and a count if more than the single mostrecent position report is requested. For example, entering "3" will return the three most-recent reports.
Enter "99" to request all reports on file.
Internet users can look up position reports by going to the website www.winlink.org and clicking the
"Station locator" button.
Positions reports can also be requested via email, send a message to QTH@winlink.org, subject
"Position Request", and one or more callsigns in the message body (optionally followed by a report
count). There is more information at the Winlink website at www.winlink.org.
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Winlink-2000 Options Messages
WL2K provides some options which can be set with "WL2K Options Message". An Options Message is a
special control message which formatted and sent by Airmail to WL2K, in order to update options settings
which are stored in the WInlink system. Whenever an options message is sent to WL2K, you should get a
"read-back" indicating the options that are on file for your station. Note that Airmail keeps a local copy of
these settings, but the copy that counts is the one on file at WL2K. If there is ever doubt about your
options settings, sent a "Query message".
To set WL2K options, open Airmail's Window/Winlink2000/Options message window. Available options
are the following:
Mobile User: This option sets your WL2K status as a "Mobile User" which means that all incoming
messages can be collected from any WL2K station. Messages for mobile users cannot be forwarded to a
non-WL2K station, if htis is desired then you need to establish a fixed "home BBS" (via a note to the
WL2K sysop). The default is for mobile-user status to be set.
Accept BCC's: If checked, all internet messages are forwarded to you including "Blind Copies". A blind
copy is a message in which your address does not appear in either the "To" or "Cc" headers. There are
two common cases where this happens: the sender lists your address as a "BCC", in which case it is
hidden from other recipients (including your own copy), and "Spam"". Spam is commercial junk mail
which is commonly sent to long lists of BCC recipients. The default is to accept BCC's, but if you are
having problems with Spam then un-check it. (See Avoiding Spam »Page 92 for more info).
Attachment Limit: This is the maximum size in bytes, per attachment, that WL2K will forward to you. The
default is zero, no attachments. Set this with some thought, as attachments can be large and require a lot
of time to download. For example, a Pactor-2 modem with an average 1000-2000 mile link will transfer
on the order of 1000 bytes/minute. So a 15K attachment is reasonable, a 50K attachment is not. Pactor-1
modems transfer about 1/4 this rate, and accepting attachments is not recommended.
Callsign Prefix, Suffix: These are added before and after your callsign when it is sent by WL2K, for ID
purposes. An example of a prefix would be "XE2" to indicate that you are operating with a Mexican
reciprocal license. In that case WL2K would send the callsign as (for example) "XE2/K6XYZ". The suffix is
normally used to indicate portable or mobile operation. Do NOT add the "/" character, WL2K will do that.
And remember that how WL2K sends your callsign is not as important as how you send it yourself- that is
still handled by Airmail's ID string in Tools/Options/Settings.
Alternate Address: This is normally blank. If an internet (or radio) address is entered, then ALL messages
are forwarded to the designated address. So if you enter your "Hotmail" address as an alternate
(forwarding) address, and then connect via radio, all of your replies will continue to be sent to your
Hotmail address. If in doubt, send another options message or a query message.
Keywords: This field is used for personal identification information such as your name or boat name. This
will appear in the WL2K roster, visible to other WL2K users but not to the public at large.
When all fields are entered, make sure the "Send Via" box contains "WL2K", then click the "Send" button
at the bottom to format and post an options message. Special WL2K messages such as the options
message are posted form the Outbox folder the same as a regular message, except carry a higher priority
code so that they are sent first.
To check your WL2K settings, click the "Query only" button. This formats a new, empty options message
and posts it. When WL2K receives and empty options message it returns the current settings without
changing anything.
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Using Airmail on a Macintosh computer
Airmail has been used quite successfully on Apple Macintosh computers under Virtual PC, a WIndows
emulator program. It takes a fairly powerful Mac to run Virtual PC, a G3 processor with lots of memory,
but there have been no reported problems.
The Mac uses a 8-pin mini-DIN connector for its serial-port connection. An adaptor cable to the male DB9 connector used for PC's can be purchased at most computer stores, this will allow the use of the serialport cables that comes with the modem. Alternately a special cable can be made up for the Mac serial
port. The following cable connections can be used between a Mac and a PTC-II (or IIe) modem:
Mac serial port
SCS PTC-II/IIe
8-pin mini-DIN »Page 78
DB-9P (9-pin male)
--------------------------------(HSK-out) pin 1 --------pin 7 (CTS in)
(HSK-in) pin 2---------pin 8 (RTS out)
(-TXD)
pin 3---------pin 3 (RXD in)
(Ground) pin 4--O------pin 5 (ground)
(-RXD)
pin 5--|------pin 2 (TXD out)
(+TXD)
pin 6 |
+--pin 4 (DTR, jumpered to DSR)
(N/C)
pin 7 |
|
(+RXD)
pin 8--+
+--pin 6 (DSR, jumpered to DTR)
(Note: pins 4 and 8 are jumpered together at the Mac end, and also connected to pin 5 at the PTC-II end,
and pins 4 and 6 are jumpered together at the PTC-II end but not connected elsewhere).

Retrieving Bulletins with the Catalog Window
Airmail's Catalog Window maintains an index of bulletins for each ham station which is connected to. The
Catalog WIndow is opened by selecting Window and then Catalog from the main menu, or by selecting
Window, Winlink-2000, then Catalog in order to only view Winlink-2000 stations.
When a new MBO station is initially connected, a new tab is created for that station in the Catalog
WIndow. There will be a single entry with a checkbox, which will retrieve the complete bulletin list for that
station. For WInlink, this is done by sending the "LB 0" keyboard command automatically, and for Winlink2000 a INQUIRY message is send (using the Query folder).
When a new bulletin list is received, Airmail will detect it automatically and add it to the corresponding
Catalog tab. If the Catalog Window is re-opened then the new bulletins will listed in the order of the
original list. Clicking any of the grey column headings will sort by that column.
The first two entries are always to request a complete new list, or to request additions to the list. A
complete list will replace the original list, removing any deleted entries. An update will add new entries,
but will not delete entries which are no longer available.
To request a bulletin, simply click the box, or double-click anywhere on the line, and a checkmark will
appear along with the word "Once". This means the requested bulletin will be downloaded once only, and
then the request canceled. Alternately, the cursor can be positioned anywhere on the line (except inside
the checkbox) and the right mouse button clicked, this will bring up a "popup" menu with choices for
"Once", "Daily", or "Weekly". The "Daily" and "Weekly" choices will cause the bulletin to be requested at
the specified interval, on the next connection to the specified station. Additionally, the label ("Once" or
whatever) can be clicked and opened for editing, and a specific time can be specified, or multiple times,
separated with commas. The keyword "Always" can also be entered, but use this with caution as it will
request a bulletin download on each connection.
Winlink bulletins are fetched with the "CFB" command and delivered (if available) as incoming messages
during the same connection. Netlink weather bulletins get a new Message-ID only if the original internet
document has changed, so they might be declined by Airmail if they are duplicates, only updated weather
bulletins are delivered.
Winlink-2000 bulletins are fetched from the internet, and queued locally for a period of time. As a result,
there may be a delay in retrieving the requested bulletin, and it may not be returned before the connection
terminates. Winlink-2000 will not hold a connection waiting for a bulletin, and it is often necessary to
reconnect after a few minutes in order to download the requested bulletin. Winlink-2000 also assigns a
new Message-ID to each requested bulletin, whether or not the original internet document has been

Page 88 of 135

AirMail Help

Airmail.RTF

updated, so duplicates will not be rejected. For weather bulletins, it is important to check the HTML
headers for the time-stamps and time the requests accordingly (use Airmail's View/Header command if
the HTML headers are not visible).

Autocall Menu
The autocall menu is only enabled if a schedule file has been defined, and for the PTC-II-family modems.
See Autocalling »Page 31 for complete details.
AutoCall Enabled If checked, Airmail's Autocall »Page 31 mode is enabled. If autocall timeslots are
defined by the schedule, then the terminal window will be opened automatically at the
designated time for autocalling. Select this once to enabled it, again to disable it.
AutoStandby Enabled
If checked, Airmail's AutoStandby mode is enabled. If a standby period is
defined in the autocall schedule, then the terminal window will be opened automatically
for the designated period for incoming calls. Select this once to enabled it, again to
disable it.

Airmail's Mail Server (local POP/SMTP server)
Airmail now includes an interface to email programs such as Outlook and Netscape (or another copy of
Airmail), running on the same computer or on a network-connected computer. This interface is called
Airmail's Mail Server and works with any standard Internet email program. An arbitrary number of users
can be supported and the POP and SMTP connections can support a number of simultaneous
connections.
Setup is relatively easy: Enable the Mail Server in Airmail's Tools/Options window, Modules tab, and
configure the external email program to use "localhost" as the incoming and outgoing mail server. Any
login name can be used, and Airmail will create an account automatically and start forwarding mail. More
information is available in the sections on Settings up Windows Networking »Page 95 and Setting up en
Email Client »Page 97.
There are two applications for which this feature might be useful: One is for a user who is familiar with a
particular email client program and wants to keep using it for radio email. In this case Airmail acts as a
specialized "agent" for transferring the messages to and from the radio system, but would not necessarily
be used for composing or reading messages. In this mode Airmail essentially runs in the background, and
if a PTC-II controller is used then autocalling can be used to make this completely automatic if desired.
A second application is for multiple users to be able to have separate access to the radio mail system. A
number of independent email clients can use Airmail as a common mail service, either on a single
computer or over a local area network (LAN).
The Airmail server will work with any standard Internet email program, such as any version of Outlook,
Outlook Express, Netscape Manager, Eudora, anything that can transfer mail with the standard Internet
POP3 and SMTP protocols. Internet services such as AOL and CompuServe do not use POP3/SMTP
mail protocols and their mail programs cannot be used with Airmail.
Messages sent from the email client are posted into Airmail's outbox according to the routing defined in
the Options/Routing table. Messages which are received by Airmail are copied into a POP folder for each
user of the mail server, separately from the copy zof the message which is visible in the Inbox. When the
mail client deletes the message from the server, this deletes the file from the user's POP folder, but not
the original message. Note that this mail server does not handle general mail forwarding, and cannot
provide a gateway between Airmail and the internet.
Requirements:
Email client programs use the TCP/IP Internet protocol to communicate with mail servers, so to make
them work we need Windows networking be installed and configured to include the TCP/IP protocol.
Networking is a standard part of Windows 95 but may need setup. This is required even for a single
computer with no network connection, but since it is part of any Internet connection it may well already be
set up for TCP/IP.
The next section will describe how to configure Windows networking to use Airmail's Mail Server on a
single computer. Once that is done, it is a simple matter to extend the TCP/IP protocol over a LAN to
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Troubleshooting:
If you get an error message from your email program when checking for new mail, first check the Account
settings in the email program. Be sure that POP or POP3 is selected (not IMAP), the POP and SMTP
servers are both set to 127.0.0.1 (local), and that the ports are set to the defaults of 110 for POP and 25
for SMTP. Be sure that access via Local Area Network (LAN) is specified (not dial-up access or a phone
connection). Also be sure that Airmail is running, and that there is a check mark for "Enable Mail Server"
in the Mail Server window.
To check the basic Internet connection, start an MS-DOS command window (Start button/Programs/MSDOS or Command Prompt) and enter the command "Ping 127.0.0.1" (without the quotes). This will test
the connection to IP address 127.0.0.1 which is a special code for the local address (whatever it is) and
should always work if Windows networking is properly configured. You should see something like:
C:\>Ping 127.0.0.1
Pinging 127.0.0.1 with 32 bytes of data:
Reply from 127.0.0.1: bytes=32 time<10ms TTL=128
Reply from 127.0.0.1: bytes=32 time<10ms TTL=128
Reply from 127.0.0.1: bytes=32 time<10ms TTL=128
Reply from 127.0.0.1: bytes=32 time<10ms TTL=128
C:\>
If you get a response of "Request timed out" then check the Network properties and be sure that the
TCP/IP protocol is installed and correctly configured. The default settings for TCP/IP should be fine
although you might want to specify an IP address (e.g. 192.168.0.1). If you have a local network
configured then be sure each computer has a different IP address and try "Ping" for each one.
If you need help with option settings, choose one of the following:
Ham SSB transceiver »Page 90
Marine SSB transceiver »Page 89, either for use on the ham bands or a marine system such as Sailmail:
If you have an Icom M710 or M700pro with a PTC-II, and the remote-control cable is connected, click
here »Page 90
If you have a Marine SSB radio with no remote-control cable, then click here »Page 91
If you have another Marine SSB/modem combination with a remote control cable, then you should follow
the dealer's advice or dig deeper, starting with the connection chart »Page 42.
Click here »Page 5 to go back to "Getting Started »Page 5".
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Options for Ham transceivers
The recommended settings for all applications is audio tones center-frequency of 1500 Hz, and USB
mode. These settings are compatible with any Pactor mode (including Pactor-3). The exceptions are that
certain older modems have fixed tones and will need to be set differently (e.g. PK232, MFJ). Traditional
settings for ham transceivers have been a center frequency of 2100Hz, and LSB mode. Technically it
makes no difference, the radio signal doesn't actually care how it was generated. The other consideration
is if you have a narrow-band IF filter, which may dictate your choice of audio frequency, in which case you
will have to dig into the details »Page 42.
If you have a remote-control cable connected, then you will also need to dig into the details, starting with
the Connection chart »Page 42. Otherwise set the Airmail options as follows:
Options window, Connection tab:
Modem connection box:
Modem Type: (select the appropriate modem)
Comm Port: COM1 (or appropriate)
Baud Rate: 38400 or 57600 (or the highest available)
Show link messages: no check
Audio Tones box:
Center Frequency: 1500
Set modem tones: Checked
Check USB
Amplitudes: see Setting audio levels »Page 67
Radio Connection box:
Check "None"
That's for options, click OK and exit. Set the radio to USB mode, and set the dial frequency to 1.5 kHz
below the station's center frequency. Click here »Page 5 to go back to "Getting Started »Page 5".

M710 / M700pro + PTC-II, with remote control
If you have an Icom M710 or M700pro radio and a PTC-II modem with the remote control cable hooked
up, then this is the page for you. Set Airmail's options (under the tools menu) as follows:
Options window, Connection tab:
Modem connection box:
Modem Type: PTC-II (or appropriate model)
Comm Port: COM1 (or appropriate)
Baud Rate: 57600
Show link messages: no check
Audio Tones box:
Center Frequency: 1500
Check USB
Amplitudes: FSK=140, PSK=170 (for starters, see Setting audio levels »Page 67)
Radio Connection box:
Check "Direct using PTC-II control Port"
Radio type: Icom-M710 (or the appropriate model)
Baud: 4800
Icom Addr: 01 (or to match your radio's "REMT-ID" setting- see below)
That's for options, click OK and exit.
Next, check the radio settings. Turn the radio off, hold down the "Func" and "1" buttons, and turn the
power back on. Rotate the left knob to find the "REMT-ID" setting, make sure that Airmail's "icom addr"
matches this. Now use the left knob to find the "REMT IF" setting, and use the right knob if needed to set
it to "d-Sub" or "RS-232". Turn the power off, and back on.
Now open Airmail's terminal window, select a station and frequency, and verify that the radio
displays"Remote" on its dial, and is set to the selected frequency. As you select different frequencies, the
radio should follow. Close Airmail's terminal window, and the radio should return to normal functioning.
Click here »Page 5 to go back to "Getting Started »Page 5".
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Marine SSB radio, no remote control
If you have a marine SSB transceiver, with no remote-control connection, then this page is for you. Set
Airmail's options (under the tools menu) as follows:
Options window, Connection tab:
Modem connection box:
Modem Type: (select the appropriate modem)
Comm Port: COM1 (or appropriate)
Baud Rate: 57600 (or the highest)
Show link messages: no check
Ignore CTS: no check
Restart controller: Checked for a PTC-II/IIe, not checked otherwise
Audio Tones box:
Center Frequency: 1500
Check USB
Amplitudes: see Setting audio levels »Page 67
Radio Connection box:
Check "None"
That's for options, click OK and exit.
Set the radio to USB mode, and set the dial frequency to 1.7 kHz below the station's center frequency.
Click here »Page 5 to go back to "Getting Started »Page 5".

Selecting Ham MBO Stations
If you are going to access the ham network, one of the first things you need to do is select the ham MBO
(mailbox) stations that you will be using. You can select them all, but there are about sixty worldwide and
that is too many to keep straight.
From the Airmail menu, select View and then Frequency List. This will open the Frequency List »Page
81, a list of all of the major MBO stations from a bulletin published by Joost ZS5S. You will be looking at
the List Format, a list of stations and frequencies with check marks representing stations of interest that
will appear in the Terminal Window's Station Box. Clear all of the check marks except those for the
stations that you think you might use. If you have no clue, then find the extra row of toolbar buttons for the
Frequency List, and click the "Text Format" button (watch the hints for the button function) to see the
detailed list. Click the "List Format" button to get back to the checkmarks, and use the "Save button" to
save the changes and exit. (If there are no checkmark boxes then your Windows Common Controls driver
needs updating, see Program Installation »Page 5).
Click here »Page 5 to go back to "Getting Started »Page 5".
Icom OPC-478 cable/level-shifter
The Icom OPC-478 is a handly cable for providing remote control for Icom ham radios and the M710 and
M7100pro marine radios. The OPC-478 provides a 9-pin female RS232 connector at one end to plug into
a stadard PC serial port, level-conversion circuitry in the connector housing, and a 1/8" (3.2mm) miniphone-plug on the other end for connection to the radio. NOTE however, that this 1/8" plug is a 2-circuit
("stereo") plug with the data signal connected to the intermediate "sleeve" contact. This is suitable for
Icom receivers and scanners but will NOT work with ham and marine transceivers which require the data
connection to the "tip" contact. So it is necessary to either fit a new plug, connecting the data wire to the
"tip" connection, or add a "stereo-to-mono" adaptor plug (a Radio Shack item). There is also a USBversion of the OPC-478, designated "OPC-478U", which also needs a modification or adaptor. There is
also a different version of this cable which can be used without modification, designed OPC-552.
For information on adding, deleting and organizing your Start-button menu and desktop, see Windows
Help Index for "Start Menu" or "Desktop".
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This is an example of a "pop up" window, press the "Esc" key on the keyboard to close it.
Whenever you click an underlined word or phrase, you will be taken to a new help-file page which
explains the concept in more detail. To return, vclick the "Back" botton at the top of this window. The ">"
and "<" buttons will also move to the next or previous page in a related topic. Those buttons are not
available for this page, because there is no related topic. As you wanter around the help file, you can click
the "Back" button multiple times to trace your path backwards, or you can go back to the "Contents" or
"Index" tab. The "Find" tab is useful for finding out where a specific key word appears in the help file.

Avoiding "Spam" (junk email)
Unsolicited commercial email, or "Spam: for short, is a growing problem with internet email and radio
users are not immune. Spam is not a difficult problem to manage if you keep a few simple facts in mind:
1. "Spammers" do not create email addresses at random, they get them from commercially-available lists
of known email addresses.
2. Your radio email address includes your callsign, which is unique. Prior to your use of this address, it
never appeared anywhere and no one ever sent email to it.
So when you first began to use your email address, it never appeared on any "Spam" lists and you never
received any junk email. Once your address begins to appear on the Spam-lists, it is over- there is
nothing you can do. The Spammers are not interested in taking you off their list, and in fact if you respond
in any way, even to ask to be removed, it is likely that your address will windo up on a "Grade-A" list of
known, working email addresses.
So it is essential to never get onto the Spam lists in the first place. How do you do that? First, understand
where those lists come from: The internet is a public place, and any email address which is exposed on a
web page or a public archive (like newsgroups or on-line forums) is going to wind up on a Spam-list. The
Spammers use automated programs which crawl the internet, link to link, gathering up email addresses.
Sending and receiving ordinary email is private and not a problem.
1. If you have a website, or contribute to a website, NEVER post your radio email address to the website
(or allow someone else to be post it).
2. Never send anything to an internet newsgroup or web-based "forum" of any sort which includes your
radio email address.
3. Never use your radio email address when filling out an on-line form or ordering anything on-line. Get
a free Hotmail or Yahoo email address and use that instead. (The problem here is not getting on a
spam-list, but those companies want to send you unsolicited email themselves. Most include a box to
check or un-check to indicate that you do not want unsolicited mail).
Sending and receiving normal private email is safe, and your address is not publically visible.
Periodically do an internet search for your radio email address(es), using seach engines such as Google
(www.google.com) or Metcrawler (www.metcrawler.com). If you find your address posted somewhere, get
if off. There is no assurance that you will find it before the Spammers, so this is hardly foolproof.
So what if this advice comes too late and your radio inbox is full of junk? There are no good solutions, so
you REALLY want to avoid having to read this far. Winlink users can disable "blind copies", this will stop
most of the Spam but also block potentially desireable email, namely anything which was sent to you as a
blind copy (a message in which addresses are not visible to other recipients). You may also be able to
change your email address by adding a suffix-letter to your callsign, check with your system administrator.
To: QTH
Subject: POSITION REPORT
TIME: 05 Nov 1999 22:09
LATITUDE: 32-46.7N
LONGITUDE: 079-57.2W
COMMENT: Charleston City Marina
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PTC-IIpro connections:
Audio Connections:
The PTC-II controller uses an 8-pin DIN connector for its audio connections, same pin arrangement as
the PTC-II and PTC-IIe. All of the interesting signals are on pins 1 to 5 so a 5-pin DIN connector will work
just fine. And in fact the German pin layout for an 8-pin connector does not match the geometry of the
US-style pin layout, so if you need a replacement for the original SCS connector then a 5-pin connector is
the safe choice.
The relevant PTC-II pin connections are as follows (5 or 8-pin DIN connector):
HF-Transceiver Audio connection (8-Pin DIN) »Page 77
------------------------------------------Pin 4 (green)
Rx Audio from the receiver to the modem
Pin 1 (violet)
Tx Audio from the modem to the transmitter
Pin 3 (yellow)
Push-to-Talk (PTT), ground to transmit
Pin 2 (white)
Ground (audio signal return)
Pin 5 (blue)
12V power connection - see "Power" below
Shell Cable shield
(Pins 6-8 are not used for Pactor applications)
Note: The colors noted are those for recent SCS pigtail cables, check them before using. These signals,
or something equivalent, will be present on the transceiver's rear-panel accessory connector or frontpanel mike and speaker jacks, so simply match up equivalent signals (and keep a drawing of how you did
it!).
Power: The power connector used by the PTC-II controller is a 5.5mm x 2.1mm coaxial-pin connector
(same as the KAM and PK-232). The center pin is positive.
Frequency control: The PTC-II also has an 13-pin DIN connector for sending remote-control information
to compatible transeivers. This is the same as the PTC-II's 8-pin mini-DIN connector except also includes
RS-232 voltage levels in addition to the PTC-II's 0-5V (TTL) levels. So a voltage converter is never
needed.
For RS-232-level (V24) connections, use the following pins: (see also PTC-IIpro to RS232 cable »Page
122)
Pin 2 (white)
RTS (DB-9 pin 7)
Pin 3 (yellow)
TxD (DB-9 pin 3)
Pin 4 (green)
CTS (DB-9 pin 8)
Pin 8 (red)
RxD (DB-9 pin 2)
Pin 13 (orange) Ground (DB-9 pin 5)
Shell (cable shield)
Note: the "DB-9" pin designations are the pin numbers where these signals appear on a standard 9-pin
computer serial-port connector.
For TTL-level (0-5 volt) connections, use the following pins:
Pin 1 (violet)
RxD (data input from radio)
Pin 5 (blue)
CTS (RS232 handshake input)
Pin 9 (pink)
TxD (data output to radio)
Pin 10 (lt. blu) RTS (handshake output)
Pin 13 (orange) Ground
Shell (cable shield)
For Icom CI-V connections (or Icom-NMEA via "clone" jack) use the following pins:
Pin 6 (black)
Bi-directional Icom CI-V connection (TTL)
Pin 13 (orange) Ground
Shell (cable shield)
(If single-conductor shielded cable is used, connect the shield to pin 13 and skip the shell. If twoconductor shielded cable is used, connect the shield to the shell).
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Glossary:
Bindings:

In Network-speak, these are the associations between network hardware (modems and
network cards) and protocols (e.g. the TCP/IP Internet protocol). With Windows, it is
possible to have multiple copies of TCP/IP, each "bound to" (associated with) a different
network adapter, e.g. one to a modem, another to a network card.

DHCP:

Dynamic Host Control Protocol, a service provided by an ISP which assigns physical IP
addresses.

DNS:

Domain Name Server (or Service): This is a service on the Internet that translates
Domain Names (e.g. Winlink.org or Airmail2000.com) into the corresponding numerical
IP addresses. A local network will not have a DNS and should use numeric IP addresses.

DUN:

Windows Dial-up Networking. This is mysterious and amorphous piece of software that
randomly asks if you would like to dial the phone. It appears to be controlled by Internet
Options in Control Panel, but also by Internet Explorer, Outlook, in fact pretty much
anything except Netscape.

Email client:

An Internet email program such as Outlook, Outlook Express, Netscape Messenger,
Eudora, etc.

IP:

Internet Protocol. An IP address is a numerical machine address, such as 192.168.0.1. If
the first number is in the range 192-223 then the first three numbers specify the network,
and the fourth specifies the host (computer) within the network. In this case the subnet
mask should always be 255.255.255.0. IP addresses starting with 192.168... cannot be
sent via the internet and are intended for use by local networks which will not be directly
connected to the internet (and should be invisible if they ever are). The IP address
127.0.0.1 is a special "loopback" address which always refers to the local computer.

ISP:

Internet Service Provider: This is the service that provides Internet access via a modem
from a dial-in phone line. An ISP will assign IP address through its DHCP server and
provide translation from these temporary addresses to the physical address used over
the Internet. As a user you don't have to worry about any of this as long as you specify
automatically-assigned IP address for a modem connection. A local network will not have
a DHCP server and must specify its IP addresses.

POP or POP3: Post Office Protocol version 3. This is the protocol used to deliver incoming mail from the
Internet (in this case via the radio network through Airmail's Mail Server).
RAS:

Remote Access Service, the NT version of DUN, and even more mysterious and
amorphous. You really don't want to hear about this one.

SMTP:

Simple Mail Transfer Protocol. This is the protocol used to send outgoing mail from an
email client to the Internet (in this case via the radio network through Airmail's Mail
Server).

TCP/IP:

Transmission Control Protocol/Internet Protocol: The two protocols used together to
implement the Internet. Computers on the network are addressed via their numeric IP
addresses.

TLA:

Three-letter acronym.

Propagation Window
Airmail includes a propagationm winodw which will help select an appropriate time and frequency for
connecting to a station. The propagation window uses the "ICEPAC" propagation program as a prediction
engine. This is a program written by NTIA/ITS, Department of Commerce, originally for doing shortwave
broadcast prediction. As such it is optimized for finding the most reliable average conditions rather than
seeking the rare "DX" openings, but this suits our needs also. In order to use Airmail‟s propagation
window, ICEPAC must be downloaded and installed into its default directory. ICEPAC can be
downloaded from the NTIA/ITS website (http://elbert.its.bldrdoc.gov/pc_hf/hfwin32.html) or from the
Airmail website. Note that the ICEPAC program is called internally by Airmail, it is not necessary to use
ICEPAC directly (the user interface can be a challenge for the uninitiated).
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Once ICEPAC is installed, the Airmail Propagation window can be accessed via the View menu (Main
window or Terminal window), or via the F8 key. In order to check propagation, the location of both
stations must be known. Airmail will show your current position if known, either entered from the PosReports window or from Tools//Options. Alternately, the current location can be entered in the
propagation window, either as Lat/Lon or as a grid code.
The station location is normally stored with the station information, and selecting a station in the "tree" on
the left will initialize the station's location box. Alternately, the station location can be entered manually.
The propagation display is computed and updated by double-clicking a station, or clicking the "Update"
button will start the computation and update the display when finished. The normal display is "reliability",
the percentage propability of achieving an adequate link. Green is good and red is bad, and the higher
the percentage, the better. The current UTC time is highlighted.
An alternate "SNR" (Signal-to-noise) display can be selected (buttons on the upper-right). In this case the
numbers represent an arbitrary signal/noise index and bigger numbers are better.
The default sunspot setting is 100, the average for a mediocre year. if desired, the current sunspot or
solar flux value can be entered, then click "update" to recompute the display. The daily number will often
vary greatly, but propagation changes in general follow more slowly and even large changes in sunspot
numbers will have relatively little effect- the signals may vary widely in strength, but the best times are still
generally the best times.
The largest short-term effects are caused by geomagnetic interference which Airmail does not attempt to
deal with- they are hard to predict and current information is rarely available to traveling users. If a more
detailed propagation analysis is desired, then there are a variety of programs available or ICEPAC can be
used directly

Setting up Windows Networking:
If your computer has ever been configured for Internet access (email or web access) then support for the
TCP/IP protocol is already installed and nothing else is needed. If this is the case then skip this section
completely for now and go down to "Configuring the Email Client", and come back here if you run into
problems.
The TCP/IP protocol is under Windows' Network settings. Start by opening the Control Panel (Start
button/Settings/Control Panel) and find the "Network" icon. If not found then select Add/Remove
Programs, click the "Windows Settings" tab, and add a checkmark for "Communications". Click OK,
provide the Windows CD or point it to the stored Windows install files if requested, and allow it to restart.
Then go back to the Control Panel and find the "Network" icon.
Double-click the "Network" Icon, this will bring up the Network properties box (you can also right-click
"Network Neighborhood" on the desktop). If you have already installed Internet access or a network card
then there will be some entries here. What you are looking for is "TCP/IP protocol", if it listed then you are
finished (except for possible troubleshooting).
If TCP/IP is not listed then click "Add", select "Protocol", click "Add", choose "Microsoft", choose "TCP/IP"
and click OK. If you get a box asking you to identify your Network connection, it means that neither Dialup Networking or Direct Cable Connection is installed, the simple thing to do is cancel out of this and go
back to Windows Setup (above) and check Communications.
Once you find the TCP/IP protocol, select it and click "Properties", then click the "IP Address" tab. For
dial-up Internet access "Obtain an IP address automatically" will be checked, this works fine for using
Airmail's mail server locally (on a single computer). If you want to use the Airmail server over a local
network (LAN) then see "Configuring a local network" below.
Next click the "Identification" tab and enter a name for your computer. If you do not have a network
adapter then you get complaints that your "Network is not complete", continue anyway- you do not need a
complete network. Then click OK and restart the computer when prompted.
(See Network Glossary »Page 94 for terms).
Windows Internet settings:
One more thing to check is the Internet access settings. Go to Windows Control Panel, Internet Options
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("Internet" on some computers), Connections tab, and check either "Never dial a connection" or "Dial
whenever a network connection is not present". (On some versions of Windows the Control Panel setting
is called "Internet". Select the Connections tab and un-check uncheck "Connect to the Internet as
needed"). We do not want Windows Dial-up Networking (DUN) to whine about the lack of a telephone
connection, but rather to use the internal network connection to the IP address of 127.0.0.1 (i.e.
ourselves). Click OK and close the box.
Now check for new mail with the email client (click the "Send and Receive" button or Tools/Send and
Receive for Outlook, File/Get-Messages/New or ctrl-T for Netscape). It should check for mail without an
error message. If you are asked for a password, give it anything and tell it to save it. Now go back to
Airmail's Mail Server window, you should see your new user name in the user list, and some text in the
dialog window. Whenever a connection from a new user is received, a new entry in the user list is created
and a new folder under a "POP" folder is created as a message queue, using the same name.
Here is a typical POP dialog for a new user:
0: 13:48:52 Connected to port: 110/1495 handle=1116376
0: 13:48:52 +OK Airmail POP3 Server ready
0: 13:48:52 USER Jim
0: 13:48:52 +OK Jim is registered as a new user
0: 13:48:52 PASS
0: 13:48:52 +OK
0: 13:48:52 STAT
0: 13:48:52 +OK 0 0
0: 13:48:52 QUIT
0: 13:48:52 +OK Ta-ta from Airmail's POP server!
0: 13:48:52 Disconnected
Configuring a Local Area Network:
With Windows 95, 98 or NT it is a relatively simple matter to connect two or more computers into a
personal Local Area Network (LAN). A network adapter is required for each computer, the most common
type is a 10base-T network card (10 MHz, twisted pair). Two computers can be directly connected with a
special "crossover" cable, while three or more will require a network hub (a little box that costs $50-100).
Setting up two computers this way will allow each to share the resources of the other (e.g. files, drives,
and printers). Of particular interest is that an email program can use Airmail on a different computer to
send and receive email messages.
Windows will detect a new PCMCIA network card and walk you through the installation. With the network
card installed, go to Network Properties (as above) and click the Identification tab and enter a unique
name for the computer. On the first tab verify that there is a TCP/IP protocol that is connected ("bound")
to the network card, and add it if needed. If you have a modem then there will generally be a separate
TCP/IP for the network card and modem. Open the properties window for the TCP/IP protocol that is
bound to the network card, select the IP address tab, and specify an IP address.
IP Addresses are the "street addresses" for computers connected over the Internet. Assuming you will not
be connected directly to the Internet, you are free to assign your own. Typically the first three numbers
represent the network address, and the last number is the (unique) computer number. Local IP addresses
should be of the form 192.168.xxx.yyy, where "xxx" can be anything from 000 to 255 and yyy is the
unique computer number, again between 000 and 255. Use a "Subnet Mask" of 255. Addresses that start
with 192.168... are special "local" IP address that cannot accessed over the real internet, this provides
complete protection for your local network should it ever be directly connected to the internet. The IP
address 192.168.0.1 is a good choice for the first computer, 192.168.0.2 for the second, etc., all with a
subnet mask of 255.255.255.0. Do not specify DNS (Domain Name Server) and verify that WINS is
disabled.
If you also have a modem that is used for Internet access, be sure that you are modifying the settings for
the TCP/IP protocol that is bound to the network card and not the modem. The modem will be directly
connected to the internet and the IP address will be automatically assigned by the internet service's
DHCP server, and using a local address such as 192.168.0.1 on the modem connection will likely cause
conflicts. But it is no problem to add two copies of the TCP/IP protocol, one bound to a local network with
a specified IP address, and a second copy bound to the modem with DHCP-assigned IP address.
Once each computer is configured with a different IP address and rebooted, they should be able to "see"
each other over the network. Open "Network Neighborhood" and verify that each computer is listed by its
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name (from the Network properties Identification tab), including the name for your own computer. If your
own computer is not listed then networking is not running properly, resolve that before proceeding. If each
computer can see itself but not the other(s) then networking is running on that computer but not the
network link. Double-check everything and try rebooting. With Win-95 it will often be necessary to reboot
each computer in order to kick-start the network. If you want to share files between the computers, then
be sure File and Printer Sharing is enabled on both computers, and that the appropriate drives are shared
(right-click the drive in Windows Explorer and select Sharing).
Once when the network is running and all computers are visible in Network Neighborhood, start the email
client on the computer(s) that will not be running Airmail. Go to the account settings (see above) and
change the IP address for incoming and outgoing mail from 127.0.0.1 to the IP address you assigned to
the computer that will be running airmail, for example 192.168.0.1. This will direct the mail requests to the
POP and SMTP servers on that computer. The computer running Airmail can use the IP address
127.0.0.1 which points to itself.
Be sure that Airmail is running, that the Mail Server is enabled (check box on the Mail Server window),
and try checking mail from each computer. The User List on the Mail Server should show each user
name, and there should be dialog text in the POP server box from each. Compose a test message on
each computer and send it, it should appear in Airmail's Outbox posted for sending.

Configuring the Email Client:
The "email client" is an email program such as Microsoft Outlook or Outlook Express, Netscape
Messenger or Eudora. Any POP/SMTP-compatible program can be used, but not AOL or Compuserve's
email clients.
To set up the client, first start up Airmail and select Window/Mail Server from the menu, this will open
Airmail's Mail Server window. Check the "Enable local server" box and leave the window open so that you
can monitor activity. The "POP Users" box will be empty if the Mail Server has not been previously used.
Old entries can be deleted but there is no need to add new ones as email client users are registered
automatically.
Next start up your email client program (e.g. Outlook or Netscape Messenger). What we need to do is set
up an account for to use Airmail's Mail server.
Outlook/Outlook Express: For Outlook or Outlook Express, Select Tools/Accounts, Mail tab. If there are
any existing accounts, either remove them (if no longer needed) or open them (double-click or select and
click Properties) and un-check "Include this account...". We do not want Outlook checking stray mail
accounts. Now click Add, Mail, enter your name when it asks for "Display Name", and the email address
that you use for radio messages (e.g. wxy1234@sailmail.com or k6xyz@bna.win-net.org) when it asks for
an email address, this will help identify messages. The Airmail Mail Server is a POP3 server (not IMAP),
your incoming mail (POP3) server is 127.0.0.1, and your outgoing mail (SMTP) server is also 127.0.0.1
(this is a special internet IP address that means "local"). Your POP account name (or Logon name) can
be any simple word with no spaces, such as your callsign, and password can be anything including blank,
Airmail does not check passwords for POP access. The name for the account should be something like
"Local" or "Airmail", and you want to connect using your LAN, local area network (not a phone line or dialup networking). You want this account to be the default, and any others to be disabled (no checkmark for
"Include this account..."). Double-check these account properties and close the Internet Accounts box.
Under Tools/Options, Email settings, be sure that "Leave mail on server" is NOT checked, and you can
elect to have Outlook check for mail every few minutes if you want, there is little overhead.
Netscape: Setting up Netscape Messenger is similar, except that there is only one account per profile,
but multiple profiles can be defined. Netscape profiles are intended for multiple users, and each profile
has its own mailbox. To use Netscape with Airmail, you can either change your existing profile to access
Airmail, which will keep all of your email in the same box, or you can create a new profile for Airmail with a
new mailbox. Creating a new profile for Airmail will keep your existing settings intact. To create a new
profile, go to the Start button/Programs/Netscape Communicator/Utilities/Netscape User Manager, and
create a new profile with the settings below.
To change an existing profile, start Netscape Messenger and select Edit/Preferences from the menu, and
find Mail Server (under Mail & Groups). If you are changing an existing configuration, be sure to write
down the old settings before changing them. Enter a name (no spaces) or your callsign for Mail server
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user name, 127.0.0.1 for both Outgoing (SMTP) and Incoming (POP) mail servers, and be sure that
"Leave messages on server" is not checked. Under "More Options" you can elect to have Netscape check
for mail every few minutes.
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Message Menu (Message Index or Message Window)
Post:

Posts the selected message(s) for sending. Once posted, messages are automatically
sent to the "Posted" system or station on the next connection. If the default posting is not
defined, then Airmail will prompt for the "Post Via" designator, which can be a callsign,
system name, or email account name. The Post-via designator can also be prefixed by a
"portal" code, for example "Telnet.KN6KB" will send via telnet and not HF radio.

Change posting:

For selected message(s), changes the posting for an already-posted message .

Unpost:

Removes the "posted" status, so that a message will not be sent when a connection
occurs. The Post-Via designator is not removed, so if the message is re-posted then the
previous Post-Via designator still applies.

Reply:

Creates a new, outgoing message and automatically addresses it as a reply to the fromaddress of the (first) selected incoming message.

Forward:

Forwards selected messages. Creates a new, outgoing message containing the selected
message(s), and opens the address-book to allow address selection.

Archive:

Moves the selected message(s) to the archive (Inbox/Saved) folder.

Delete:

Deletes the selected message(s), i.e. moves them to the "trash" folder. (Deleting
messages from the Trash folder removes them completely).

Modules Menu
The Modules menu is used to open enabled communications modules, or make them visible if they are
hidden or minimized. The primary module for Airmail client version is the Terminal Window, which
handles radio communications. Other modules wll be visible if available and enabled in the Tools/Options
window, Modules tab.

Position Reports
Airmail can send Position Reports in a variety of formats, manually or automatically, using data obtained
from a GPS if connected, or from manaully entered position information. Specially-formatted reports can
be sent to the Winlink-2000 system or to the Yoetreps marine reporting system, or a custom format can
be created for personal use.
The position reports window has two tabs, one for entry of position information, and a second tab for entry
of marine weather information. If automatic data input is enabled, then the data will appear in the
appropriate boxes (see Data Input Window »Page 100).
A series of boxes is provided on the right side for available report formats. Marine reports can be sent
directly to "Yotreps" and hams can send reports to Winlink-2000 (and optionally forwarded to Yotreps). A
custom reporting format is also provided for other formats or private reports. Marine weather observations
sent to Yotreps are also forwarded to the US National Weather Service (NWS) through their "MAROB"
(MARine OBservation) program. See MAROB »Page 123, Winlink-2000 Reports »Page 84, Yotreps
reports »Page 101 and Custom format »Page 102 for more information.
The data boxes have the following format:
Position tab:
Identifier:

This is the callsign or other identifier (8 characters max) that will identify your position
report (and be used for the Yotreps system). This is normally a callsign but can be
another unique identifier.

Lat, Lon

Current latitude and longitude, in degrees and minutes. If a GPS is connected, then these
boxes are filled in automatically (and colored gray to indicate that manual input is not
appropriate).

Date/Time

UTC time which corresponds to the reported position and weather data. Clicking the
"Now" button will enter the current UTC time, obtained from the GPS (if connected) or the
computer time as reported by Windows.

Course:

Average course-made-good (over the ground). This should be the average course over a
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few hours or since the last report. Note that this is not necessarily the boat's compass
heading, if current is present.
Speed:

Average vessel speed in knots, over the same time period use for reporting course.

Weather tab:
Wind direction: Average true wind direction (i.e. direction from which the wind is blowing), either in in
degrees (true) or cardinal points (selected from the list). This is the wind direction as
would be observed if the vessel were stationary (and absent current), and not the
apparent wind that is observed from a moving boat. Many instrument systems display
True Wind Direction (TWD) in degrees magnetic (sometimes called "Mag Wind") which
can be converted to degrees true (by Airmail, if the NMEA interface is connected, or
manually), or it can be computed (or estimated) from the observed apparent wind
direction, boat speed and compass heading. Alternately, the direction of the wind-waves
as observed against the vessel's compass provides a good guide to average wind
direction. This is ideally a 10-minute average.
Wind speed:

Average true wind speed in knots, again as would be observed if the vessel was
stationary (see above). If instruments are not available then this can be estimated from
the seastate using the Beaufort scale which is published in most weather references.
This is ideally a 10-minute average.

Height:

Height of the wind-driven waves, peak-to-trough, in feet or meters (as selected for Swell
below)

Period:

Period of the wind-driven waves, in seconds (peak to peak as if measured from a
stationary point). One method of estimating wave period is to observe a small floating
object such as piece of wood, patch of foam or a bird and begin counting seconds as it
reaches the crest of the first well formed wave. Stop counting when a number of crests
have passed and obtain the period by dividing the number of crests into the time lapsed.

Swell Height:

The height (peak to trough) of the primary swell pattern, in feet or meters as selected.
Note that estimating swell height from any vessel is difficult. If you can stand in your
cockpit, eye about 8 feet above the water, and you can just see over the top of the swell
tops when the boat is in the trough, then it is probably not a 20-foot swell.

Swell Direction: The direction that the primary swell is coming from, in degrees (true) or compass points.
Swell Period:

Period of the primary swell, in seconds (peak to peak as if measured from a stationary
point). This can be measured similarly to wind-waves above, except base the
measurement on the long-period swell and not the smaller wind-waves.

Barometer:

Barometric pressure at the time of reporting. This can be reported as either mb/hPa
(millibars or hectopascals), or in (inches of mercury).

Trend:

Pressure change (in mb/hpa or in) over the past 3 hours. Prefix with a plus or minus sign
to indicate rising or falling. Report "0" if steady. Use the same units selected for
Barometric pressure.

Cloud:

Proportion of the sky covered by cloud of some sort, in percent.

Visibility:

Prevailing visibility, i.e. visibility common to half or more of the horizon circle, measured in
nautical miles. This is hard to estimate from a small vessel, one reference is that the
horizon-line for most vessels is 3-4 miles.

Air temp:

Air temperature at the time of reporting. This should be measured on the windward side
of the vessel, with the thermometer shielded from sunshine, rain and spray.

Sea temp:

Sea water temperature at the surface. One method is to collect a bucket sample of
surface sea water.

Position Reports- Data input Window
The Data input window cane be opened by clicking the "Setup" button in the Data input box on the
Position-Report window. This provides automated data input which is common to all report formats. Data
can be acquired from a NMEA-GPS serial-port connection, via the PTC-II's GPS input (if Terminal window
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is open), or from Raytech Navigator (or a combination). The basic input is latitude, longitude and time. If
sailing instruments are connected via NMEA then wind and boat speed data can be input automatically.
GPS Setup:
If a GPS with a standard NMEA interface is connected to an available serial port (different from the one
used for the radio modem!) then Airmail can acquire lat/lon/time data automatically, and wind and boat
data if it is available. This allows positon reports to be generated automatically. Select the appropriate
COM port from the list, and click "GPS enabled". If the GPS's NMEA data is found then "GPS active" will
be indicated and the lat/lon, speed, heading and date/time will be updated. Recognized NMEA sentences
are (in order of priority) 'RMC' for lat/lon/speed/heading/time, 'GLP', 'GGA', and 'GXP' for lat/lon/time,
'GLL' for lat/lon, and 'VTG' for speed/heading. Hopefully this combination will accommodate all GPS
formats. If two GPS ports are available, then both COM-ports can be typed into the selection box with the
format "COM1,COM2".
If a charting program is also with the GPS, then either two GPS serial-ports are required (see adding
computer serial ports »Page 76), or the chart program will have to be used alternately with Airmail's
Position Reports. Splitting a GPS to two serial ports is easy, in most cases it simply requires connecting
two serial pigtail cables to the GPS output terminals.
It is also possible to route GPS data through the PTC-II (or IIe or IIpro) modem using a GPS "Y-Cable" (a
special cable from any SCS dealer). Note that this ONLY works for Airmail, and will not make the data
available for any other programs such as charting. It is also necessary that Airmail's Terminal window be
open, in order to process the data. For these reasons, connecting the GPS directly to an additional serial
port is the preferred configuration. To enable GPS input via the PTC-II Y-cable, check the "PTC-II NMEA
input" box (and make sure that Airmail's Terminal window is open).
Airmail also supports the DeLorme Tripmate and Earthmate GPS modules. The Tripmate is detected
automatically, for the Earthmate check the "Earthmate" box (this selects 9600 baud and switches to the
Earthmate's binary format).
If Kiwitech or Raytech Navigator is installed and running, then data can be aquired via direct transfer.
The "Enable Raytech" box will appear, check that box to enable data transfer. If Raytech is running, and
acquiring data from the GPS, then lat/Lon (and wind data, if interfaced) will appear in the appropriate data
boxes.
Note that connecting a GPS is strictly optional. Position reporting works fine without it, all you need to
do is type in the lat/lon before sending a position report.
When Airmail is acquiring data automatically, the corresponding data boxes will be "greyed out" to
indicate that they are not available for manual input. If no data is received for 30 seconds, then Airmail
times out and the boxes become available for manual input. This data is copied to all available pos-report
tabs.
To enter data manually, follow the specified format for latitude and longitude (for example "32°46.7'N").
Speed is in knots, course in degrees true. Enter the corresponding UTC time in the format "09 Nov 2001
22:09" or click the "Now" button and Airmail will do it for you. (If the indicated UTC time is incorrect then
your Windows Date/Time settings need adjustment).

Position Reports- Yotreps Report
Yotreps reports are for vessels on passage only, and not used by land-based travelers or vessels in port.
Airmail can generate a Yotreps report from the Position Report window, Yotreps box. Reports are
normally sent once per day while on passage, ideally created at the same time each day. (See Yotreps
Introduction »Page 114 for general information).
To access the Yotreps report window, open Airmail's Window/Position reports menu. To send a report, fill
in the position and weather boxes and click "Send Now" in the "Yotreps" box. To enable automatic GPS
data input, see Data input »Page 100). If the GPS is connected, then a report message can be created at
a specified time by checking "Create report every..." and entering the appropriate interval (in hours) and
UTC time (.e.g every 24 hours at 00:00z). Yotreps requests that messages be sent once per day only,
and created at 24 hour intervals (or as close as practical). A delay in the sending of the message is not a
problem, but the data is most useful if the report-message is created at the same time each day.
Yotreps reports are sent as normal email messages to the Yotreps address, using the default routing.
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Postion Reports- Custom Format Tab
A custom positon-report message can be generated using the Custom report window (From the Postionreport window, click "Setup" in the Custom Report box). This is a free-text message into which pos-report
data can be inserted. The To, Cc, and subject headers are typical of any message. The "Post Via" box is
the same as for any message, and should be the name of a system -e.g. "Sailmail" or "WL2K"- or a
station callsign that the message will be sent via.
The message body can be any text, with data items embedded using "<>" characters.
The following data items are available (assuming that the values are available from the Data Input »Page
100 tab). Whenever these are used in a custom report-format, they are replaced by the designated data
item.
<date>
UTC date, in Windows' short-date format- see Windows Control panel/Regional settings
<time>
UTC time, ditto
<localdate> Date in local time-zone, Windows' short-date format
<localtime> Local time, ditto
<lat>
Latitude, same format as Data Input tab
<lon>
Longitude, ditto
<cog>
Course over ground (deg true, alternates are <course> or <crs>)
<sog>
Speed (in knots, alternates are <spd> or <speed>)
<tws>
True Wind Speed (knots)
<twd>
True Wind Direction (degrees true)
The message can be "previewed" by clicking the "Preview" button. This will format the message exactly
as it will be sent, with current data.
To create a message and post it for sending, click the :"Send Now" button on the Custom Report box on
the Position-Report window. If the GPS is connected, then the message can be created at a specified
time by checking "Create report every..." and entering the appropriate interval (in hours) and UTC time
(.e.g every 24 hours at 00:00z).
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Quick Start Index
These links will jump into detailed information on specific topics. If what you want is here, this is a quick
way to get started. If you are new to all of this, then it is probably better to use the Getting Started »Page
5 page as a guide..
For connecting a ham transceiver, click here »Page 90.
For connecting a marine transceiver, click here »Page 89
If you need information on option settings, click here »Page 89
If you need to know how to choose ham mbo stations, click here »Page 91
Click here »Page 5 to go back to "Getting Started »Page 5".

WL2K Logon passwords:
WL2K now supports secure logon. This prevents the possibility of someone else "spoofing" your callsign
and connecting to your mailbox. This has not been a significant problem in the past, but if desired, a
password-protected logon can be requested. This is not without risk, read everything here!
Before using this, you need to register a WL2K password, this is the same password used for WL2K webpage access but must be separately registered. Send a message to Steve k4cjx (k4cjx@winlink.org) with
your desired password, and request that secure logon be enabled. Then open Airmail's Tools/Options
window, Settings tab, and enter the same password in the box under your ham callsign. Do not check
"password required", unless you want to disconnect if WL2K does NOT ask for your password.
WARNING: Enabling secure login carries the risk that you will be unable to connect, because of errors on
your part, on the part of the system operators, or possibly software errors in Airmail or Winlink. DO NOT
REQUEST SECURE LOGON unless you have an alternate email path available to correct any errors with
your password, otherwise you may be locked out of WL2K with no email access. If there are any
problems with your password, send a message to Steve k4cjx@winlink.org or Rick kn6kb@winlink.org.
Please do NOT send password requests or questions to me as I have no access to the password
database.

Radio Protocol Codes
Airmail is compatible with a number of radio protocols. The simplest, used by simple BBS programs and
some TNC's directly, is the "Basic BBS format" sometimes called the W0RLI protocol. A formal
specification can be found by searching the web for "W0RLI", this overview is not intended to be
definitive. The called (slave) station sends a "SID" (System-ID) code in square-brackets, identifying the
software, version and capabilities, followed by a ">" prompt. This is the signal to the calling station that
the basic BBS protocol can be used. The calling (master) station then sends a message proposal starting
with "SP" followed by to and from-addresses, and MID (message-id) code. If the called station wants the
message (i.e. the MID is not a duplicate), then it sends back a "Y", otherwise a N"N meansing "already
received". The calling station then sends the message, the called station sends another prompt, and the
sequence repeats for each message. When the calling station has no more traffic, it sends "F>", meaning
"Reverse forward", and the roles of sender and receiver are reversed.
The drawbacks to the basic BBS protocol are the large number of link turn-aroiunds which makes this a
rather inefficient protocol especially over Pactor. The FBB protocol (designed by Jean-Paul F6FBB)
overcomes many of these limitations by grouping messages, adding check characters, and in the higher
levels sending messages as compressed blocks with CRC error-checking. Detailed specifications can be
found at www.f6fbb.org, the following is intended as an overview.
A link with the FBB protocol starts the same, with an exchange of SID codes. If both stations are
compatible with the FBB protocol then the sending station sends a block of up to five proposals,
containing address information and the MID. The receiving station sends back "FS" followed by a yes/no
response code for each message, "+" or "Y" indicates that the message is wanted and "-" or "N" means
that it was already received.
There are four levels of FBB protocol, the lowest is the FBB ASCII protocol (indicated by "F" in the SID).
Following the exchange of proposals and replies, the sending station sends all messages as a single
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block in plain text. When all messages are received, the receiving station then sends its own block of up
to five proposal codes, and the roles of sender and receiver reverse.
The FBB binary level-0 mode ("BF" inthe SID code) sends the each message as a compressed-text
binary file to save transmission time. Level-1 ("B1F") adds a CRC code for each compressed-message
block, adds the ability to send files in addition to messages, and adds special response code to reject or
defer a message, or to resume a transfer with an offset (in the event that the link was lost). Note that the
B1F mode can only transfer "loose files", i.e. not attached to a message. Airmail includes a layer of
protocol to allow the transfer of files attached to messages, but this is not supported by Winlink.
Winlink-2000 defines a new FBB level-2 protocol ("B2F"), which encapsulates the address information
into the message body as special header lines, and allows binary files to be encapsulated within text
messages. The same compressed-binary format and protocol responses of B1F are used, but because
B2F supports multiple destination-addresses, the recipient callsign is no longer contained in the proposal
line. The encapsulated addresses do not necessarily indicate intended recipients so B2F can only be
used to forward messages to teh end-user, not for futher forwarding. (Airmail includes some additional
headers to allow onward forwarding of B2 messages between Airmail stations but these are not
supported by WL2K).
For more detailed information on the FBB protocol, refer to www.f6fbb.org. For more information on the
B2 protocol, look for the WL2K specs at www.winlink.org.

Updating PTC-II FIrmware
Airmail includes a special window (under the Tools menu) for updating the firmware for PTC-II-family
modems. Normal firmware updates are straightforward, and recovery is automatic if there is any
interruption in the update process.
Upgrading the PTC-II firmware is relatively straightforward, but you want to be careful.
Step one is to download the firmware from the internet. Point your web browser at http://www.scsptc.com, click on "News/Updates", scroll down to find the Firmware Updates and click the link that says
"Download the PTC-II FIRMWARE as self extracting archive" for the appropriate PTC-II model. Make
sure that the correct version is downloaded, there is a separate firmware file for each. Save this file into a
"Firmware downloads" folder somewhere on your hard drive.
Next, open that folder and double-click the file that you downloaded (pt2_v31.exe or something like that,
depending on version). This will expand the compressed file into a firmware file and some document files.
There is no need to study the document files at this point.
Then start Airmail, and make sure your modem is powered on and connected. Select the Tools/UpdatePTC menu, this will open Airmail's update window. The top part is for the file, click the "Browse" button
and find the firmware file- "VER3_1.PT2" (or .PTE or .PRO, depending on model). Click "Open", and you
will be returned to the update window. Check the bottom box, that will show the details of the current
firmware (or an error message if Airmail can't find the PTC). Now click the "Update" button and watch for
a minute or so while it sends the new firmware. When finished, the PTC will reset and be ready to go.
Close the update window.
If desired, the current firmware version can be confirmed by opening Airmail's Tools/Dumb Terminal
window. Hit the Esc or Enter keys, you should see the PTC's power-on message which will indicate the
firmware version. (The "VER" command can also be entered from the PTC's "cmd:" prompt in the Dumb
Terminal window.
If the update process is interrupted, for example loss of modem power in the middle of uploading the new
firmware, then the PTC will come up in "BIOS" mode when powered back on. The firmware update can
simply be repeated. .
BIOS updates: Normal firmware updates do not update the "BIOS" portion of the firmware, which
contains the basic code to load firmware and run system tests. Updating the BIOS firmware is possible
but somewhat risky, because it involves updating the program that handles the updates. There is also a
risk of corrupting the flash-ROM if communications are lost during the update, requiring that the modem
be sent back for ROM replacement. SCS recommends that BIOS updates should only be done using
instructions and programs downloaded from the SCS web site. As of this date (PTC-II ver 3.1) no BIOS
updates have been required for Pactor mode or simple packet operation. .
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Mail Client Window
Airmail's "Mail Client" window is used to send and receive messages through a standard internet email
connection. This allows Airmail to handle regular internet email as well as for radio email. This is
particularly useful for Sailmail users, who have access to their messages via Sailmail's POP server.
To enable Airmail's Mail Client window, open the Options window (from the Tools menu), and check the
box next to "Mail Client". Click OK, then open the Mail Client window from the Modules menu.
Account Setup: To set up a new account, open the Mail Client window and click the "New" button, an
empty account settings window will appear. Enter a name for the account, and then the POP-server
settings as follows:
POP settings:
Server Name: Name of the POP-server or the numeric IP-address
Login name: User name associated with the mail account
Password: Login Password associated with the mail account
Leave mail on server: If checked, messages are left on the mail server for the specified number of days
(indefinitely if the "days" box is blank). (Note that most POP mailboxes have a size limit, and leaving mail
on the server may cause new messages to be rejected).
Don't download larger than: Use this box to prevent downloading large messages, useful with a slow
connection. Messages which are not downloaded are left on the server indefinitely, so this should not
normally be used.
Timeout: Normally 120 seconds, set it longer for especially slow connections. (Note: this is a "rolling
timeout", and keeps resetting whenever new data is received from the POP server).
Port: The normal TCP port for POP servers is 110, do not change this unless the server is monitoring
some other port.
Include in "Check All". Normally checked, this causes the accout to be checked whenever the "Check all"
button is clicked (or when automatic checking is enabled).
SMTP settings:
Server Name: Name of the SMTP-server or the numeric IP-address
From Name: The "friendly" name shown on the outgoing messages as a from-address. This
should be a simple name with minimal punctuation.
Email address: The email address used for a from-address. Important: This must be a valid
address of the form name@domain.com. If this is incorrect or invalid then reply messages will be
impossible, or outgoing messages may be refused altogether if the format is not correct.
Login name: User name associated with the mail account
Password: Login Password associated with the mail account
Authorization: Check "Login" or "POP first" is required to authorize access to the SMTP server
Login Name: Used with Authorization-Login ONLY, this is the required login name.
Password: Used with Authorization-Login ONLY, this is the required password.
Timeout: Normally 120 seconds, set it longer for especially slow connections. (Note: this is a
"rolling timeout", and keeps resetting whenever new data is accepted by the SMTP server).
Port: The normal TCP port for SMTP servers is 25, do not change this unless the server is
monitoring some other port.
Include in "Check All". Normally checked, this causes mail posted to this account to be sent whenever the
"Check all" button is clicked (or when automatic checking is enabled).
Passwords: Internet email is normally fetched from a mailbox located at a "POP Server" (or POP3
server), the "POP" refers to the "Post Office Protocol (version 3) used to transfer messages. Outgoing
mail is sent to a "SMTP Server" (a reference to the Simple Mail-Transfer Protocol used to relay email
messages on the internet). POP servers are always password-protected to prevent unauthorized persons
for accessing messages. SMTP servers were traditionally unprotected, the so-called "open relay". With
the widepread abuse of junk email ("spam"), all SMTP servers require some sort of authentication (or
should). There are two types, logon (similar to POP server logon), and "POP-before=SMTP" which
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requires that a user connect first to the POP server (wich requires a password) before being allowed to
connect to the SMTP server.

Checking Sailmail's POP Server with the Mail Client Window
Airmail's "Mail Client" module that can be used to fetch messages from a standard Internet POP3 server,
including SailMail's POP3 server. This allows you to connect your computer to the Internet and retrieve
your SailMail messages when you are off the boat or in a marina where radio interference is a problem. (If
you need to use someone else's computer, such as a cybercafe's, then fetching your SailMail messages
into a Hotmail or Yahoo account is still the best way to go).
To set up Airmail's Mail Client for accessing SailMail, first make sure that you have a dialup connection
set up and working from your computer (check Windows Help if you need assistance). Then start Airmail
and select Tools/Options, "Modules" tab. Check the box next to "Mail (pop/smtp) Client" to enable it (if not
already), and click OK.
Now go to Airmail's "Modules" menu and select "Mail Client" to open the mail-client window. The next
step is to set up a new mail account to access SailMail. Click the "New" button, and enter "SailMail" for
the account name. On the right side, in the "POP3 connection" box, for Server address enter
"pop3.sailmail.com" (without the quotes), and for Login Name and Password enter the settings which
were included with your "Welcome to SailMail" message (or drop a note to sysop@sailmail.com if you
didn't save that). Do NOT check the "Leave mail on server" box unless you want to download the same
messages again via radio. And do NOT make an entry in the "Don't download" box, SailMail will not
forward more than 5K in any event. Leave the timeout set to 60 and port 110.
On the left, under SMTP connection, you can either enter the SMTP-server parameters from your dial-up
service or use SailMail's SMTP server. To use Sailmail's SMTP server, make the following entries: For
"Server address" enter "pop3.sailmail.com"; for "From Name" enter your name or boat name (this
appears in your return address), and for "Email address" either enter your regular email address or your
complete SailMail email address (callsign@sailmail.com). Under "Authorization", check "Login", for "Login
Name" enter "sailmailsmtp", and for "Password" enter "9cLbUc5" (no quotes on any of these). Leave
timeout set to 60 and port set to 25. Double-check the settings and click "OK".
Now, from the mail client window, establish a dialup connection, and then click the Mail Client's "Check
All" button. Airmail will first check the POP3 server for incoming messages, and then send any outgoing
messages that posted to "SailMail". Note that we set our new Mail Client account up to have the name
"SailMail", this allows outgoing messages which are posted to "SailMail" to be sent either via radio or via
internet email.
A couple of things to remember: Messages retrieved via SailMail's POP3 server are in the same format
as radio messages and will be truncated at 5K, this is necessary to allow the POP3 server to cancel
messages from the radio connection. Also note that SailMail's POP3 access is not intended to replace
regular Internet email members who are ashore for extended periods, please do not attempt to use it in
place of a regular email account.
For AOL users: Once you connect with AOL a standard Internet TCP/IP connection is opened, this allows
Airmail (or any other program) to access the Internet directly. So first make the AOL dialup connection
manually (Airmail cannot dial an AOL account), then open Airmail's Mail Client (from the Modules menu)
and click "Check All". Note that this requires AOL's Internet link to be enabled, this should be enabled by
default and can be checked by starting Internet Explorer or any web browser and opening a web page. \
If you have problems getting connected, dial the connection manually and try to open a web page with
Internet Explorer or any other browser (try opening www.google.com or www.sailmail.com). If you get a
"page not found" error, then there is something wrong with the dialup connection.

Connecting a PTC-II to a Kenwood TS-2000 Ham Transceiver:
This page covers connecting the SCS PTC-II-family modems to a Kenwood TS-2000 ham transceiver.
For other Kenwood models, see the pages for connecting the PTC-II to the TS-570D »Page 78 and TS450 »Page 60.
Audio connections:
PTC-II Audio

Kenwood "ACC-2"
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(8-pin DIN) »Page 77
(13-pin DIN) »Page 77
------------------------------(Tx audio) Pin 1----(vio)-----Pin 11 (PKD)
(Rx audio) Pin 4----(grn)-----Pin 3 (AF out)
(PTT)
Pin 3----(yel)-----Pin 9 (PTT in)
(Gnd)
Pin 2----(wht)-----Pin 8 (ground)
Shell---(shield)---Shell or pin 12
Notes:
1. The colors shown above are for the pigtail cable supplied with the PTC-II and IIe. Check the colors with
an ohmmeter, errors have occurred.
2. The German-style 8-pin DIN connector has a different physical pin geometry, and is not interchaneable
with the US-style 8-pin DIN connector. However, a 5-pin DIN connector can be used.
Without a remote-control connection, set the Airmail options as follows:
Modem (TNC) connection:
Modem type: PTC-II
Comm port: COM1 or as appropriate
Baud rate: 57600
Show link messages: no check
Ignore CTS: no check
Restart controller: checked
Audio Tones:
Center Frequency: 1500 Hz
Check "Set tones"
Check "USB"
Do not check "FSK dial=center" (for marine radios only)
Amplitudes: as appropriate, start with 250/450 (see radio settings)
Radio connection:
Check "None" (the remaining settings do not matter)
TS-2000 radio menu settings:
menu 50A: off
(Narrow-filter for USB/LSB)
menu 50B: 4
(Audio input level at low-level)
menu 50C: 2
(Audio output level at mid-level)
Remote frequency connection:
Most recent Kenwood transceivers (including the TS-2000) provide remote-control capability via a
standard RS-232 connector. This can be connected directly to an additional computer serial port, if
available (see adding computer serial ports »Page 76). It can also be connected to the remote-control
port on a PTC-II by using a special level-shift cable available from SCS or dealers. For a PTC-IIpro, a
specially-wired RS232 cable can be connected to the PTC-IIpro's control connector (see PTC-IIpro to
RS232 cable »Page 122)
Airmail options settings:
Modem (TNC) connection box: as above
Audio Tones box: as above
Radio connection box:
Check "Direct using PTC-II control port" or "Direct via COM port" as appropriate
Radio type: Kenwood, Baud: 57600
VFO: A
No check for "Set narrow filters"
TS-2000 radio menu settings:
menu 50A: off
(Narrow-filter for USB/LSB)
menu 50B: 4
(Audio input level at low-level)
menu 50C: 2
(Audio output level at mid-level)
menu 55: OFF
(selects Remote control, not packet interface)
menu 56: 57600
(selects 57600 baud)
"AFSK" (FSK/LSB Split) mode (Pactor-2 only)
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There is another option available for remote-frequency control for the TS-2000, which allows the use of
the 500 Hz narrow filter for Pactor-1/2 modes. The latter is recommended for Pactor-2 use as it allows the
use of a narrow-band filter for receiving. With newer Kenwood models, the 500hz filter can only be used
in FSK (and CW) modes, not LSB/USB. But Pactor-2 must use LSB/USB mode for transmit. The answer
is to use the radio's "split" mode, transmitting in LSB mode and receiving in FSK mode.
Airmail options for "AFSK" mode:
Modem (TNC) connection box: as above
Audio Tones box: as above
Center Frequency: 2225Hz
Check "AFSK" (this enables the FSK/LSB split mode)
(other settings as above)
Radio connection box:
Check "Direct using PTC-II control port" or "Direct via COM port" as appropriate
Radio type: Kenwood, Baud: 57600
VFO: A
Check "Set narrow filters"
TS-2000 radio menu settings:
menu 38: 200
(200hz shift)
menu 39: Normal
(normal polarity)
menu 40: 2125
(sets mark tone, center is 2225hz)
menu 50A: off
(Narrow-filter for USB/LSB)
menu 50B: 4
(Audio input level at low-level)
menu 50C: 2
(Audio output level at mid-level)
menu 55: OFF
(selects Remote control, not packet interface)
menu 56: 57600
(selects 57600 baud)
Note: Airmail will always override these settings with USB/1500 Hz whenever a Pactor-3 station
and frequency is selected.

Connecting a PTC-IIpro to an Icom M710/M700pro marine transceiver
This page covers connecting the SCS PTC-IIpro to an Icom M710 (or M700pro) marine transceiver. The
audio connections are the same as the PTC-II/IIe, the radio-control connection is specific to the IIpro.
Audio connections:
PTC-IIpro Audio
Icom M710 ACC(1)
(8-pin SCS DIN) »Page 77
(8-pin Icom DIN) »Page 78
-------------------------------(Tx audio) Pin 1----(vio)-----Pin 4 (Mod)
(Rx audio) Pin 4----(grn)-----Pin 5 (AF out)
(PTT)
Pin 3----(yel)-----Pin 3 (PTT in)
(Gnd)
Pin 2----(wht)-----Pin 2 (ground)
(+12V)
Pin 5----(blu)-----Pin 7 (12V out- see note)
Shell---(shield)---Shell
Notes:
1. The colors shown above are for the pigtail cable supplied with the PTC-IIpro. Check the colors with
an ohmmeter, errors are possible.
2. The German-style DIN connector has a different physical pin geometry, and is not interchaneable
with the US-style DIN connector used by Icom. Label the cable ends to avoid any confusion over
which end goes where.
3. The PTC-IIpro has provision for an alternate 12V input on its HF audio connector. This provides a
convenient way to connect power to the modem, but if the cable is particularly long then this could be
a source of RF interference. Consider a separate power connection for long cables.
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Remote frequency-control is optional, but highly recommended when a PTC-IIpro modem is used with an
Icom M710/M700pro transceiver. There are two options for connecting remote control to the radio, the
recommended connection is to use the M710's 9-pin "Remote" connector (supported from Airmail ver
3.0.857 onwards). As an alternative, the 1/8" mini-phone "Clone" jack can be used, see "option 2" below.
PTC-IIpro "Control"
(13-pin DIN) »Page 77
----------Pin 3 (yellow) -------Pin 8 (red) ----------Pin 13 (orange) ---+--+--- GND 9
Shell ----(shield)-----

ICOM 710 "Remote"
(DB-9P 9-pin male)
-------------NMI+ 5
NMO+ 7
NMI- 6 (see note)
Shell

Note: Add a jumper between pin 6 and 9 on the 9-pin connector, so that the (orange) ground wire
connects to both pins. Also make sure that unused wires are carefully insulated, short-circuits can
damage the radio or modem.
Radio Settings:
In order to use the NMEA interface, it must first be selected using the front-panel "Set Mode" functions
(turn power on while holding down the "Func" and "1" buttons-- or "Ent" and "1" for the 700 pro). Select
the "REMT-IF" (remote interface) setting and change it "d-Sub" (or "RS-232" on some models). Also
check that the "REMT-ID" setting matches Airmail's "AIcom Addr" setting).
AirMail Options Settings:
Modem (TNC) connection:
Modem type: PTC-IIpro
Comm port: COM1 or as appropriate
Baud rate: 38400 or 57600
Show link messages: no check
Ignore CTS: no check
Audio Tones:
Center Frequency: 1500
Check "USB"
Check "Marine (FSK dial=center)"
Amplitudes: as appropriate, start with 130/170
Radio connection:
Check "Direct using PTC-II control port"
RS-232: Checked (this is important!)
Radio type: "Icom-M710" (select appropriate model)
Baud: 4800
Icom Addr (hex): 01 for M710, 02 for M700pro, or 03 for M710RT (must match radio's REMT-ID
setting)
Dial offset: 00
Note: Entering the radio modes with the "Modes" button is no longer required.
Remote control Option 2:
If desired, the Icom's 1/8" mini-phone "clone" jack can be used for remote control. Thjis works fine, but
has some disadvantages: There is no two-way control so "Auto-level" is not available, and the "clone"
jack is not as robust mechanically.
PTC-IIpro "Control"
(13-pin DIN)
----------Pin 6 (black) --------Pin 13 (orange) ------Shell (shield) --------

ICOM 710 "clone"
(1/8" mini-phone plug)
-------------tip contact
ground contact
ground contact (with orange wire)

Note: insulate unused wires carefully, as short-circuits can damage the radio or modem.
Settings: the same as above, except in Airmail's Options settings do NOT check the "RS-232" box.
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Connecting a PTC-IIe to an Icom M710 or M700pro
This page covers connecting the SCS PTC-IIe to an Icom M710 (or M700pro) marine transceiver. The
audio connections are the same as other PTC-II models, but the options for connecting radio control are
different.
Audio connections:
PTC-IIe Audio
Icom M710 ACC(1)
(8-pin SCS DIN) »Page 77
(8-pin Icom DIN) »Page 78
-------------------------------(Tx audio) Pin 1----(vio)-----Pin 4 (Mod)
(Rx audio) Pin 4----(grn)-----Pin 5 (AF out)
(PTT)
Pin 3----(yel)-----Pin 3 (PTT in)
(Gnd)
Pin 2----(wht)-----Pin 2 (ground)
(+12V)
Pin 5----(blu)-----Pin 7 (12V out- see note)
Shell---(shield)---Shell
Notes:
1. The colors shown above are for the pigtail cable supplied with the PTC-IIe. Check the colors with an
ohmmeter, errors are possible.
2. The German-style DIN connector has a different physical pin geometry, and is not interchaneable with
the US-style DIN connector used by Icom. Label the cable ends to avoid any confusion over which end
goes where.
3. The PTC-IIe has provision for an alternate 12V input on its HF audio connector. This provides a
convenient way to connect power to the modem, but if the cable is particularly long then this could be a
source of RF interference. Consider a separate power connection for long cables.
Remote frequency control:
The PTC-IIe does not include a port for radio control, but the M710/M700pro is easily connected to an
additional computer serial port to provide remote frequency control. This is strictly optional, but avoids
having to program the radio for each station. See COM-Port Control for the M710 »Page 52 for details.
AirMail Options Settings:
Modem (TNC) connection:
Modem type: PTC-IIpro
Comm port: COM1 or as appropriate
Baud rate: 38400 or 57600
Show link messages: no check
Audio Tones:
Center Frequency: 1500
Check "USB"
Check "Marine (FSK dial=center)"
Amplitudes: as appropriate, start with 130/170 (See Setting Audio Levels »Page 118)
Radio connection:
Check "Direct via COM port"
Radio type: Icom-NMEA:
Baud: 4800
Icom Addr (hex): 01 for M710, 02 for M700pro, 03 for M700RT (must match radio's REMT-ID setting)
Dial offset: 00
Note: Setting the modes with the "Modes" button is no longer required.
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Connecting a PTC-II* modem to a Kendood TS-570D Ham Transceiver (and
compatibles)
This page covers connecting the SCS PTC-II-family modems to a Kenwood TS-570D and compatible
ham transceivers. The audio connections are the same as the PTC-II and IIe/IIex, and the remote-control
options are different.
Audio connections:
PTC-II Audio
Kenwood "ACC-2"
(8-pin DIN) »Page 77
(13-pin DIN) »Page 77
------------------------------(Tx audio) Pin 1----(vio)-----Pin 11 (PKD)
(Rx audio) Pin 4----(grn)-----Pin 3 (AF out)
(PTT)
Pin 3----(yel)-----Pin 9 (PTT in)
(Gnd)
Pin 2----(wht)-----Pin 8 (ground)
Shell---(shield)---Shell or pin 12
Notes:
1. The colors shown above are for the pigtail cable supplied with the PTC-II and IIe. Check the colors with
an ohmmeter, errors have occurred.
2. The German-style DIN connector has a different physical pin geometry, and is not interchaneable with
the US-style DIN connector
Remote frequency connection (PTC-IIpro):
Most recent Kenwood transceivers (including the TS-570 family) provide remote-control capability via a
standard RS-232 connector. This can be connected directly to the PTC-IIpro's 13-pin DIN "Remote"
connector with the following cable connections:
PTC-IIpro "Control"
Kenwood "COM"
(13-pin DIN) »Page 77
(DB-9S 9-pin female)
--------------------------(RxD in) 8 (red) -------- 2 (transmit data out)
(TxD out) 3 (yel) ---------3 (receive data in)
(Gnd)
13 (org) -------- 5 (ground)
(RTS out) 2 (wht) -------- 7 (Rcv enable -in)
(CTS in) 4 (grn) -------- 8 (Tx enable - out)
Shell -----(shield)------- Shell
Note: A DB-9P male connector can also be used, with a straight-thru female-female adaptor. Wiring the
cable with a male connector makes it functionally identical to a computer serial-port connector.
Insulate unused wires carefully, short-circuts can damage the radio or modem. Fit clip-on ferrites to both
ends. And label the connectors, the radio's accessory jack is also a 13-pin DIN connector.
Remote frequency connection (PTC-II, PTC-IIe, IIex):
With a PTC-II modem, an external adaptor can be added to convert the modem's TTL-level control port to
RS-232. Contact SCS or your dealer for more information. The settings are the same as below except
there is no "RS-232" selection box.
With a PTC-IIe or Iiex modem (without a remote-control port), the radio can be controlled direct from the
computer using an additional serial port (see Adding Serial Ports »Page 76). A standard 9-pin
female/female serial cable is used.
Airmail settings:
The recommend settings for Pactor-2 and Pactor-3 are to use 1500 Hz center-tone, and USB mode.
Modem (TNC) settings:
Modem type: PTC-II* (select appropriate model)
Comm port: COM1 or as appropriate
Baud rate: 38400 or 57600
Show link messages: no check
Audio Tones:
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Center Frequency: 1500
Check "USB"
Radio connection box:
Check "Direct using PTC-II control port" (or "Direct via COM port")
Radio type: Kenwood, Baud: 57600
Check "RS-232" (Important!)
VFO: A
"Narrow filters" no check
Radio Settings:
TS-570 radio menu settings:
menu 32: OFF (disables narrow filter for USB/LSB modes)
menu 33: 0 (sets AF input level to lowest level)
menu 34: 4 (sets AF output level to mid-level)
menu 35: 576-1 (sets RS-232 baud rate to 57600)
NOTE: The radio must be powered off and on for changes to become effective!
It is also possible to use the radio's narrow-band DSP filter by setting menu 32 "on", but it will be
necessary to match the audio tones to the correct center-frequency. This is not a recommended
configuration.
Using "AFSK" (FSK/LSB Split) mode (Pactor-2 only)
Rationale: With newer Kenwood models (e.g. TS-570), the optional 500hz filter can only be used in FSK
(and CW) modes, not LSB/USB. But Pactor-2 must use LSB/USB mode for transmit. The answer is to use
the radio's "split" mode, transmitting in LSB mode and receiving in FSK mode. If you do not have the
optional 500hz filter then you can optionally use simple LSB mode (below). NOTE: this is not possible for
Pactor-3 mode.
Airmail options for "Split" mode:
Audio Tones box:
Center Frequency: 2225Hz
Check "AFSK" (this enables the FSK/LSB split mode)
Do not check "FSK dial=center" (for marine radios only)
Amplitudes: as appropriate, start with 250/450 (see radio settings)
Radio connection box:
As above, plus:
Check "narrow filters" if a 500hz filter is fitted
Radio Settings:
TS-570 radio menu settings as above, plus::
menu 29: 200 (200hz shift)
menu 30: off (normal polarity)
menu 31: 2125 (sets mark tone, center is 2225hz)
menu 32: OFF (disables narrow filter for USB/LSB modes)
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Connecting to a Yaesu FT-817
The Yaesu FT-817 portable transceiver has a very flexible audio-FSK "DIG" mode for use with digital
modes. Unfortunately, this is the only mode that can be used, because the rear-panel "ACC" connector is
only enabled in the DIG mode. So using the usual USB mode for the radio is not possible. DIG mode
must be used, and configured manually (using the radio's settings menu) to be compatible with the
desired modem settings. The recomended DIG-mode "USER-U" in conjunction with Airmail's USB mode.
Connect the modem to the radio's "DATA" jack, the pin connections are show in the manual ("Transmitter
operation, Digital-Mode Operation"). A remote-control connection can be connected to the "ACC"
connector.
Recommended settings: The following settings will work for Airmail remote control, provided that the
radio is set up exactly as noted. The radio settings cannot be set by Airmail, and if other settings are used
then remote-control may not work or will set an incorrect frequency. Since there is no software control
over the DIG-mode configuration, the radio must be set up manually and proper radio setup is important.
Remote Control:
Airmail also can provide remote-control for frequency and mode. Connect the radio's ACC connector to
either the "Remote" jack on a PTC-II or IIpro, or to an additional computer serial port. (Either TTL or RS232 levels can be used). Make sure that the selected baud rate matches the radio's Menu-14 setting
(9600 or 38400 baud is recommended).
Radio menu settings
(hold down "F" for 2 seconda to enter settings mode, turn "SEL" knob to select parameter):
Menu 14 CAT RATE: 9600 or 38400, to match Airmail's setting (below)
Menu 24 DIG DISP = 0
Menu 25 DIG MIC = 50
Menu 26 DIG MODE = USER-U
Menu 27 DIG Shift = 0
(Hold "F" button down for 2 seconds again, to restore normal mode).
Airmail options:
Audio center freq = 1500 Hz, "USB" mode
PFSK/PSK levels 150/150
For remote-control: for a PTC-IIpro select "Direct via PTC-II control port", check the RS-232 box.
Otherwise select "Direct via COM port, and select the appropriate port.
Radio type= Yaesu-817, baud rate 9600 or 38400 depending on radio setting, other settings not
used.
Alternate settings: The FT-817 provides extensive control over the use of digital modes. If Pactor-3
mode is used, then the DIG mode setting must be set to USER-U. Otherwise RTTY or USER-L mode can
be used if desired. RTTY mode is fixed at 2225 Hz audio center, and a narrow filter can be selected (see
the Yaesu manual). Use Airmail's AFSK mode with RTTY, USB with USER-U, and LSN with USER-L.
Airmail always selects the radio's "DIG" mode via remote control, but the frequency offset is handled
differently depending on the selected Airmail mode. In general the DIG DISP and DIG SHIFT parameters
should be set to zero, and the dial will read out carrier freq for USB/LSB and center-freq for RTTY mode.
Some experimentation will be required, and use of other than USB/USER-U mode is not supported. (That
means you need to sort it out yourself or find another 817 owner for help with settings, we won't be able
to answer questions).
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Introduction to Yotreps
YOTREPS is a voluntary reporting scheme for boats on passage, created by long-term cruiser Mike
Harris. Airmail provides a page in the Position Reports window to create Yotreps reports, see Position
Reports- Yotreps »Page 101 for more information. Mike provided the following introduction to the Yotreps
system:
All boats on passage, anywhere in the world are welcome to take part in Yotreps, and it‟s free. Benefits of
reporting are:
A personalized web page showing a plot of your last 30 reports within the last year.
Reports are routinely forwarded to weather forecasters who use the „on the spot‟ observations as a
check on the accuracy of their atmospheric modeling, and so contribute to the overall accuracy of
forecasts.
In return, in some areas, notably the south Pacific, forecasters provide a long- term prognosis of
weather prospects for boats contemplating passage.
Reports are also forwarded to search and rescue co-coordinators. In an emergency, this enables
them to see an up-to-date plot of boats in a particular area and so provides a vital information base
from which to make decisions on which vessels are best placed to render assistance.
Reports contribute to a database of passage weather observation for analysis of trends in ocean
cruising weather conditions. Where there is sufficient data, a web page provides a historical review of
conditions experienced on popular cruising routes.
Taking part
The YOTREPS report distribution and position plotting system is entirely automated. The system will
reject reports that don't fit the standard format, and return an error message. So before submitting a
report and to avoid frustration, please make sure that you understand what is required. The most up-todate source of information is the YOTREPS web site which contains, not only the boat position plotter,
passage analysis pages and free software downloads, but also full details of reporting protocols and a
page of Frequently Asked Questions. If you have any questions not covered by the FAQs please contact
mike@pangolin.co.nz
Also on the web site is „Vessel Details‟ form. So far, the largest vessel using YOTREPS has been the
„Queen Elizabeth II‟ and the smallest an 8 metre cutter „Discovery II‟. You can remain anonymous if you
wish, but filling this out helps to let us know who you are and something of your perspective on ocean
weather.
Note for YOTREPS reporters
1) If you've not already done so please check out the YOTREPS
(www.pangolin.co.nz/yotreps/index.asp) for the latest updates on reporting protocols.

web

site

2) Please only send YOTREPS reports while on passage and not from shoreside locations, ports,
anchorages or marinas.
3) Please send no more than one report in 24 hours. If you make an error, sending a repeat will not
correct the problem.
4) Please use only UTC times and dates. Reports received at the server more than 24 hours after their
validity time, or reports with future dates are rejected.
5) YOTREPS reports are routinely forwarded to search and rescue coordinators, met. forecasters and are
used in an ocean passage weather analysis web page. For this reason, weather observations form an
important part. One or two blank observation fields are acceptable but reports with no weather
observations are rejected.
6) Reports remain in the web site data base for about a year. When you have a few in the system the
following URL can be used to show a plot of your last 30:
www.pangolin.co.nz/yotreps/tracker.asp?ident=ID
where ID is the identifier used on your reports.
Report content
It's surprising how a report of even the simplest observations can be open to a variety of interpretations.
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When talking of the date and time, for example, do we mean the local time with any adjustment for
daylight saving, or perhaps Zone, or Universal time? If we specify a compass course, do we give what the
compass actually reads or is it corrected it for the local magnetic variation? When reporting boat speed,
would that be our speed through the water, or the speed over the sea bed? When exchanging information
between people from different backgrounds, cultures and experience, it is absolutely essential to be sure
that we are speaking the same language. Fortunately, with marine weather reporting, there is already a
widely used, internationally agreed standard that has been in regular use for many decades.
The World Meteorological Organization (WMO) Voluntary Observing Ship scheme (VOS) uses a system
of encoding (BBXX) that firmly defines the parameters to be given in weather reports. It is these, with
some small noted differences, that are used in YOTREPS reports and are as follows:
Parameter
Date
time

Units

and UTC

Position

Degrees
and min

Explanation

Note

UTC (Coordinated Universal Time which for the purpose
here is synonymous with GMT (Greenwich Mean Time)
Report to the nearest whole number of minutes and do
not use decimals.

Boat course Degrees
true

Boat's course through the water. (Not necessarily the 1
same as the boat's heading)

Boat speed

Knots

Average speed over the last 3 hours to the nearest 2
whole number. Speed reported should be the speed
over the ground.

Wind
direction

Deg true Direction of the true wind. To obtain this use either the
or
Beaufort Scale or correct the masthead wind indicator
Compass reading for the boat's speed and course.
points

Wind speed

Knots

Swell
direction

Compass Direction of the main ocean swell.
points

Average speed of the true wind. To obtain this, use
either the Beaufort Scale or correct the masthead
anemometer reading for the boat's speed and course.

Swell height Metres

Vertical distance from trough to crest and the average of
the larger well formed swells.

Cloud cover %

Proportion of the sky covered by cloud

Pressure

HPa

Barometric pressure

Pressure
tendency

+ or - hPa Pressure change over the past 3 hours. Prefix with a
plus or minus sign to indicate rising or falling. Report 0 if
steady

3

Notes
The course reported should be obtained by correcting the compass heading for deviation, magnetic
variation and leeway.
Except when in a strong current, which is unusual on an ocean passage, speed over the ground will be
very similar to speed through the water and could be measured by electric or mechanical log, GPS set or
visual estimate. Remember to report the average and not peaks that might perhaps occur when surfing
down wave fronts.
To estimate cloud cover, imagine the sky divided into quarters like a cake. Imagine each quarter further
divided into two parts; each segment forming one eighth of the total sky. These are known as oktas and
are the unit of cloud cover used by professional observers. Perhaps because the okta is not widely
familiar, cloud cover is often reported as a percentage. Multiply the number of oktas by 12.5 to convert to
a percentage.
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Connecting a Furuno 1503 marine SSB to a PTC-IIpro or PTC-IIe modem
The Furuno "Remote-A" option is required to connect a modem, this fits an accessory-connector which
can be used for audio in/out and also remote-control. The remote-A kit consists of a circular 16-pin
connector labeled "Remote" on the rear panel, the internal cable and small circuit-board. The remote-A kit
will come the mating connector.
The audio levels are specified at 0 dBm at 600 ohms, i.e. 2200 mV peak-peak. For a PTC-IIpro or PTC-IIe
modem, set the FSK/PSK levels intially at 1300/1700 and adjust from there. The target is about 75 watts
in FSK mode (about "6" on the meter) and 150 peak/75 avg in PSK mode to avoid overheating problems.
It is necessary to check the power-out and adjust as needed. The Furuno 1503 is not rated for full-power
output. The over-temp indicator (flashing "LOW") comes on fairly quickly even with 50 watts output, but
this can be safetly ignored to a point- check the heatsink temperature, warm is OK but if it is too hot to
touch for more than a few seconds, the radio is overheating. It will reduce power automatically, if needed.
Some models have a fan, this is highly recommended.
The pin connections for the rear-panel "Remote-A" connector wiring are as follows:
Tx audio ---Tx aud ret -Rx audio ---Rx audio retPTT --------RS232 TxD --RS232 RxD --+12v -------sig gnd ----chassis gnd -

12 (Line-in-H)
13 (Line-in-C)
10 (Line-out-H)
11 (Line-out-C)
14
1 (RS232 data from radio)
3 (RS232 data to radio)
6,7
8,9
5 (shield)

Here are the proper connections for a PTC-IIpro or IIe. The Furuno "Remote" plug must be wired with one
or two cables, one to the PTC's "audio" connector (5 or 8-pin DIN), the second to the PTC-IIpro's 13-pin
"remote" connector. (This is easiest if the SCS "pigtail" cables are used).
PTC-IIpro
Furuno
"Audio" (5/8-DIN)
"Remote"
-------------------------------Pin 4 (green)
10
Rx audio from receiver to modem
Pin 1 (violet)
12
Tx Audio from modem to the xmtr
Pin 3 (yellow)
14
PTT, ground to transmit
Pin 2 (white)
11,13,8 sig ground (audio signal return)
Pin 5 (blue)
6
12V power connection - see "Power" below
Shell (shield)
5
frame ground
For a PTC-IIpro, add the following connections to a 13-pin DIN plug:
PTC-IIpro
Furuno
"Control" (13-DIN)
"Remote"
--------------------------------Pin 3 (yellow)
3
data from modem to radio
Pin 8 (red)
1
data from radio to modem
Pin 13 (orange)
9 (or 5) sig ground
For a PTC-IIe modem, the remote-control connection can be configured to an additional serial port as
follows:
COM port
Furuno
DB-9 female
"Remote"
------------------------------------Pin 3
3
data from modem to radio
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1
data from radio to modem
9 (or 5) sig ground

AirMail Options Settings:
Modem (TNC) connection:
Modem type: PTC-II (select appropriate model)
Comm port: COM1 or as appropriate
Baud rate: 38400 or 57600
Show link messages: no check
Audio Tones:
Center Frequency: 1500
Check "USB"
Amplitudes: as appropriate, start with 1300/1700 (See Setting Audio Levels »Page 67)
Radio connection: (if connected)
Check "Direct using PTC-II control port" or "Direct via COM port" as appropriate
RS232: checked (PTC-IIpro only)
Radio type: Furuno-1503
Baud: 4800
Dial offset: 00

Setup Wizard
A "Setup Wizard" is provided for first-time users, and to provide a simplified method of setting up the
basic options settings. The wizard is a series of simple options-windows, starting with system selection
and callsign entry, location, and modem and radio selection. Only the most common settings are covered
by the Setup Wizard, but these are all that are needed in most cases. For special applications it will still
be necessary to open the Options window (Tools menu) and enter additional settings there.
The Setup Wizard starts automatically when Airmail is started for the first time, or can be opened from the
Tools menu, Setup Wizard. The Setup Wizard can be canceled at any time prior to completion, in which
case the settings will not be stored. Note that if settings have been "tweaked" with the Options window,
then re-running the Setup Wizard may reset those "tweaks" back to the default values.
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Setting Audio Levels- Icom Marine transceivers
This page desribes how to set the audio levels for PTC-II-family modems and Icom Marine transeivers
(M710, M700pro, M802).
The modem's audio level setting is basically a "volume control" and determines the radio's power output.
If it is set too low, then transmit power will be low and connections will be slower and more difficult. If set
to high, then distortion can result, causing slow connections and interference. Fortunatley
Using radio's "REMOTE" connection:
This applies to any system using the M710, M700pro or M802's 9-pin "REMOTE" connection, either via a
PTC-IIpro or direct to a COM port:
Open Airmail's terminal window, Control menu, "Set PTC amplitudes". This opens the audio-level toolbox.
Select a frequency in the 10-MHz range (or 12 MHz for Sailmail users), and listen carefully to be sure that
the frequency is not in use. (The station can be on the other side of the world, we are not trying to
connect- only avoid interference). Then click the "Auto Set" button, and wait 10-15 seconds while Airmail
sets the levels.
If the "Auto Set" button is not available, then your remote-control connection is not wired for 2-way
communication and Airmail cannot read the radio's power-meter.
Without remote control, or using "clone" jack:
This applies to any system without remote-control, or remote-control wired to the M710/700pro's "clone"
jack:
The Auto-set mode is not available. Open Airmail's terminal window, Control menu, "Set PTC
amplitudes". This opens the audio-level toolbox. Select a frequency in the 10-MHz range (or 12 MHz for
Sailmail users), and listen carefully to be sure that the frequency is not in use. (The station can be on the
other side of the world, we are not trying to connect- only avoid interference). Click the "Xmit" button to
the right of the "FSK Amplitude" setting, and check the radio's bar-graph display. Adjust the slider for the
FSK Amplitude adjustment left until fewer than 7 bars (5 bars for the M802) are indicated on the radio
display, then slowly increase the adjustment (using the left/right arrow buttons, or the left-right arrow keys
on the keyboard) until the 7th bar is on (5th for the M802), and the 8th bar just flickers (6th bar for M802).
This is about 80 watts. (For the M802 the correct settings are 5 bars on, 6th just flickering). Click the
"Stop button. Verify that the "PSK Amplitude" is set about 30% higher than the FSK setting (the
adjustments track).
Verifying audio levels:
The optimum levels are 75-85 watts in FSK mode, and 130-140 watts peak in PSK mode. The best way
to verify the correct setting is with a RF power/SWR meter, if one is available. Alternately a good test is to
use a battery monitor, and check the increase in DC amps when transmitting. First measure the DC amps
being used from the battery when the radio is receiving, then click the FSK "XMIT" button and check the
increase above the value when receiving, the increase should be around 15 amps for 80 watts output
power.
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Connecting a PTC-II* modem to an Icom M802 Marine Transceiver
This page covers connecting the SCS PTC-II-family modem to an Icom M802 marine transceiver. The
audio connections are the same as the M710, the radio-control connection is different.
Audio connections:
PTC-II* Audio
Icom M802 "ACC"
(8-pin SCS DIN) »Page 77
(8-pin Icom DIN) »Page 78
-------------------------------(Tx audio) Pin 1----(vio)-----Pin 4 (Mod)
(Rx audio) Pin 4----(grn)-----Pin 5 (AF out)
(PTT)
Pin 3----(yel)-----Pin 3 (PTT in)
(Gnd)
Pin 2----(wht)-----Pin 2 (ground)
(+12V)
Pin 5----(blu)-----Pin 7 (12V out- see note)
Shell---(shield)---Shell
Notes:
1. The colors shown above are for the pigtail cable supplied with the PTC-IIpro. Check the colors with
an ohmmeter, errors are possible.
2. The German-style DIN connector has a different physical pin geometry, and is not interchaneable
with the US-style DIN connector used by Icom. Label the cable ends to avoid any confusion over
which end goes where.
3. The PTC-IIpro has provision for an alternate 12V input on its HF audio connector. This provides a
convenient way to connect power to the modem, but if the cable is particularly long then this could be
a source of RF interference. Consider a separate power connection for long cables.
Remote Control
PTC-IIpro: Remote frequency-control is optional, but highly recommended when a PTC-IIpro modem is
used with an Icom M802 transceiver. This connection uses the PTC-IIpro's RS232 remote connection to
the radio's "REMOTE" jack (a standard RS232 connection).
PTC-IIpro "Control"
(13-pin DIN) »Page 77
----------Pin 2 (wht) ----------Pin 3 (yel) ----------Pin 4 (grn) ----------Pin 8 (red) ----------Pin 13 (org) ---------Shell (shield) --------

ICOM M802 "Remote"
(DB-9 9-pin male)
-------------pin 7 (RTS)
pin 3 (TxD)
pin 8 (CTS)
pin 2 (RxD)
pin 5 (Ground)
Shell

Note: The "RTS" and "CTS" signals are not currently used by the M802, but it is recommended that they
be connected so that they are available if this cable is used for other applications in the future.
Direct COM-port connection:
The M-802's "REMOTE" connector is a standard 9-pin serial connector which can be directly
connected to a computer serial port with a standard 9-pin male/female serial extension cable. See
Adding Serial Ports »Page 76.
Radio Settings:
The M802 is shipped with "auto-tuner" set to "off" by default. To enable the auto-tuner, turn the radio
off, then hold down the "Mode" button and push the "power" button to turn the radio on. The display
will say *** SET MODE *** across the top. Then rotate the left knob until "AUTO TUNE" is displayed,
and use the right knob to select "ON".
NOTE: Some early M-802's had a problem with the auto-tune mode failing to tune properly. The
symptom was that the "Tune" indicator flashed and then went off, rather than staying on steadily. The
radio's "SWR" indicator would also flash while transmitting. This is now corrected, and radios which
exhibit this problem can be returned to an Icom dealer for updating.
AirMail Options Settings:
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Modem (TNC) connection:
Modem type: PTC-IIpro (or select appropriate model)
Comm port: COM1 or as appropriate
Baud rate: 38400 or 57600
Show link messages: no check
Audio Tones:
Center Frequency: 1500
Check "USB"
Amplitudes: as appropriate, start with 250/330 (see Setting Audio Levels »Page 118)
Radio connection:
Check "Direct using PTC-II control port" (or "Direct via COM port")
RS-232: Checked (for PTC-IIpro only, important!)
Radio type: "Icom-M802"
Baud: 4800
Icom Addr (hex): 08 (must match radio's REMT-ID setting)
Dial offset: 00
Upgrading to Pactor-3
This page describes how to upgrade your modem to use Pactor-3 (P3) mode with Airmail.
If you wish to upgrade, then the steps are to upgrade your modem firmware (if needed) to version 3.3c or
later, and then try it out using the 20 "free" trial P-3 connects. Then purchase a P3 license-code from your
PTC modem dealer or SCS. Starting with firmware ver 3.3, there is no longer a any difference between
"Pactor-3" and "normal" firmware. There is only one version, it is called "professional" firmware, and with
a license it can operate in P3 mode, without a license it can operates in P2 mode. The only caution is to
not use the new firmware with older versions of Airmail, as you will get warning-messages which no
longer apply.
To update the firmware if needed, start Airmail and then select Tools menu, "Update PTC firmware". The
"profi33c" file (or later) should already be listed in the "Update file" box, click "Update" to start the
firmware update. (The firmware can be downloaded from the Airmail website - www.airmail2000.com - or
from the SCS website. If it is stored in the Airmail folder then Airmail will find it.
Next, get a license-code to enable P3. We recommend obtaining the license from the dealer you bought
the modem from, as they will also be able to provide support and handle the firmware installation if
desired. Alternately, Sailmail members may contact Sailmail tech-support (support@sailmail.com).
Licenses can also be obtained from Farallon Electronics (garywood@farallon.us) or from the SCS
website (http://www.scs-ptc.com/registration.html). The license cost is $150.
You will need to know whether your modem has an "electronic serial number" or not. If you have a PTC-II,
or a pre-2002 PTC-IIe, then it will not have an electronic serial# and you need a license code which is
keyed to your callsign(s). All IIpro's, IIex's, and recent IIe's have an electronic serial#- check for a barcode label on the bottom. No bar-code, no electronic serial# (although an electronic serial# chip can be
fitted by some dealers or repair-centers).
The license-code will usually come in an email. The simplest thing is to have it sent to your Winlink or
Sailmail address, Airmail will then recognize the license and store it automatically (there will be a
message-box to that effect) and there is nothing else to do.
Check your P3 license-code by opening the Tools/Options window, connection tab, and click the
"Advanced settings" button- if Airmail received the license-code then it will be in the box at the bottom,
otherwise enter it there (you can "paste" it in by clicking the right mouse button).
Options changes: We recommend changing your Airmail options settings to use USB mode and centertone of 1500 hz (Tools/Options/connection). This is automatically selected for P3 mode, but we
recommend changing the default setting for all modes to avoid confusion. On the same page, we also
recommend UN-checking the "show link messages" box, to avoid terminal-window clutter. Click OK to
save settings and close the Options window.
Then open terminal window, and check the "red" messages- Airmail should display "license OK". At that
point you are set! Airmail selects P3 mode automatically whenever you select a station supporting P3
(check the Modes menu). If you set your radio-freq manually, be sure to use USB mode, and subtract 1.5
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khz from the station freq for all P3 channels (and for all channels, if you changed the Airmail settings as
recommended above). This means you will need to change any station frequencies you already have
programmed into you radio‟s memories (or better yet, use Airmail's remote-control to set the radio
frequency). Remember that P3 ALWAYS uses a 1500hz center-freq, and 1.5khz freq-offset, no narrow
filter.
See Pactor-3 specifications »Page 122 for technical information.

Introduction to Pactor-3
First, what is Pactor-3 (P3)? It is a new mode for SCS PTC-II modems, not a new modem. Any PTC-IIe,
IIex, IIpro and nearly all PTC-II modems can be upgraded for a $150 fee (paid to a PTC modem dealer or
directly to SCS, not Sailmail). Winlink stations now support Pactor-3 on some frequencies where
wideband operation is allowed. Sailmail is now supporting P3 mode for all stations, all frequencies.
Who should upgrade? No one needs to, but if you do a lot of email, or want to be able to do more, then it
is certainly worthwhile. The speed advantage is 2-4x with good signals, but even with very weak signals
P3 appears to do a better job. The upgrade procedure is not difficult, and the new SCS firmware makes it
simpler.
Do we recommend it? Yes, the only qualification being cost. Prior to SCS version 3.3 firmware, there
were also technical issues, in that a modem with Pactor-3 firmware would not work at all without a proper
P3 license. That issue is thankfully all behind us now thanks to the efforts of the SCS designers, and
version 3.3. firmware works smoothly in either Pactor-3 mode (with a license) or Pactor-2 mode (without).
The only caveat is to also update Airmail to version 3.1.921 or later, to avoid warning messages which no
longer apply.
There are two kinds of SCS license-codes: Newer modems (including all IIpro, IIex and 2002-model IIe
modems) have electronic serial numbers (check for a bar-code serial# label on the bottom). For these
modems, a serial# license-code is required, which then becomes a permanent license for that physical
modem (even if resold), and there should never be a license-code problem.
Older modems, including all PTC-II's and earlier IIe's without a bar-code label, are licensed to particular
callsigns (up to 3 max). In this case, the license-code is only valid, and the firmware only works in P3
mode, for the licensed callsigns. If a callsign changes then you can still use P2 mode, and get a revised
license-code from SCS (contact Martin dl1zam@scs-ptc.com).
An earlier modem can optionally be fitted with a "serial#" chip, which allows the use of a "permanent"
serial# license and avoids any problem with callsigns. The cost to install the "serial# chip" is $100 (in
addition to the upgrade charge) and is only done by SCS major distributors (e.g. Farallon Electronics in
California, Marc Robinson in Australia).
See Upgrading to Pactor-3 »Page 120 for a detailed procedure to upgrade your modem firmware to
support P3.
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PACTOR-III link layer specification
(C) 2002

SCS GmbH & Co. KG, Hanau, Germany

SL

= "Speedlevel", sub protocol level - adaptation fully automatic.

NT

= Number of tones (sub carriers) used on actual "Speedlevel".

PDR = Physical data rate, raw bit rate (Bit/sec) transferred on the physical
protocol layer.
NDR = Net user data rate (without data compression) (Bit/sec). If PMC
(automatic online data compression) is activated, multiply with factor 1.9 in
case of text files.
CFR = Envelope power ratio, peak / average power (dB). If CFR is 3 dB, a 100
W SSB transmitter generates 50 W mean output power without signal clipping or
limitting.
SNR = Required signal to noise ratio.
SL
NT
PDR
NDR
CFR
SNR
----------------------------------------------0
2
200
76.8
2.7
*)
1
6
600
247.5
2.8
*)
2
14
1400
588.8
3.4
*)
3
14
2800
1186.1
3.6
*)
4
16
3200
2039.5
4.1
*)
5
18
3600
2722.1
4.4
*)
*) Depends on channel model. Measurements on the Ionospheric Simulator will
follow. On an average channel, PACTOR-III is around 3.5 times faster than
PACTOR-II. On good channels, the effective throughput ratio between PACTORIII and PACTOR-II can exceed 5. PACTOR-III achieves slightly higher
robustness on the low SNR edge compared to PACTOR-II.
Maximum occupied bandwidth: 2.4 kHz @ -40 dB, audio passband: 300-2700 Hz.
Maximum net throughput with online data compression: ca. 5200 Bit/sec.
Note that the online data compression provided by the PTC modems is
especially useful for applications which do not allow offline (file)
compression, e.g. email via TCP/IP, etc. The PTC-II is the only HF modem on
the market which offers efficient online data compression.

PTC-IIpro to RS-232 connections
This page shows the wiring for a handy cable, to provide a connection between the PTC-IIpro's "Control"
port and a standard 9-pin serial-interface connector. This cable has the same connections as a standard
9-pin computer serial port.
PTC-IIpro "Control"
(13-pin DIN) »Page 77
----------Pin 2 (wht) ----------Pin 3 (yel) ----------Pin 4 (grn) ----------Pin 8 (red) ----------Pin 13 (org) ---------Shell (shield) -------Notes

ICOM M802 "Remote"
(DB-9 9-pin male)
-------------pin 7 (RTS)
pin 3 (TxD)
pin 8 (CTS)
pin 2 (RxD)
pin 5 (Ground)
Shell
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The 13-pin DIN connector has small pins and is hard to solder, the best approach is to start with the SCS
pigtail with the 13-pin DIN pre-wired, and add a 9-pin male connector to the other end. The colors shown
are for the SCS pigtail cable, but should be checked as errors can occur.
The "RTS" and "CTS" signals are not used by some radios, but it is recommended that they be connected
so that they are available if this cable is used for other applications in the future.
Likewise, some radios (e.g. Kenwood) want a female connector on the RS232 cable, which is the
opposite of the usual convention of female at the computer end, male at the device end. It is
recommended that the PTC-IIpro/RS232 adaptor cable still be made up with a male connector as
indicated above, and a double-female adaptor be used at the radio end. This will allow the cable to be
used for a "normal" RS-232 application in the future.
In Airmail options settings, be sure to select "PTC-IIpro" and check the "RS232" box..
The MAROB Voluntary Marine Observation Program
Adapted from information supplied by Tim Rulon of the NWS (email: timothy.rulon@noaa.gov).
All Information with Respect to the MAROB Program is Preliminary and Subject to Revision
What is the MAROB Program?
The MAROB Program is an experimental voluntary marine observation program of the National Weather
Service in the early stages of development. It seeks the participation of all mariners, both commercial and
recreational, which are not part of the more in-depth Voluntary Observing Ship (VOS) program. It is the
goal of the program to collect as many marine observations as practicable, to improve the accuracy of
coastal, offshore and high seas forecasts, by taking advantage of technological advancements in marine
communications and the proliferation of the Internet.
Who May Participate in the MAROB Program?
Any mariner is welcome to participate in the MAROB program. However, we ask that commercial vessels,
which are routinely underway, consider participating in the international Voluntary Observing Ship (VOS)
program, see www.vos.noaa.gov or call 1-228-688-1457 for information.
I Have Some Concern about Piracy or my Competition
If you have some concern about piracy or your competition (e.g. while racing or fishing) you should likely
not participate in a voluntary vessel position or weather reporting system such as MAROB where your
position is widely disseminated and may become known to others. Where some degree anonymity is
desired, use the identity "SHIP" in your report. Never enter a report with a false position
What Training is Required to Participate in MAROB?
At present, no training is required to participate in the MAROB Program. However, many local National
Weather Service Forecast Offices conduct training for mariners and we encourage you to contact them to
learn of available training sessions.
How May I Contact My Local Forecast Office?
Telephone numbers for local forecast offices may often be found in the telephone directory white/blue
pages under "United States Government"; "Commerce Department"; "National Weather Service". Or see
www.nws.noaa.gov/organization.html for links to webpages containing phone numbers and/or e-mail
addresses.
Do I Need to Register in Advance to Participate in MAROB?
At present, no advance registration is required to participate in the MAROB program however, individual
MAROB reporting schemes may have registration requirements.
What is the Required Accuracy of MAROB Observations?
There are not yet any required standards of accuracy for the MAROB program.
From What Areas Should MAROBs Be Sent?
In order to be of value to forecasters, MAROB observations should be sent from vessels in the
unprotected waters of the high seas, offshore, and coastal areas, including waters of the Great Lakes and
large, open, bodies of water such Long Island Sound, Chesapeake Bay and Biscayne Bay. Observations
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should not be sent from areas such as harbors and inlets where the observed conditions are not
representative of the surrounding open waters.
How Often and When Should Observations be Sent?
Weather forecasts are generated on a 6-hour cycle using observations collected at 0, 6, 12, and 18 UTC.
These times are referred to as the synoptic observation times. Observations collected at these times are
of most value to forecasters, with those collected at the intermediate synoptic times of 3, 9, 15 and 21
UTC and other times to be of somewhat lesser value.
Observations should be taken on or immediately after the hour and forwarded to the National Weather
Service as soon as practicable, preferably within 1 hour of the observation time. The value of
observations begins to diminish rapidly after about 3 hours; however, all observations may be used for
climatological research.
Due to the limited number of observation systems in marine areas, each and every voluntary marine
observation is of great value to forecasters. Never hesitate to forward an observation.
In the event of inclement weather, and/or where the observed conditions differ significantly from the
forecast conditions, forward observations immediately and at intervals not exceeding 3 hours if
practicable. NEVER place your vessel in potential danger for the purpose of collecting weather
observations.
Who Pays For Any Equipment Costs and Telecommunication Charges?
Mariners voluntarily participate in the MAROB program and any communications charges, the cost of any
observing equipment, or incidental expenses, will not be reimbursed by the National Weather Service.
Why Does the MAROB Program Use the Data Format of the VOS Program?
The MAROB format is identical to that of the VOS program with the exception that “MAROB” replaces
“BBXX”. This format was selected as a great deal of infrastructure is already in place within the National
Weather Service to decode and utilize observations. However, this format has the disadvantage that the
resolution of several data elements is more suitable to the high seas than coastal areas. In the long term,
a unique format may be developed for MAROBs.
Why Don’t MAROB Reporting Schemes Collect More Observation Parameters?
Although MAROBs may contain any of the observation elements of the VOS format, in general, MAROB
reporting schemes will implement a small subset of those available in order to encourage a greater
number of mariners to participate in the program by not presenting a seemingly complex report form. The
subset of observations collected may vary between reporting schemes.
How May I Send a MAROB?
The National Weather Service is in the process of developing cooperative arrangements with a
variety of organizations including the WinLink 2000 Global Radio Network, Sailmail, and the
YOTREPs Reporting System, to both train observers and forward observations to NWS.
Technologies utilized may include cellular telephone, HF Marine radio, MF Marine radio, VHF Marine
Radio, Ham Radio, Webforms and e-mail.
In several cases, MAROB reporting schemes will work in conjunction with vessel position reporting
systems such as WinLink's Position Reporter, the Maritime Mobile Service Network's ShipTrak, and the
YOTREPs Reporter, to enhance the safety of mariners.
At present, mariners may participate in the MAROB program in any of several ways:
1. By sending in YOTREPs via WINLINK (www.winlink.org) or SAILMAIL (www.sailmail.com)
using their AIRMAIL software.
2. By sending in YOTREPs (pronounced Yacht Reps) using Pangolin‟s Offshore Reporter software. see
www.pangolin.co.nz This function may be performed directly aboard the vessel or the observation data
forwarded to a volunteer ashore. YOTREPs are converted to the MAROB format and forwarded to the
National Weather Service by Pangolin Software. See instructions below.
3. By entering the observed data into Pangolin‟s freeware program PANMAROB.exe and sending the
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encoded data to the National Weather Service via e-mail. See:
http://www.nws.noaa.gov/om/marine/panmarobhelp.pdf This function may be performed directly
aboard the vessel or the observation data forwarded to a volunteer ashore.
4. By sending in YOTREPS via e-mail in the WINLINK/AIRMAIL format style See:
http://www.nws.noaa.gov/om/marine/panemailhelp.pdf This function may be performed directly
aboard the vessel or the observation data forwarded to a volunteer ashore. YOTREPs are converted to
the MAROB format and forwarded to the National Weather Service by Pangolin Software, see
www.pangolin.co.nz
5. For the real “power user”, by entering the observation data into the AMVER/SEAS software (see
http://www.vos.noaa.gov/) of the Voluntary Observing Ship (VOS) program and sending the encoded data
to the National Weather Service via e-mail. This option is only recommended for those familiar with the
VOS program. Save the observation data using the Transmit/Save ASCII function to the met.txt file, and
copy/paste the applicable data into an e-mail of a format described in the procedure for sending MAROBs
via PANMAROB.exe above. This function may be performed directly aboard the vessel or the observation
data forwarded to a volunteer ashore.
6. By manually encoding the observation data following the guidance of the NWS Observing Handbook
No 1 (www.nws.noaa.gov/om/marine/handbk1.pdf), and sending the encoded data to the National
Weather Service via e-mail in the format described in the procedure for sending MAROBs using
PANMAROB.exe above. This option is only recommended for those familiar with the VOS program. This
function may be performed directly aboard the vessel or the observation data forwarded to a volunteer
ashore.
7. Using WINLINK‟s QTH Reporter restricted webpage which is intended for the net control operators of
large maritime mobile ham nets. Send an e-mail to marine.weather@noaa.gov for further information.
See: http://www.nws.noaa.gov/om/marine/qthrephelp.pdf
Note: Any reference to a commercial product or service does not imply any endorsement by the National
Weather Service as to function or suitability for your purpose or environment.
How Will I know if my MAROB Has Been Received by the National Weather Service?
Links to the last MAROBs received may be found at www.nws.noaa.gov/om/marine/forecast.htm#marob
An online database of recently received MAROBs may be established in the future.
Using the YOTREP Offshore Reporter software, YOTREPs may be retrieved from the YOTREP server
and plotted with other YOTREPs using the “Get Reports” and mapping functions of the program. See
program documentation for details.
Using the PAMAROB freeware, an e-mail will be sent to the mariner if an observation has passed initial
format checks. This feature may be removed at a later time based on user feedback. No e-mail will be
returned if the observation contains any format errors.
Where Can I Learn More About the National Weather Service Marine Products and Services?
Visit webpage www.nws.noaa.gov/om/marine/home.htm
Is There an Awards Program Established for Participants In the MAROB Program?
It is a long-range goal of the MAROB program to establish an awards program to recognize the voluntary
efforts of mariners who actively participate in the program.
How Can I Have Any Questions Answered About the MAROB Program?
Due to the volume of inquiries we receive, the preferred means of communication is via e-mail at:
marine.weather@noaa.gov If you feel you cannot adequately state your question in an e-mail, we may
be reached via telephone at: 1-301-713-1677 x128
To find the latest information on the MAROB program, see www.nws.noaa.gov/om/marine/marob.htm As
this program is in its early stages of development, changes may be frequent. Any feedback on the
MAROB Program would also be greatly appreciated.
Using Airmail's remote-control feature requires a second serial port in either case (or a PTC-IIpro modem
with a radio-control port, but that's not the case here). The PTC-IIe configuration requires one serial port
to talk to the modem, and a second serial port to talk to the radio. This additional serial port can be an
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(additional) USB/serial adaptor, OR it can be a multi-port USB/serial box (or some other serial port). We
recommend Keyspan single-port adaptors or Edgeport multi-port boxes, most others will work but those
are the ones we have consistent good luck with.
I assume your Quatech adaptor is a PCMCIA card? It will probably work OK, Quatech had driver
problems for a while but that has to be fixed by now. Just make sure you have the correct drivers for WinXP or whichever version of Windows you have. And test it first, by trying each port in turn connected to
the modem (there is lots of "chatter" between the PTC-II and Airmail even when it is idle, and serial-port
problems will show up pretty quick- just leave terminal-window open for a few minutes. A "Init failed" or
"Communications lost" message means the port is not working.
The PTC-IIe modem connects to the first computer serial-port, just like always. No change here.
Since you already have (or had) a connection from the PTC-IIe to the radio's P3 terminal strip, my
suggestion would be to stick with that. So the first computer serial-port goes to the modem, and the
modem goes to the radio's P3 term-strip just like you documented it in your note. (Repeated here for
clarity, this is going to become a new Airmail help page).
Audio connections to radio's "P3" terminal-strip:
PTC-IIpro "Audio"
SEA-235 "P3 Accessory Conn"
(8-pin SCS DIN)
(12-pos terminal strip)
------------------------------------(Tx audio) Pin 1----(vio)-----term-12 (TXAF)
(Rx audio) Pin 4----(grn)-----term-11 (LLAF)
(PTT)
Pin 3----(yel)-----term 2 (PTT)
(Gnd)
Pin 2----(wht)-----term 1 (GND-AF)
(+12V)
Pin 5----(blu)-----term-8 (13.6S)
Shell---(shield)---term-7 (GND)
(Note: the AF and SPKR terminals are jumpered to operate the internal
speaker).
Notes: Colors shown are for the SCS pigtail cable, and may differ - Always check!
When utilizing the "P3" terminal-strip for audio connections, the radio's internal switches should all be in
the "OFF" state (see manual).
Remote control: Remote frequency control is recommended and requires an RS-232 connection from
the PTC-IIpro to the radio's "P2 S-232" connector. The recommended configuration is to wire the
modem's "Audio" and "Control" connections together to the radio's "P2 RS-232" connector, using a
specially-wired "Y" cable (below).
Combined audio and remote-control "Y" cable:
PTC-IIpro "Audio"
SEA-235 "P2 RS-232" connector
(8-pin SCS DIN male)
(9-pin DB-9 male)
------------------------------------(Tx audio) Pin 1----(vio)-----Pin 7 (audio-in/TXAF)
(Rx audio) Pin 4----(grn)-----Pin 6 (audio-out/LLAF)
(PTT)
Pin 3----(yel)-----Pin 4 (PTT in)
(Gnd)
Pin 2----(wht)-----Pin 9 (Ground)
(+12V)
Pin 5----(blu)-----Pin 8 (12V out- see note)
Shell---(shield)---Shell
...
PTC-IIpro "Control"
... ("P2" continued) ...
(13-pin DIN male)
...
-------------...
(RxD in) Pin 8----(red)-----Pin 2 (RxD out)
(TxD out) Pin 3----(yel)-----Pin 3 (TxD in)
(Gnd)
Pin 13---(org)-----Pin 5 (Ground)
Shell---(shield)---Shell
Notes: Colors shown are for the SCS pigtail cables, and may differ - Always check!
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To utilize the radio's "P2 RS-232" connector for audio connections, the radio's internal switches must all
be in the "ON" state (see manual).
Alternately the audio connection can be wired to the "P3" terminal-strip using a SCS pigtail cable (see
above), and the modem's Control connection can be connected to the radio's "P2 RS-232" connector with
a PTC-IIpro RS-232 control cable (see PTC-IIpro connections »Page 93, "RS-232").
Airmail Options Settings (the following assumes Pactor-3 is used):
Modem (TNC) connection:
Modem type: PTC-IIpro
Comm port: COM1 or as appropriate
Baud rate: 38400 or 57600
Show link messages: no check
Audio Tones:
Center Frequency: 1500, select "USB" mode
Amplitudes: as appropriate, start with 100/130 an increase as needed
Radio connection:
Check "Direct using PTC-II control port"
Check the "PTC-IIpro RS232" box
Radio type: SEA-235
Baud: 9600
VFO: not used
Dial offset: 00
Important: See the SEA-235 transceiver »Page 128 page for important notes regarding regarding the
microphone input in Telex and USB modes.
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SEA-235 Marine Transceiver (general notes)
The SEA-235 can be used for Pactor, but it is not a heavy-duty radio and without the optional fan kit has a
very limited continuous output power rating of about 40 watts, depending on termperature. The cost of the
fan kit is modest and it is highly recommended. With the fan kit, continuous average power is still limited
to about 75 watts depending on termperate but it will do very nicely with Pactor-2 or 3 as the average
power for these modes is about half the peak power.
There are two different ways to connect the audio connections from a modem: either using the "P3"
terminal strip, or using the "P2 RS-232" 9-pin connector. (Do NOT attempt to use the "SEABUS"
connector). The advantage of the "P3" terminal strip is that no soldering is needed. The 9-pin "P2 RS232" connector serves both as a standard RS-232 input on pins 2, 3 and 5 which can be connected
directly to a computer, and as an optional audio connection using pings 4, 6, 7, 8, and 9. Switches are
provided inside the radio to connect the audio signals from this connector to the corresponding
connections on the "P2" terminal strip. If "P3 RS-232" is used for the audio connections (with a specially
wired cable) then these switches must all be in the "ON" position. If the "P3" terminal strip is used for the
modem's audio connections, then these switches must be in the "OFF" position.
Remote control: Remote frequency control is recommended and is connected to the 9-pin "P2 RS-232"
connector, either shared with the audio connections with a specailly-wired cable, or using a standard RS232 cable.
Internal switches: The SEA-235 has internal "DIP" switches to disconnect the audio connections from
the "P2 RS-232" connector when this connector is not being used for the modem's audio connections.
This is required to avoid short-circuits when a standard RS232 cable is used, which may wire those pins
to other signals. If the "P2 RS-232" connector is used for audio connections (in addition to remote-control)
then the internal switches must be set to the "ON" position. if the modem's audio connections are wired
to the "P2" terminal strip then thei internal switches must be set to the "OFF" position.
Remote-head models: Models of the SEA-235 with a remote control-head will not have the internal
jumper-cable which allows the "P3" terminal-strip to be used for the modem's audio connections. In this
case the "P2 RS-232" connector and a specially-wired cable must be used.
Recommended cables:
PTC-IIpro modems: Use a specially-wired "Y" cable to connect the radio's "P2 RS-232" connector to
both the modem's "Audio" and "Control" connectors. Alternatley, a separate audio cables to the "P3"
terminal-strip and control cable to the "P2 RS-232" connector can be used. See PTC-IIpro to SEA-235
»Page 125 for more details.
PTC-IIe/ex modems: The modem's audio connection can be wired the "P3" terminal strip using the SCS
pigtail cable. Alternately the modem's audio connection can be wired to the "P2 RS-232" connector in
conjunction with the RS-232 remote-control cable using a specially-wired "Y" cable. Remote control
requires an additional computer COM-port and is connected to the radio's "P2 RS-232" connector. See
PTC-IIe/ex to SEA-235 »Page 129 for connection details.
PTC-II modems: The PTC-II modem has a remote-control port, however it does not include the PTCIIpro's RS-232 voltage levels. The two options are to use the SCS level-shifter module or to not use the
modem's control-port and use an additional computer COM-port instead. See PTC-II to SEA-235 »Page
62 for connection details.
Pactor-1 modems: Not recommended, because of the slower speed and higher average power levels
compared to Pactor-2 and 3 modes. If used, use the same general configuration as the PTC-IIe/ex,
above.
Caution -- Output power: The SEA-235 is not capable of continuous full-power output. With a fan-kit
approxamatly 50% average power can be used continuously (depending on ambient tempeature), this is
adequate for Pactor-2 and 3. Without a fan kit, power must be reduced. The modem‟s audio output levels
must be carefully adjusted to keep the average power at a reasonable level. The proper way to set the
audio levels is with a RF wattmeter, but a DC ammeter that measures the radio‟s power consumption can
be used in a pinch. See "Audio levels" for more information.
Important Note regarding microphone input: The SEA-235 has the odd characteristic that the rearpanel modem connection is only enabled in "Telex" (J2B) mode, and the microphone is only enabled in
"USB" mode. Pactor-2 can use teh radio's telex mode but to use Pactor-3, USB mode must be used. The
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radio menu is used to select the rear-panel connector in USB mode (and must be switched back to Mic
when finished, otherwise the radio will not work in voice mode). If only Pactor-2 is used, then Telex mode
can be used (set the audio center-freq to 1700 hz, select AFSK mode, and check "Marine radio").
If remote-control is used (and it is strongly recommended for this radio), then Airmail handles switching
USB mode from Mic to modem and back. However it is essential that you know how to switch USB
mode back to "Mic" input (e.g. if the computer is inadvertantly shut down before Airmail closes and
switches back to the microphone). See "Changing the SSB audio input source" in the operator's manual,
page 42 in the "rev-2" version).
Failure to understand this can leave the radio's microphone input disabled when it is needed!

PTC-IIe/ex to SEA-235 connections
For the PTC-IIe and PTC-IIex modems, the audio cable from the modem can either be connected to the
rear-panel "P3" terminal strip, or to the 9-pin "P2 RS-232" connector. The first is generally simpler (no
soldering is required) and is recommended. The exception is that some models of the SEA-235 with a
remote control-head will not have audio connections available on the "P3" terminal-strip, and the P2
wiring must be used. .
The audio connections to the radio's "P3" terminal-strip are as follows:
PTC-II Audio
SEA-235 "P3 Accessory Conn"
(8-pin SCS DIN)
(12-pos terminal strip)
------------------------------------(Tx audio) Pin 1----(vio)-----term-12 (TXAF)
(Rx audio) Pin 4----(grn)-----term-11 (LLAF)
(PTT)
Pin 3----(yel)-----term-2 (PTT)
(Gnd)
Pin 2----(wht)-----term-1 (GND-AF)
(+12V)
Pin 5----(blu)-----term-8 (13.6S)
Shell---(shield)---term-7 (GND)
(Note: the AF and SPKR terminals are jumpered to operate the internal
speaker).
Notes: Colors shown are for the SCS pigtail cable, and may differ - Always check!
When utilizing the "P3" terminal-strip for audio connections, the radio's internal switches should all be in
the "OFF" state (see manual).
The audio connectios to the radio's "P2 RS-232" connector are as follows:
PTC-II Audio
SEA-235 "P2" connector
(8-pin SCS DIN) »Page 77
(9-pin DB-9- see note)
-------------------------------(Tx audio) Pin 1----(vio)-----Pin 7 (audio-in)
(Rx audio) Pin 4----(grn)-----Pin 6 (audio-out)
(PTT)
Pin 3----(yel)-----Pin 4 (PTT in)
(Gnd)
Pin 2----(wht)-----Pin 9 (ground)
(+12V)
Pin 5----(blu)-----Pin 8 (+12V out)
Shell---(shield)---Shell
Notes: Colors shown are for the SCS pigtail cables, and may differ - Always check!
To utilize the radio's "P2 RS-232" connector for audio connections, the radio's internal switches must all
be in the "ON" state (see manual).
Remote control: Remote frequency control is recommended and requires an RS-232 connection from a
second computer serial-port to the radio's "P2 S-232" connector. If the audio connections are wired to the
"P3" terminal-strip then use a standard RS-232 "serial extension" cable can connect to "P2 RS-232"
connector, alternately a specially-wired Y-cable is required (below). Note that two computer serial COMports are required, one for the modem and one for remote control. See Adding Computer Serial Ports
»Page 76 for more information.
Combined audio and remote-control "Y" cable:
PTC-II Audio
(8-pin SCS DIN)

SEA-235 "P2" connector
(9-pin DB-9 male)
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------------------------------------(Tx audio) Pin 1----(vio)-----Pin 7 (audio-in/TXAF)
(Rx audio) Pin 4----(grn)-----Pin 6 (audio-out/LLAF)
(PTT)
Pin 3----(yel)-----Pin 4 (PTT in)
(Gnd)
Pin 2----(wht)-----Pin 9 (Ground)
(+12V)
Pin 5----(blu)-----Pin 8 (12V out- see note)
Shell---(shield)---Shell
...
Second PC serial port
("P2" continued) ...
(9-pin female)
...
-------------...
(RxD in) Pin 2--------------Pin 2 (RxD out)
(TxD out) Pin 3--------------Pin 3 (TxD in)
(Gnd)
Pin 5--------------Pin 5 (Ground)
Shell---(shield)---Shell
Notes: Colors shown are for the SCS pigtail cable, and may differ - Always check!
To utilize the "P2 RS-232" connector for modem connections, the internal switches must all be in the
"ON" state (see manual).
Airmail Options Settings (the following assumes Pactor-3 is used):
Modem (TNC) connection:
Modem type: PTC-II
Comm port: COM1 or as appropriate
Baud rate: 38400 or 57600
Show link messages: no check
Audio Tones:
Center Frequency: 1500, select "USB" mode
Amplitudes: as appropriate, start with 100/130 an increase as needed
Radio connection:
Check "Direct via COM port"
Select the appropriate COM port
Radio type: SEA-235
Baud: 9600
VFO: not used
Dial offset: 00
Important: See the SEA-235 transceiver »Page 128 page for important notes regarding regarding the
microphone input in Telex and USB modes.
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Making a backup of Airmal files
Everything is contained in the C:\Program files\Airmail folder. So all you need to do use Windows
Explorer and make a copy of that folder elsewhere, e.g. My Documents/Backup. Settings are in Airmail.ini
and system.xxx.ini ("xxx" is "ham" or "Sailmail"), address book is addrbook.txt, messages are in various
sub-folders.
If you are not familiar with Windows Explorer do it like this:
First, start Win Explorer, open C-Drive, Program Files, Airmail (on the left).
Check that there is enough space: With the Airmail folder selected, select Files menu, Properties,
check the total size. Make sure there is plenty of room on the drive.
Then (with Airmail folder still selected), select Edit menu, Copy.
Then select "My Documents" (same explorer window, or a new one), make a new folder called
"Backup" or similar, then select Edit menu, Paste. Win-Explorer will then make a copy of all files and
sub-folders. Do not try to run Airmail from this new folder, but you can copy this back to the original
location.
You can also use Winzip (www.winzip.com) to make a compressed "archive" file as backup, or to copy
to a different computer. This file can then be restored to the original location on the same computer, or a
different one. Do not attempt to restore an Airmail installation to a different folder from that into which it
was originally installed.
To create a Winzip archive: With Winzip installed, right-click on the "Airmail" folder in Win Explorer,
select "Winzip" and then "Add to Airmail.zip". Winzip will create a file called Airmail.zip containing all files
and sub-folders and save it in the Program Files folder (same location as the original Airmail folder itself).
The archive file will be about half the space of the original. This file should be moved to the "My
Documents/Backup" folder or similar location, or saved to a CD-rom.
To restore a Winzip archive: To restore an Airmail installation from a Winzip archive, open the file and
Winzip will start, then click the "Extract" button (or Action/Extract menu). Make sure "All files" is selected,
and also "Use Folder names" (important!). if copying Airmail to a new computer, you will also want to run
the install program (at least "Disk #1") in order to install a needed library file into the Windows system
folder ("vcl50.bpl", stored in the Windows/System32 folder, or Windows/System for Widows 95-98-ME).
Important: Copying files to a CD-Rom and then back to a hard drive will generally change all of the files
to "Read-Only". (That is, after all, the nature of a CD-Rom). This means that Airmail will not be able to
write the files. An error message is usually displayed but very strange things can result.
To save files to a CD-Rom, either for backup or to copy to a new computer, use Winzip as described
above. When files are "extracted" (restored) from a Winzip archive, the original file status is also restored.

Winlink-2000 Attachments
Attachments can be delivered via any Winlink-2000 station, but must be enabled first. by default, WL2K
attachments are DISABLED. To enable attachments, open Airmail's Window menu, Winlink-2000,
Options message. Find the box titled "Attachment limit" and enter a suitable upper size-limit, for example
10000 for Pactor-2 users and 30000 for Pactor-3 users, then click "Send". This number is in bytes, with
no commas or other punctuation. Keep in mind your average connect speeds when choosing an
attachment limit. Winlink will always confirm an options message, check this when received.
To find out your current attachment-limit setting, open the Window/Winlink-2000/Options-message as
above, and click "Query only". This will send an empty options-message to Winlink which acts as a query,
and Winlink will confirm the current settings.
See Winlink-2000 Options message »Page 86 for more WL2K options settings.
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Airmail Catalog Window
Airmail's "Catalog" window can be used to request weather bulletins and other documents from the
Winlink-2000 system for hams, and also from the Saildocs server operated by the Sailmail association but
also accessible via email by Winlink uers. The Airmail catalog is found under the Window menu, Catalog
selection. The catalog window is divided into two panels- on the left is a "tree" showing various folders,
similar to Airmail's message-index tree or Windows Explorer. These folders represent categories of
documents which can be requested.
The catalog entries are organized first into sections for "WL2K" and "Saildocs". Clicking the little "+" will
expand a selection, clicking a "-" will collapse it (just like Windows Explorer). The right and left-arrow keys
can also be used to expand and collapse folders.
Under "WL2K" are a folder for "global" bulletins, plus a folder for each station which has been seen,
containing that stations local bulletins as well as the "update" listings. Under the "global" folder are folders
for each bulletin category, click on these (or use the arrow keys) to open that folder and show the
contents in the list on the right side. Bulletins or documents are requested by checking the corresponding
check-box, see Winlink-2000 Bulletins »Page 84 for more information.
Under "Saildocs" is a series of category-folders. The "Grib files" category is a special folder which brings
up a grib-request window with a world map for requesting grib weather-data files. See "Grib Weather Files
»Page 132" for more information on requesting grib data. Saildocs also includes a large number of text
weather-bulletin documents which can be requested. These are organized into folders under "Saildocs"
for the different ocean regions. Some areas have sub-folders to further divide the selection for easy
browsing. Also, many bulletins are listed under more than one heading, for example Atlantic hurricane
bulletins are listed under both "Atlantic" and "Tropical". See "Saildocs Catalog »Page 133" for more
information on requesting documents from Saildocs.

Grib Weather-data Files
Grib files are "GRIdded Binary" weather data files. Grib files typically include wind and surface-pressure
information and are created by the various weather-forecast computer models. This is generally "raw
data" which is used by forecasters in the generation of bulletins and charts. So grib data is not a
substitute for available forecast bulletins and charts which are generated by professional meteorologists.
However, what is of great interest to sailors is that grib data is available with greater details and over
larger areas than any other forecast source. So as a supplemental to the weather decision-making
process it can be valuable, but it must be kept in mind that this is computer-generated data subject to all
of the problems common to automated systems (see below).
Airmail's Saildocs »Page 134 catalog includes a grib-request window for requesting custom grib files from
the Saildocs server. This can be found under Airmail's Window menu, Catalogs. Expand "Saildocs" on the
left and select the "Grib files" category. See "Grib requests »Page 133" for more details.
Grib data is typically extracted from global forecast computer-models, which are operated by most of the
world's larger meteorological services. Most, however, cheerfully charge for their efforts. We are fortunate
that the US takes a different view and requires that data generated with public funds be available to the
public. Most available grib data is based on the US NOAA/NCEP global models. The only drawback to
the NOAA data is that the grobal model is organized in such a way that providing 6-hourly updates
presently requires downloading over a gigabyte of raw data each day. Many thanks go to NOAA for
making the data available, and to Sailmail for the resources to make the downloading and processing
possible.
Grib data-files are available via email from the Saildocs server. Saildocs is a service created by the
Airmail author and operated by the Sailmail Association for its membership, and is also available without
charge to users of the Winlink-2000 system. See Saildocs »Page 134 for more information.
Saildocs gribs are extracted on a per-request basis from the NOAA/NCEP AVN global model and can
cover any requested area. The resulting file can be anywhere from 1K bytes to megabytes depending on
the amount of data requested. Reasonable-sized files can be sent via low-speed data links such as
Sailmail or Winlink. Sailmail will accept grib files up to 30K for P-3 users, 10K for P-2; for Winlink the limit
depends on the user-specified attachment limit, which must be set by a Winlink-2000 Options message
»Page 86 (Airmail's Windows menu).
Important note: Saildocs grib files are extracted from a computer forecast model. While such computer
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data can provide useful guidance for general wind flow, it is not reviewed and the data may not be current
or correct. Along shore, local effects may dominate the weather and not be adequately considered by the
model. Never rely solely on grib data from any source. In particular, current global-scale models cannot
provide adequate prediction for tropical systems, frontal activity or convergence zones. For
hurricane/cyclone forecasts, carefully monitor the appropriate warning messages. Grib data should be
considered supplemental, and not be relied upon in lieu of professionally-generated charts or forecasts.

Saildocs Catalog
The Airmail catalog is found under the Window menu, Catalog selection. The catalog window is divided
into two panels- on the left is a "tree" showing various folders, similar to Airmail's message-index tree or
Windows Explorer. These folders represent categories of documents which can be requested.
On the left, under "Catalog", is a folder for "Saildocs". Clicking the little "+" will expand a selection, clicking
a "-" will collapse it (just like Windows Explorer). The right and left-arrow keys can also be used to expand
and collapse folders.
Under "Saildocs" is a series of category-folders. The "Grib files" category is a special folder which brings
up a grib-request window with a world map for requesting grib weather-data files. See "Grib Weather Files
»Page 132" for more information on requesting grib data. Saildocs also includes a large number of text
weather-bulletin documents which can be requested. These are organized into folders under "Saildocs"
for the different ocean regions. Some areas have sub-folders to further divide the selection for easy
browsing. Also, many bulletins are listed under more than one heading, for example Atlantic hurricane
bulletins are listed under both "Atlantic" and "Tropical".
To request a document, open the appropriate folder on the left side (the up-down-left-right arrow keys are
often handy for navigating a "folder tree"). The list on the right side shows the documents in that folder,
INCLUDING sub-folders. The documents that are in the selected folder will be listed first, followed by the
documents in the sub-folders 9if any), with their folder names also shown in the list. (Note that this is
different from how Windows Explorer works, but handy for browing weather bulletins).
To request that a document be sent just once, check the corresponding box. Airmail will create a requestmessage to: query@saildocs.com with the appropriate code. It iwll be posted via the usual routing (e.g.
via Sailmail) and sent on the next connection. The requested document will be returned via email, the
saildocs server is usually quick but the round-trip may require 20-40 minutes depending on how often the
station communicates with the server.
If regular delivery of a bulletin is desireable, for example a daily weather bulletin, then a "subscription"
request can be sent to Saildocs. This is stored on the Saildocs server, and Saildocs will fetch the
document from the internet and send it ONLY IF IT HAS CHANGED. So to request a weather bulletin to
be sent every day at 12:00 utc, check the box for that bulletin, then click the "Subscribe" button, enter the
number of days that you would like the subscription to run (default is 14 days), how often you want it sent
(default is every 24 hours), and at what time (default is 00:00 utc). Airmail will format the request and it
will be sent on the next connection. You will get a confirmation from Saildocs and the first delivery will be
at the specified time after that.
To cancel a subscription, follow the "how to cancel" instructions included with every Saildocs subscription
message, at the bottom. (Send a message to: query@saildocs.com with the word "cancel"--without
quotes-- followed by the document code).

Grib Requests
Grib files »Page 132 can be requested from the Saildocs »Page 134 server using Airmail's Catalog
window. Open the "Window" menu, then select "Catalog". the left side is a category "tree", click the small
"+" to expand a selection (or use the right-arrow key). Find the Saildocs folder, expand that and then
select the "Grib files" folder. This will open the grib-request window, which shows a world map above a
panel showing options and settings.
To request a grib, first adjust the map to show the part of the world that is of interest, using the "slider"
buttons on the bottom and right edges, and the "+"or "-" zoom buttons in the lower-right. Then "drag" a
selection rectangle on the map. This is done by first positioning the cursor in the upper-left corner of the
desired area, then click and hold the left mouse-button, and then moving the cursor to the lower-left
corner of the desired area (while holding down the mouse button). This will crate a colored rectangle
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which defines the area for the grib file. The lat-lon limits and estimated file-size are shown in the
information box below the map. Note that the file size is an estimate, the actual size will vary somewhat
depending on the weather (seriously, bad weather requires a larger file size).
The important factors which determine file-size are the lat-lon area, the grid spacing, and the forecast
times. The default grid-spacing is 2 x 2 degrees (i.e. one data point every 2 degrees of latitude or
longitude), this can be changed to as fine as 1 deg for the standard GFS grib files, or larger (coarser) if
desired. Large areas require a larger grid-spacing in order to keep the file size small; conversely, gridspacings 1 x 1 degree can be used with small lat-lon areas and still have a very small file size. To change
the lat-lon area click and "drag" the sides of the selection rectangle to make the rectange smaller or
larger. (The rectangle can be moved by clicking and dragging in the center of the rectangle). To change
the grid-spacing click the "Options" button in the lower-right, this opens the grib-options window.
The default forecast times are 24, 48 and 72 hours, from 00z. Other forecast-intervals (called "valid
times") can be selected by clicking the "options" button in the lower-right. Obviously more valid-times
require a proportionally larger file size. The practical limit of grib files in terms of accuracy is much less
than the 10 days available through the grib-request options. Obviously the shorter-term forecasts are the
most accurate, this is true for any forecast. Beyond 2 or 3 days the accuracy begins to degrade
significantly, and 4 or 5 days is probably the limit for any sort of reasonable accuracy. The longer-term
forecasts still may have some value as a planning tool, but keep in mind that beyond a few days they
become increasingly speculative and the deviations can be large. This is true for any forecast, not just
grib files or NOAA gribs.
(At this time it is not possible to cross the zero-degree meridian on the map, but Saildocs will process
such a request. So specify an area on one side or the other, then open and modify the request-message
before sending it, changing the lat-lon limits appropriately).

Saildocs
Saildocs is an automated server which supplies weather bulletins and other documents from the Internet
via email. The Saildocs service was created by the author of Airmail and is supported and operated by
the Sailmail Association for its membership. Saildocs is also available without charge to hams who are
users of the Winlink-2000 system. In addition to a wide variety of text weather bulletins, Saildocs also
makes available grib weather-data files. Saildocs is an email-based system, for more information send a
(blank) email to: info@saildocs.com.
Information about grib
gribnews@saildocs.com.
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Telnet Window
Airmail's "telnet" window can be used to directly access the Winlink-2000 or Sailmail systems via the
internet. This is a general discussion in the context of ham radio systems, see "Sailmail Internet Access
»Page 134" for specific details on accessing Sailmail.
To set up Airmail's Telnet window, first go to Airmail's Tools/Options widow, modules tab, and make sure
that the box to the left of "Telnet Client" is checked. Click OK.
Then go to the Modules menu and select "Telnet Client". This opens the Telnet window, very much like
the Terminal window except operates over an internet connection. To access Winlink you will need to get
the connection information from any WL2K station operator, or from Steve k4cjx@comcast.net . When
you have that information then click the "New" button and enter the connection parameters.
Click OK, then make sure that you have an internet connection open and click the green "connect" button
on the telnet window. Airmail will connect and upload/download messages just like a radio connection,
except much faster. This is a virtual radio connection so you can do everything that you could do by radio,
including bulletins, position reports, etc.
To get your Winlink messages via web access when you can't use your own computer (e.g. a cybercafe),
go to www.winlink.org , and click on "Message access". You will need to register a special password for
this, click on the "Need help?" link for info on how to do that.

Sailmail Internet Access
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There are a number of methods which can be used to access Sailmail via Internet when a radio
connection is not available. For all of these methods you will need your Sailmail System Password which
was provided with the membership information from Sailmail. (For a lost password or to change
passwords send a note to: sysop@sailmail.com ).
Direct Internet Access (aka "Telnet"):
The most efficient way to access Sailmail via Internet from your own computer is to use Airmail's "telnet"
window. If you can get an Internet connection from your computer (via dial-up, Iridium, connecting to a
cyber-cafe's network, Inmarsat Mini-M, whatever) then you can use Airmail to access your Sailmail
messages via the Internet instead of via radio. The same compression and protocols are used, which
means a robust highly-compressed connection which is great for satellite phones and third-world
telephone networks.
To do this go to the "Modules" menu and select "Telnet Client". This is the window which is used for direct
Internet access, and looks very much like the Terminal window which operates over the radio. The
difference is that there are no frequencies to select, and the settings are a bit different. The primary
server is "WRD719", this should already be configured in the "Connect to" box in the toolbar at the top. To
check or change the settings click the "Settings" button and verify the following:
To set up a connection to Sailmail, click the "New" button (or "Settings" if you just want to check an
existing connection) and enter the following parameters:
Remote callsign: WRD719
Remote host: pop3.sailmail.com
Port: 50001
Timeout: blank (unless you have a particularly slow connection, default is 120 seconds)
Local Callsign: your Sailmail callsign (same as for used for radio connections)
Password: enter your "Sailmail system password" (formerly known as the "pop3 password").
Then click OK. In the toolbar at the top of the window "WRD719" should be selected, this is the station
that you are going to connect to via Internet. (A backup station is WHV382 in Friday Harbor, Remotecallsign is WHV382, remote-host is r7fh.no-ip.com and everything else is the same).
To connect to Sailmail, make sure "WRD719" is selected (or the backup server at WHV382) and click the
green "Connect" button. (No need to listen first, here). Airmail will establish a connection, log in and
exchange mail and then disconnect.
If you have a dialup account set up that you would like Airmail to dial first, then check the "Before
connecting, first dial" box at the bottom and select the appropriate account. Don't forget the "Then hang
up" button, and also make sure there is a timeout set in the Windows dial-up settings in case there is a
glitch and Airmail fails to hang up.
If you have a connection which is always available then you can check the "Check every" box and enter
the appropriate interval and time.
POP3 access
You can also access Sailmail using the Sailmail POP3 server, either from a webmail program such as
Mail2Web (www.mail2web.com ), Hotmail, Yahoo mail, etc. The settings are the same as above, mailserver is pop3.sailmail.com, login is either your complete email address (mail2web.com) or just your
callsign (most other sites), and your password is the same "system password" you received from Sailmail.
For more details go to www.sailmail.com and click on "Webmail".
You can also access Sailmail with any standard POP3-compatible email program (e.g. Outlook or just
about anything except AOL). The server is pop3.sailmail.com, login is just your callsign, and the
password is the same "system password".
You can also access Sailmail using Airmail's "Mail Client" window, this acts as a standard POP3 client
and uses the settings above. To enable Airmail's Mail client window, go to Tools/Options, Modules tab
and check the box for "Mail Client". It will then appear under the Modules menu.
More info is available from the Sailmail website at www.sailmail.com , click on "Sailmail Primer".

